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Pro/ENGINEER Wildfire 2.0 Configuration Options 
Name Category Description Values Default Value 

accuracy_lower_bound Environment Enter an accuracy value to override the default lower 
limit. The minimum value for relative accuracy is 1E-
06. 

- 0.0001 

acis_out_version Without 
Category 

Allows the user to choose ACIS export version. public 4, public 5, internal 6, 
internal 7 

5 

activate_sketch_with_dfl
t 

Features Activate sketcher automatically using system defaults. yes, no no 

add_java_class_path Application 
Programming 
Interfaces 

Prepends the option value on the java environment 
variable, CLASSPATH, used to find classes in J-Link 
programs. To specify multiple search paths in the same 
line, delimit them using ':' on UNIX, and ';' on 
Windows NT. 

- - 

add_lower_level_comps
_to_layer 

Layers Setting this option to yes will check off the Favor 
Current Layer option, which allows lower level 
components to be added to top level layers. 

yes, no no 

add_weld_mp Weld Yes - System includes welds when calculating mass 
properties. No - System excludes welds when 
calculating mass properties. 

yes, no no 

adobe_distiller Printing & 
Plotting 

Sets the Adobe Distiller command path. Required for 
PDF and COLOR PDF creation. 

- - 

advanced_intersection Assembly Control the appearance of the intersection tool and 
scope of available functionalities. 

yes, no no 

aec_parameter_file Without 
Category 

Specifies the file name of the user defined piping 
parameter codes. 

- - 

af_copy_references_flag User Interface Toggle display of Copy References column in 
Annotation Feature definition dialog 

no, yes no 

align_cable_bundles Electromechani
cal 

Align NEWLY CREATED bundles where they meet 
or branch out 

yes, no yes 

allow_anatomic_features Features   yes, no no 
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Name Category Description Values Default Value 
allow_confirm_window User Interface Display a confirmation window when exiting 

Pro/ENGINEER. This enables you to use the mouse to 
confirm/cancel exiting Pro/ENGINEER. 

yes, no yes 

allow_float_opt_checkou
t 

System Yes - Allows checkout failure for floating modules. no, yes no 

allow_move_attach_in_d
tl_move 

Drawing Yes - Move and Move Attach commands in drawing 
mode act together. No - Move and Move Attach 
commands in drawing mode do not act together. 

yes, no yes 

allow_move_view_with_
move 

Drawing Disallow the movement of drawing views with the 
mouse. 

yes, no no 

allow_multiple_tool_tips Manufacturing Allows to use for machining cutting tool with multiple 
tips. 

yes, no no 

allow_package_children Assembly Sets what type of children packaged components can 
have. ALL - Features and components can be a 
children of packaged component. FEAT - Only 
features can be children of packaged components. 
NONE - Packaged components cannot have children. 

all, feat, none all 

allow_ply_cross_section Miscellaneous Yes - Enables Pro/COMPOSITE to create a cross-
section of composite plys. 

yes, no yes 

allow_redo_intersections Assembly Yes - Displays the ReIntersect command in the ASSY 
FEAT menu. 

yes, no no 

allow_ref_scope_change Reference 
control 

No - Displays the message "Reference scope changes 
are prohibited by the configuration file settings" when 
the Ref Scope user interface is changed. 

yes, no yes 
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Name Category Description Values Default Value 
allow_refs_to_geom_rep
s_in_drws 

Drawing Yes - Allows you to create drawing references to 
geometry representations (includes dimensions, notes, 
and leaders). These references may become invalid if 
the referenced geometry changes resulting in geometry 
representations not updating in drawings. 

yes, no no 

allow_rfs_default_gtols_
always 

Dimensions & 
Tolerances 

Yes - Enables RFS/Default gtols to be created even 
when not permitted by ANSI standard. 

no, yes no 

allow_save_as_instance Assembly Allows the option to save a copy of the active model as 
a family table instance. 

yes, no no 

allow_shrink_dim_befor
e 

Casting & 
Mold Design 

Allow calculation before relations. yes, no no 

allow_solid_perspective
_hlr 

Model Display Yes - Allows a solid to be displayed with hidden lines 
while in perspective. 

no, yes no 

allow_udf_style_cosm_t
hreads 

Features Defines the Cosmetic Thread user interface. Yes - 
Creates a Cosmetic Thread as a UDF. No - Creates a 
Cosmetic Thread as a Cosmetic Thread feature. 

yes, no no 

allow_workpiece_silhou
ette 

Without 
Category 

Determines if the workpiece is allowed for Silhouette 
Mach Window creation. NO - only reference part is 
allowed; YES - both workpiece and reference part are 
allowed; AUTO - only workpiece is allowed. 

yes, no, auto no 

ang_dim_in_screen Dimensions & 
Tolerances 

Yes - If the display is in the default pan/zoom setting 
(View>Pan/Zoom>Reset), the system checks whether 
an angular dimension is visible on the screen. If it is 
not visible, then the system moves the dimension to a 
visible location. 

yes, no no 

ang_units Environment Sets the display of angular dimensions to decimal 
degrees (ang_deg), degrees and decimal minutes 
(ang_min) or degrees, minutes and decimal seconds 
(ang_sec). 

ang_deg, ang_min, ang_sec ang_deg 

angle_grid_interval Features Modify grid space in angular units for handle 
movement. 

- 1 
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Name Category Description Values Default Value 
angular_tol Dimensions & 

Tolerances 
An alternative format for setting default angular 
tolerance dimensions. The value sets the number of 
decimal places, and the tolerance is the actual tolerance 
value. For integer dimensions, the value is zero, and 
the tolerance is an integer. 

- 0 

angular_tol_0.0 Dimensions & 
Tolerances 

Sets the default tolerance for angular dimensions. Each 
option sets a tolerance for a specific decimal place. The 
value is the place of the last decimal. 

- 5 

angular_tol_0.00 Dimensions & 
Tolerances 

Sets the default tolerance for angular dimensions. Each 
option sets a tolerance for a specific decimal place. The 
value is the place of the last decimal. 

- 50 

angular_tol_0.000 Dimensions & 
Tolerances 

Sets the default tolerance for angular dimensions. Each 
option sets a tolerance for a specific decimal place. The 
value is the place of the last decimal. 

- 500 

angular_tol_0.0000 Dimensions & 
Tolerances 

Sets the default tolerance for angular dimensions. Each 
option sets a tolerance for a specific decimal place. The 
value is the place of the last decimal. 

- 5000 

angular_tol_0.00000 Dimensions & 
Tolerances 

Sets the default tolerance for angular dimensions. Each 
option sets a tolerance for a specific decimal place. The 
value is the place of the last decimal. 

- 50000 

angular_tol_0.000000 Dimensions & 
Tolerances 

Sets the default tolerance for angular dimensions. Each 
option sets a tolerance for a specific decimal place. The 
value is the place of the last decimal. 

- 500000 

arc_radius_limit Without 
Category 

Sets the upper limit for a radius in a CIRCLE statement 
of NCL file. The value must be positive. If not, 
10*part_size is used. 

- -1 

ask_designate_owners Without 
Category 

Show the both required and optional owners to be 
designated. 

yes, no yes 
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Name Category Description Values Default Value 
assy_mfg_open_mode Manufacturing No Default Application set for opening Assembly NC 

Models. 
internal none, public mfg, 
public process, public feature, 
internal toolmaker 

- 

atb_auto_check_on_acti
vate 

Data Exchange Sets state of ATB 'Auto Check Status On Activate' 
toggle. 

on, off off 

atb_auto_check_on_retri
eve 

Data Exchange Sets state of ATB 'Auto Check Status On Retrieve' 
toggle. 

on, off on 

atb_auto_check_on_upd
ate 

Data Exchange Sets state of ATB 'Auto Check Status On Update' 
toggle. 

on, off off 

atb_ident_cadds_files Data Exchange Allows to identify CADDS files in the file open 
browser. 

yes, no no 

atb_prod_asm_upd_by_c
omp_ids 

Data Exchange Allows to update a Pro/DESKTOP assembly based on 
assembly component ids, if set to YES. Otherwise, the 
update will be based on component names. 

yes, no yes 

atb_search_path Without 
Category 

Extends search path for ATB Update and ATB Check 
Status commands. 

- - 

atb_show_log Data Exchange Sets state of ATB 'Show Log' toggle. on, off on 
attach_menumanager Without 

Category 
Setup menu manager attachment to the main Pro/E 
window. 

yes, no no 

auto_ae_param_file User Interface Define path and file name of external file used to 
define parameters that are automatically created in all 
Annotation Elements. 

- - 

auto_assembly_with_lay
outs 

Assembly Yes - Enables automatic assembly. No - Disables 
automatic assembly. 

yes, no yes 
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Name Category Description Values Default Value 
auto_associate_dimensio
ns 

Data Exchange Yes - The drawing setup option 
associative_dimensioning is also set to Yes. The 
system tries to associate imported IGES dimensions 
(not yet associative) with corresponding imported 
geometry. 

no, yes no 

auto_constr_always_use
_offset 

Assembly Control whether auto constraint should create offsets. 
Yes - Auto constraint alw ays creates offsets. No - 
Auto constraint snaps align or mate if surfaces are wi 
thin tolerance. Never - Auto constraint never create 
offsets. 

yes, no, never no 

auto_constr_offset_toler
ance 

Drawing Sets the auto constraint tolerance for creating offset 
dimensions. If distance is less than this tolerance 
multiplied by component size, offset is set as 
coincident. Default value is 0.5 . 

- 0.5 

auto_convert_cables Electromechani
cal 

Yes - When regenerating a pre-Release 11.0 cabling 
assembly, the system automatically creates a separate 
spool feature for every individual wire or cable in the 
assembly. No - An interface for the cable conversion 
appears. 

yes, no yes 

auto_regen_views Drawing Yes - Automatically repaints the drawing display when 
changing from one window to another. No - Update to 
drawing views will only occur when manual updates 
are made via Repaint or View> Update. 

yes, no yes 

auto_traceback System When set to yes, traceback.log file will be generated 
when fatal error occurs. 

yes, no yes 

auto_xml_on_retrieve Electromechani
cal 

Automatically load Cabling Logical Reference from an 
XML file when retrieving the cabling assembly 

yes, no no 



Parametric Technology Corporation 7 Pro/ENGINEER Wildfire 2.0 Configuration Options 

Name Category Description Values Default Value 
auto_xml_on_save Electromechani

cal 
Automatically create an XML Logical Reference when 
saving a cabling assembly 

yes, no no 

autobuildz_enabled Drawing Loads AutobuildZ application. yes, no no 
autodrill_udf_dir Manufacturing Storage directory for holemaking MUDF's that are 

used by Pro/NC Auto-drilling functionality 
- - 

autodrilling_config_filen
ame 

Manufacturing Retrieve automatically and load the configuration file 
for the auto-drilling table. 

- autodrilling 

autodrilling_holestyle_p
aram 

Manufacturing Parameter name included in hole features of a 
manufacturing reference model. The parameter value 
identifies the MUDF for holemaking that is 
automatically applied in Pro/NC to drill these holes. 

- - 

autoplace_single_comp Assembly Assembling components with an interface will 
automatically place the component at the first position 
satisfying the interface definitions. 

no, yes yes 

autoroute_path_param_n
ame 

Electromechani
cal 

Set the wire parameter to use to select a path during 
autorouting. 

- use_path 

auxapp_popup_menu_in
fo 

User Interface Enable display of popup menu info in the trail file. yes, no no 

bell Environment Yes - Turns on the keyboard bell that rings after each 
prompt. No - Turns off the keyboard bell. To override 
this setting use the Environment dialog box on the 
Tools menu. 

yes, no no 

bitmap_size Data 
Management 

Works in conjunction with save_bitmap. Determines 
the size (squared) of the bitmap image that is stored. 

- 200 
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Name Category Description Values Default Value 
blank_layer Layers Blanks specified layers when you begin a 

Pro/ENGINEER session. The value is the layer ID. 
- 0 

blended_transparency Model Display Yes - Transparent colors will appear using alpha 
blending (if supported) when the model is shaded. 

no, yes yes 

bm_graph_tool User Interface BMX graph tool public default, public 
excel_linked, public 
excel_embedded, internal 
generic_graphtool 

default 

bmgr_pref_file User Interface Specifies the location of the Graph Tool preference 
file. 

- - 

bmx_param_restrictions Without 
Category 

  yes, no yes 

bom_format Drawing Sets the BOM format file to be used for a customized 
BOM. Specify name and path. 

- - 

browser_favorite File Storage & 
Retrieval 

Specifies the directories visible in the file browser for 
quick navigation. Use the full path to avoid problems. 

- - 

bump_revnum_on_retr_r
egen 

Assembly Determines whether or not revision number is 
increased for generic models that regenerate and 
change during assembly retrieval. Only applies if 
new_asm_regen_revnums is yes (otherwise, there will 
be no revision number bumping). 

yes, no yes 

button_name_in_help User Interface Yes - The name and menu of any selected menu option 
displays, in English, in the help text associated with 
that button. 

yes, no no 
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Name Category Description Values Default Value 
cable_int_portions_for_c
lr 

Electromechani
cal 

No - Global clearance checking for internal cable 
portions is excluded. Yes - Global clearance checking 
for internal cable portions is included. 

no, yes no 

cadam_line_weights Data Exchange Define the line width of entities within 
Pro/ENGINEER to plot drawings with correct line 
weights that are consistent with a standard. The default 
Pro/ENGINEER values for these weights are: 2 (light), 
3 (medium), 5 (heavy). 

- 0 

cadds_import_layer Data Exchange Allows import of CADDS5 layering. yes, no yes 
campost_dir Manufacturing Specifies the CAM-Post load point directory to enable 

you to directly set-up the post-processors and generate 
MCD files. 

- - 

can_snap_to_missing_re
f 

Assembly Controls whether to enable snapping to missing 
references while dragging components for placement. 
Yes - Snapping is enabled while dragging. No - 
Snapping is disabled while dragging. 

yes, no yes 

capped_clip Model Display Yes - Displays the model as a solid when shaded and 
clipped. No - Displays the model as surfaces when 
shaded and clipped. 

no, yes yes 

catia_out_to_existing_m
odel 

Data Exchange Append - If the selected CATIA model already exists, 
the new data is appended to the existing CATIA file. 
Overwrite - If the selected CATIA model already 
exists, the newly exported file overwrites the existing 
one. 

append, overwrite append 

catia_translator Data Exchange Allows the user to choose between the old CATIA 
license-based converter (pro_cat) and the new non-
CATIA license based (cat_ii) converters when doing 
direct import/export of CATIA files. When 
"topobus_enable" is set to "yes", cat_ii will be always 
used. 

cat_ii, pro_cat cat_ii 

cdt_transfer_details Data Exchange No - Details (dittos) associated with the imported 
CADAM drawing are placed on the current 
Pro/ENGINEER drawing sheet. Yes - Each detail 
(ditto) associated with the imported CADAM drawing 
converts to a separate additional sheet. 

yes, no yes 
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Name Category Description Values Default Value 
centimeter_grid_interval Features Modify grid space in centimeter units for handle 

movement. 
- 0.1 

cgm_inc_pad_byte_in_le
ngth 

Data Exchange Yes - Enables a metafile to be processed by the 
Micrographic CGM converter. 

yes, no no 

cgm_use_enum_in_real_
spec 

Data Exchange Yes - Enables a metafile to be viewed in Advanced 
Technology Center's ForReview. 

yes, no no 

cgm_use_reversed_ieee_
floats 

Data Exchange Yes - Enables a metafile to be viewed in Advanced 
Technology Center's ForReview. 

yes, no yes 

chamfer_45deg_dim_tex
t 

Drawing Controls the display of chamfer dimension text without 
affecting the leader. This only affects the text of newly 
created dimensions. ASME/ANSI is the default. 

asme/ansi, iso/din, jis asme/ansi 

check_ghost_features Without 
Category 

Skip features that are already marked non-ghost. skipchecked, never, always skipchecked 

check_same_assy_parts Assembly Determines whether to permit different names for 
different part occurrences, or not in mirror 
subassembly UI. 

yes, no yes 

chk_part_surfs_profpock Manufacturing Yes - Includes all reference part surfaces as check 
surfaces for profiling and pocketing NC sequences. 

yes, no no 

cl_arrow_scale Manufacturing Enables you to control the size of the tool path arrow 
for contouring NC sequences. 0 - The arrow does not 
display. Any other value - The arrow scales 
accordingly. 

- 1 

cl_rotate_sign_conventio
n 

Manufacturing TOOL or TABLE - defines ROTATE sign direction 
convention based with respect to either rotation table or 
cutting tool. 

table, tool table 

clearance_triangulation Environment Specifies the quality of surface triangulation used to 
obtain initial guess points for clearance and 
interference calculations. 

none, low, medium, high none 
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Name Category Description Values Default Value 
clip_always Model Display Yes - Display clipping after Visibilities dialog box is 

closed. 
no, yes yes 

clock Environment Yes - Displays the clock while Pro/ENGINEER is 
working. 

yes, no no 

clr_print_plus_minus Environment Sets the display of the system accuracy when 
calculating clearances between two parts or surfaces. 
The default is to not display the accuracy. 

yes, no no 

color Colors Turns the colors on or off. Turning colors off displays 
the model wireframe in white. 

no, yes yes 

color_ramp_size Colors Specifies the number of shades in a color ramp. 
Applicable to multi-color, shaded model displays of 
simulation / analysis results. System graphics must 
support 256 colors and color maps that compress. 

- -1 

color_resolution Colors Specifies minimum allowable deviation between user-
defined colors. Colors having RGB values within 
tolerance of existing colors cannot be created. 
Decreasing this setting allows more colors that are very 
similar in RGB value to be defined. 

- 0.1 

color_windows Colors All_windows - Wireframe colors display in the main 
window and all auxiliary windows. One_window - 
Colors display only in the main window. Auxiliary 
windows display wireframe in the default color. 

all_windows, one_window all_windows 

comp_angle_offset_eps Assembly Specifies the angle epsilon such that if the desired 
surfaces are equal or greater than the epsilon (in 
degrees), than an angle offset constraint will be 
created. 

- 10 

comp_assemble_start Assembly Constrain_in_window - New assembly components are 
shown in a separate window and must be constrained 
within the assembly. Package - New assembly 
components are shown within the assembly as a 
packaged component. 

package, constrain_in_window - 
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Name Category Description Values Default Value 
comp_offset_dec_places Assembly Sets the default number of decimal places (0-10) to 

display in the offset column of component placement. 
- 4 

comp_rollback_on_redef Assembly No - Assembly is not rolled back when the user 
redefines a component. 

yes, no yes 

comp_snap_angle_tolera
nce 

Without 
Category 

Specify the angle tolerance for snapping while 
freeform dragging components. Default value is 30.0 
degrees. 

- 30 

comp_snap_dist_toleran
ce 

Without 
Category 

Specify the distance tolerance for snapping while 
freeform dragging components. Default value is 0.1 
(relative to size of component being assembled). 

- 0.1 

company_name Environment Used with the export option iges_out_mil_d_28000. To 
support MIL-D-28000, your company name is required 
input and the system prompts you every time you 
export through IGES unless you set the company name 
in your configuration file. 

- - 

compress_output_files File Storage & 
Retrieval 

You can compress object files to store them. 
Compressed files are slower to read and write, one-half 
to one-third the size, and fully compatible across 
systems. Yes - Stores object files in compressed 
format. No - Object files are not compressed. 

yes, no no 

conf_mouse_anim Miscellaneous Display the presenter's mouse motions when observing 
a shared Pro/ENGINEER session. 

no, yes yes 

copy_dxf_dim_pict Data Exchange YES - Imports each component of AutoCAD 
dimension separately. NO - Imports AutoCAD 
dimensions as dimensions in Pro/ENGINEER. 
AS_SYMBOL - Imports AutoCAD dimensions as 
symbols in Pro/ENGINEER. 

yes, no, as_symbol no 

copy_geom_update_pre_
2000i_dep 

Assembly Yes - Flags independent copy geom features in a pre-
2000i model as modified when retrieved into 
Pro/ENGINEER. Save the model immediately to 
update the model's copy geom dependency 

no, yes - 
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Name Category Description Values Default Value 
information. 

cpus_to_use System Set up the number of threads including main thread - 2 

create_drawing_dims_on
ly 

Drawing Yes - Saves all new dimensions created in the drawing 
(regardless of the drawing setup file option) inside the 
drawing as associative draft dimensions. No - Saves all 
dimensions created in Drawing mode in the part. 

yes, no no 

create_fraction_dim Dimensions & 
Tolerances 

Yes - All dimensions created will be displayed as 
fractions. 

yes, no no 

create_numbered_layers Layers Yes - Creates default layers named 1 through 32. yes, no no 

create_temp_interfaces Assembly Allow the automatic creation of interfaces based on 
previous assembly instructions. 

yes, no no 

curr_proc_comp_def_col
or 

Assembly 
Process 

Specifies the default color used to display the current 
component in a process assembly. 

- 0 

curr_proc_comp_def_fo
nt 

Assembly 
Process 

Specifies the default font used on the current 
component in a process assembly. 

- - 

custom_rainbow Miscellaneous Used to specify fringe colors in Pro/FEM-POST 
results. Specify blue, black, cyan, magenta, green, 
yellow, red, and white. Enter colors as a dash-delimited 
string (lowest to highest value). The default is blue-
cyan-green-yellow-red-magenta-white. 

- - 

datum_point_symbol Model Display Specifies the shape of datum point symbols displayed 
in Part or Assembly mode. 

dot, cross, circle, triangle, 
square 

cross 

dazix_default_placement
_unit 

Data Exchange Specifies the units to be used for data imported in 
Dazix files. 

micron, mm, thou - 
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Name Category Description Values Default Value 
dazix_export_mounthole Data Exchange Yes - Causes the MOUNTHOLE section of a Dazix 

file to be processed as a mount hole. No - Causes the 
MOUNTHOLE section to be processed as a cut. 

yes, no no 

dazix_z_translation Data Exchange Yes - Passes the objects in the .edn files through z 
translation. 

yes, no yes 

def_layer Layers Specifies default layer names for different types of 
items. The first value string is the layer type. The 
second value string is the layer name. 

layer_assem_member, 
layer_assy_cut_feat, layer_axis, 
layer_chamfer_feat, 
layer_comp_design_model, 
layer_comp_fixture, 
layer_comp_workpiece, 
layer_copy_geom_feat, 
layer_corn_chamf_feat, 
layer_cosm_round_feat, 
layer_cosm_sketch, layer_csys, 
layer_curve, layer_curve_ent, 
layer_cut_feat, layer_datum, 
layer_datum_plane, 
layer_datum_point, 
layer_detail_item, 
layer_dgm_conn_comp, 
layer_dgm_highway, 
layer_dgm_rail, 
layer_dgm_wire, layer_dim, 
layer_draft_constr, 
layer_draft_dim, 
layer_draft_dtm, 
layer_draft_entity, 
layer_draft_feat, 
layer_draft_geom, 
layer_draft_grp, 
layer_draft_hidden, 
layer_draft_others, 
layer_draft_refdim, 
layer_driven_dim, 

- 
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Name Category Description Values Default Value 
layer_dwg_table, 
layer_ext_copy_geom_feat, 
layer_feature, layer_geom_feat, 
layer_gtol, layer_hole_feat, 
layer_intchg_funct, 
layer_intchg_simp, 
layer_nogeom_feat, 
layer_nongraph_annot_elem, 
layer_note, 
layer_parameter_dim, 
layer_part_refdim, layer_point, 
layer_protrusion_feat, 
layer_quilt, layer_refdim, 
layer_ribbon_feat, 
layer_rib_feat, 
layer_round_feat, layer_sfin, 
layer_shell_feat, 
layer_skeleton_model, 
layer_slot_feat, 
layer_snap_line, 
layer_solid_geom, 
layer_surface, layer_symbol, 
layer_thread_feat, 
layer_trim_line_feat, 
layer_weld_feat 

default_abs_accuracy Environment Defines the default absolute part accuracy. - 0 

default_ang_dec_places Drawing Specifies the number of decimal places shown in 
angular dimensions in a drawing. 

- 1 

default_comp_geom_sco
pe 

Reference 
control 

Set thespecified Shared Geometry reference control 
conditions to newly added components. 

all, pg, none all 



Parametric Technology Corporation 16 Pro/ENGINEER Wildfire 2.0 Configuration Options 

Name Category Description Values Default Value 
default_comp_invalid_re
fs 

Reference 
control 

Set the specified handling method of out-of-scope 
Accessible references to newly added components. 

copy, prohibit copy 

default_comp_scope_sett
ing 

Reference 
control 

Set the specified Accessible reference control 
conditions to newly added components. 

all, none, subassemblies, 
skeleton_model 

all 

default_comp_skel_geo
m_scope 

Reference 
control 

Set the specified Shared Geometry reference control 
conditions to newly added Skeleton components. 

all, pg, none all 

default_comp_skel_scop
e_setting 

Reference 
control 

Set the specified Accessible reference control 
conditions to newly added Skeleton components. 

all, none, subassemblies, 
skeleton_model 

all 

default_dec_places Dimensions & 
Tolerances 

Sets the default number of decimal places (0-14) to 
display in all model modes for non-angular 
dimensions. It does not affect the display of 
dimensions modified using Num Digits. In Sketcher, 
sketcher_dec_places controls the number of decimal 
places. 

- 2 

default_dim_num_digits
_changes 

Dimensions & 
Tolerances 

Sets the default number of digits displayed in a 
dimension to the last entered value. No - The system 
defaults to the value specified for the configuration file 
option default_dec_places. 

yes, no yes 

default_draw_scale Drawing Sets the default drawing scale for views added with the 
No Scale command. The value must be greater than 0. 
No - The system does not set a default drawing scale. 

- -1 

default_ext_ref_scope Without 
Category 

Set default scope for externally referenced models. All 
- Any model. None - Only current model and children. 
Skeletons - Any component in model's assembly and 
higher skeletons on branch. Subassembly - Only 
components and children in model's assembly. 

all, none, subassemblies, 
skeleton_model 

all 
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Name Category Description Values Default Value 
default_font User Interface Sets font for text other than menu bar, menus and their 

children, and pop-up menus and help. Add comma-
delimited variables in any order (italic bold, 24, times 
or 24, times, italic bold have the same effect). Any 
omitted variable uses standard setting. 

- - 

default_geom_scope Reference 
control 

Default value for Geometry Scope allowed for 
referencing. 

all, pg_if_exists, pg_only all 

default_layer_model Layers Name of the model which is used to drive rule-based 
layer placement of new items in all models of the same 
type in session. 

- - 

default_mold_base_vend
or 

Casting & 
Mold Design 

Default Value for Mold Base vendor. futaba_mm, dme, hasco, 
dme_mm, hasco_mm 

- 

default_obj_constraints_
scope 

Reference 
control 

Set the specified Shared Placement reference control 
conditions to newly created models if template models 
were not used. 

all, interfaces, none all 

default_object_geom_sc
ope 

Reference 
control 

Set the specified Shared Geometry reference control 
conditions to newly created models if template models 
were not used. 

all, pg, none all 

default_object_invalid_r
efs 

Reference 
control 

Sets default condition for reference handling. Prohibit - 
System will abort all attempts to create ext. reference 
that violates scope. Copy - System will issue warning 
upon all attempts to create ext. reference that violates 
scope. 

copy, prohibit copy 

default_object_scope_set
ting 

Reference 
control 

Set default condition for reference control. All - Any 
model. None - Only current model and children. 
Skeletons - Any component in model's assembly ang 
higher skeletons on branch. Subassembly - Only 
components and children in model's assembly. 

all, none, subassemblies, 
skeleton_model 

all 

default_placement_scope Reference 
control 

Default value for Component Placement Reference 
filter. 

all, intrf_if_exists, intrf_only all 

default_ramp_size Model Display Specifies a number of shades of gray to show shading 
of non-colored objects. 

- 0 
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Name Category Description Values Default Value 
default_shrink_formula Casting & 

Mold Design 
Default option of shrinkage formula: 1/(1-S) - ASME 
standard or 1+S (simple). 

asme, simple simple 

delete_after_plotting Printing & 
Plotting 

Yes - A plot file is automatically deleted from the 
directory in which it resides when it has been 
successfully plotted. 

yes, no - 

depthcue_always Model Display Depth cue aids in visualizing a wireframe model. With 
depth cue enabled, wireframe lines become darker as 
they extend into the screen and lighter as they extend 
towards the screen. Depth cue is supported only by the 
appropriate graphics hardware. 

no, yes yes 

depthcue_value Model Display Aids in visualizing a wireframe model. With depth cue 
enabled, this option specifies the default percentage of 
depthcue used. Depth cue is supported only by the 
appropriate graphics hardware. 

- 0 

diagram_pin_edit_multi_
line 

Electromechani
cal 

(Diagram) Determines the Pro/TABLE format used 
when you are modifying pin parameters. "yes" - You 
can add user-defined pin parameters by including them 
between the DEFINE and ENDDEF statements for 
each pin. "no" - The system uses columnar format and 

yes, no no 

dialog_translation User Interface Specifies the language in which the dialog display 
when running non-English version of Pro/ENGINEER. 

yes, no yes 

dim_fraction_denominat
or 

Dimensions & 
Tolerances 

Sets the largest denominator to be used for fractional 
dimensions. If the fraction can be reduced, then it 
converts to the lowest possible denominator (for 
example, 4/32 converts to 1/8). 

- 32 

dim_fraction_format Dimensions & 
Tolerances 

Std - Displays fractional dimensions in the standard 
Pro/ENGINEER format. Aisc - Displays fractional 
dimensions in the American Institute of Steel 
Construction (AISC) format and displays architectural 
units in AISC format for feet-inches. 

std, aisc std 
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Name Category Description Values Default Value 
dim_offscreen_limit Dimensions & 

Tolerances 
If more than zero, sets the margin beyond which 
dimensions are automatically snapped back onto the 
screen. For example, a value of .2 lets a dimension be 
20% of the window size outside the window. If set to 
zero, disables snapping of offscreen dimensions. 

- 0.2 

dir_cache_max File Storage & 
Retrieval 

Specify the maximum number of directories to cache. 
Larger values can speed up file access, but use more 
memory. 

- 256 

direct_vrml Data Exchange Yes - Enables direct VRML conversion. yes, no no 
disable_search_path_che
ck 

File Storage & 
Retrieval 

Controls whether the search path is checked for name 
conflicts when creating, renaming, or copying models. 
Name conflicts should be avoided because different 
models with the same name cannot be together in 
session. 

yes, no no 

disp_in_open_rep_create Without 
Category 

Simplified Rep to display initially in Open Rep Create: 
"No" for none, "Yes" for graphics rep, or "Default 
Rep" to display the rep indicated by option 
"open_simplified_rep_by_default". 

yes, default rep, no no 

disp_trimetric_dwg_mod
e_view 

Drawing Displays the model in default orientation when placing 
a general view on the drawing. No - Model does not 
appear until Default is chosen from the Orientation 
dialog box. 

yes, no yes 

display Model Display Wireframe - Displays model with all lines in white. 
Hiddenvis -Hidden lines in grey. Hiddeninvis - All 
hidden lines removed. Shade - All models (except 
drawing) with all surfaces shaded. Line display is 
reflected in plotter, DXF and IGES files. 

wireframe, hiddenvis, 
hiddeninvis, shade 

shade 

display_axes Model Display Displays or hides datum axes. yes, no yes 
display_axis_tags Model Display Displays or hides datum axis name tags. yes, no yes 
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Name Category Description Values Default Value 
display_comps_to_asse
mble 

Assembly 
Process 

Yes - The design model goes into memory and 
displays. Pick process components from the design 
model or the Model Tree. No - Only the Model Tree 
displays. As you pick process components from the 
Model Tree, they go into memory. 

yes, no yes 

display_coord_sys Model Display Yes - Coordinate systems will be displayed. No - 
Coordinate systems will not be displayed. 

yes, no yes 

display_coord_sys_tags Model Display Yes - Coordinate system name tags will be displayed. 
No - Coordinate system name tags will not be 
displayed. 

yes, no yes 

display_dwg_sketch_con
straint 

Drawing When set to yes, parametric sketching constraints, such 
as V for vertical, are displayed when a drawing object 
is selected 

yes, no no 

display_dwg_tol_tags Drawing Sets the display of the tolerance tags that appear in 
drawings. This option does not affect the display of 
tolerances on dimensions. 

yes, no yes 

display_florin Model Display Yes: display of the florin (international currency 
symbol) where possible. No: use the euro symbol 
exclusively. 

no, yes no 

display_full_object_path Environment Controls the display of the object's full file name 
(including its object-type suffix and its version 
number) and file path in the window title and Model 
Info display. Yes - Displays full file name and file 
path. No - Displays object name only. 

no, yes no 

display_in_adding_view Drawing Controls model display in a drawing when 
auto_regen_views is No. Wireframe - Adds new views 
in wireframe, displays datums. Minimal_wireframe - 
Displays in wireframe, no datums, axes, or silhouette 
edges. Default - Displays using the Environment 
setting. 

wireframe, minimal_wireframe, 
default 

wireframe 
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Name Category Description Values Default Value 
display_internal_cable_p
ortion 

Electromechani
cal 

Yes - Internal cable portions will be displayed for any 
wires that have been manually set to Yes in the Cable 
Paths Setup dialog box for each individual splice and 
custom component. This option can be overridden in 
the Environment dialog box. 

yes, no no 

display_layer Layers This causes the specified layers to display when you 
begin a Pro/ENGINEER session. The variable "value" 
is the layer Id. 

- 0 

display_plane_tags Model Display Yes - Datum plane name tags will be displayed. No - 
Datum plane name tags will not be displayed. 

yes, no yes 

display_planes Model Display Yes - Datum planes will be displayed. No - Datum 
planes will not be displayed. 

yes, no yes 

display_point_tags Model Display Yes - Datum point tags will be displayed. No - Datum 
point tags will not be displayed. 

yes, no yes 

display_points Model Display Yes - Datum points and their names will be displayed. 
No - Datum points and their names will not be 
displayed. 

yes, no yes 

display_silhouette_edges Model Display Sets the display of silhouette edges for wireframe 
display only. 

yes, no yes 

display_thick_cables Electromechani
cal 

Yes - Display cables and wires with thickness. No - 
Display the centerline of cables and wires only. This 
option can be overridden in the Environment dialog 
box. 

public yes, internal no no 

display_tol_by_1000 Dimensions & 
Tolerances 

If set to Yes, tolerances for non-angular dimensions 
will be displayed multiplied by 1000. 

yes, no no 

dm_auto_open_zip Data 
Management 

YES - Windchill CAD packages or zip files will open 
automatically. NO - User selects which file in contents 
to open. 

yes, no yes 

dm_cache_mode Data 
Management 

Indicate which objects will be written to local cache 
when objects in Pro/E memory are saved. 

none, modified, all all 
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Name Category Description Values Default Value 
dm_cache_size Data 

Management 
Enter amount of disk space (in megabytes) to allocate 
for local file storage. 

- 400 

dm_http_compression_le
vel 

Data 
Management 

Set the data compression factor (0-9, 0= no 
compression) for data exchange with a Windchill 
server. 

- 0 

dm_overwrite_contents_
on_update 

Data 
Management 

Yes: Windchill Workspace Update will overwrite 
locally/modified out of date objects with the ones in 
the server. No (Default): Windchill Workspace Update 
will update metadata only. 

yes, no no 

dm_remember_server Data 
Management 

Primary server/workspace must be set by user for each 
Pro/E session. 

no, yes yes 

dm_secondary_upload Data 
Management 

Indicate when modified Pro/E objects on a secondary 
server will be moved from the local cache to the user's 
workspace on the server. 

automatic, explicit automatic 

dm_upload_objects Data 
Management 

Indicate when modified Pro/E objects will be moved 
from the local cache to the user workspace on the 
server. 

automatic, explicit explicit 

dont_show_symbol_nod
es 

Design 
Manager 

Do not show references derived from relations in 
Parent/Child viewer. 

yes, no no 

draw_models_read_only Drawing Yes - Drawing model files are read-only. Driven 
dimensions, gtols, and similar items cannot be added to 
the model. Cosmetic_only - Driven dimensions, gtols, 
cross sections, and explode states can be added to the 
model, design changes are not allowed. 

yes, no, cosmetic_only no 

draw_points_in_model_
units 

Drawing Defines the current draft view's coordinate values as 
model units rather than drawing units. The GET 
POINT menu uses the scale of the draft view and the 
draft view's model units for relative and absolute 
coordinate entry and display in the Message Window. 

yes, no no 
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Name Category Description Values Default Value 
drawing_file_editor Drawing Specifies the default text editor for the drawing setup 

file, otherwise, the system uses the default editor. 
Protab - the system uses Pro/TABLE. Editor - system 
uses the system editor (refer to pro_editor_command). 

protab, editor editor 

drawing_setup_file Drawing Sets the default drawing setup file option values for 
your Pro/ENGINEER session, otherwise, the system 
uses the default drawing setup file option values. 
Certain parameters in the file are valid only if you have 
a license for Pro/DETAIL. 

- $PTCSRC/text/pr
odetail.dtl 

drawing_view_origin_cs
ys 

Drawing The named coordinate system will be used as the origin 
of a newly created view or of a modified view. None - 
The system will not use a previously specified 
coordinate system. 

none - 

dwg_export_format Data Exchange Provides the ability to choose DWG file version when 
exporting from Pro/E drawing. 

12, 13, 14, 2000 2000 

dxf_block_to_pro_symb
ol 

Data Exchange Specifies whether or not DXF BLOCKS to be imported 
as Pro/E symbols. Yes - Imports BLOCKS as symbol 
definitions, No - Imports BLOCKS as separate entities. 

yes, no no 

dxf_export_format Data Exchange Provides the ability to choose DXF file version when 
exporting from Pro/E drawing. 

12, 13, 14, 2000 2000 

dxf_export_mapping_fil
e 

Data Exchange Specifies the DXF export mapping file. Absolute or 
relative path to the file can be used. 

- - 

dxf_in_faceted_brep Data Exchange Default, faceted boundary representation is allowed in 
import. 

yes, no yes 

dxf_out_comments Data Exchange YES - comments (999 group codes) will be created in 
DXF file exported from Pro/ENGINEER. NO - DXF 
file will be created without comment lines. 

yes, no yes 
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Name Category Description Values Default Value 
dxf_out_drawing_scale Data Exchange Specify whether or not to export drawing scale to the 

DXF or DWG file. Yes - Includes a scale factor 
DIMLFAC in the exported DXF/DWG. No - Exports 
without using a scale for the drawing. Set to Yes when 
exporting to read into AutoCAD. 

yes, no no 

dxf_out_scale_views Data Exchange Specify whether or not to scale drawing views when 
exporting to the DXF or DWG file. Yes - rescales the 
entire drawing in such a way that the main view scale 
becomes 1:1. No - exports without rescaling. 

yes, no no 

dxf_out_sep_dim_w_bre
aks 

Data Exchange YES - Breaks dimensions with breaks on witness lines 
to separate entities and preserves the original picture. 
No - Exports such dimensions as DXF DIMENSION 
entities and removes the breaks on witness lines. 

yes, no no 

dxf_out_stroke_text Data Exchange Strokes == text is converted to lines and dots. Yes - 
Strokes out text in DXF or DWG export. No - Does not 
stroke out the text for export. 

yes, no no 

dxfio_in_sjis Data Exchange Determines if the SJIS is supported when 
importing/exporting DXF files in Japanese 

yes, no no 

ecad_area_default_impor
t 

Data Exchange Defines how imported ECAD areas are treated. 
Cosm_area - Treats imported ECAD areas as cosmetic 
area features. 3d_volume - Imports ECAD areas with 
Z-heights as a 3D enclosed quilt. 

3d_volume, cosm_area cosm_area 

ecad_board_csys_def_na
me 

Data Exchange Specifies the default coordinate system name added to 
an ECAD board being imported. If you do not set this 
variable, the system prompts you for a name. 

- - 

ecad_comp_csys_def_na
me 

Data Exchange Specifies the default coordinate system name added to 
an ECAD component being imported. If you do not set 
this variable, the system prompts you for a name. 

- - 

ecad_comp_layer_map Data Exchange Allow layer mapping for ECAD component's import 
into Assembly. 

yes, no yes 
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Name Category Description Values Default Value 
ecad_create_hint_add Data Exchange Assists in creation of an ecad_hint.map file. Yes - 

Automatically renames components, if necessary, each 
time library of component outlines is imported to 
Pro/ENGINEER. This does not create an 
ecad_hint.map file. It controls if ecad_hint.add is 
created. 

no, yes yes 

ecad_default_comp_heig
ht 

Data Exchange Sets default value and units for an ECAD component 
being imported. Units can be: inch, mil (1E-3 inches), 
thou (1E-6 inches), cm, mm, micron (1E-6 meters), dsu 
(1E-8 meters). If not set, the system uses the current 
component's units. 

- -1 

ecad_default_comp_plac
e_status 

Data Exchange Sets default component placement status for export 
(parameter setting will override the default). 

unplaced, fixed, placed, mcad, 
ecad 

placed 

ecad_exp_both_two_are
as 

Data Exchange Supports the export of ECAD areas with different 
"Above Board" and "Below Board" conditions. "yes" - 
Enables you to export both sided keep-in/keep-out 
ECAD areas as two individual areas (top and bottom). 

yes, no no 

ecad_export_cuts_as_hol
es 

Data Exchange Exports Pro/ENGINEER cuts as holes to ECAD 
systems. 

yes, no yes 

ecad_export_holes_as_c
uts 

Data Exchange Exports Pro/ENGINEER holes as cuts to ECAD 
systems. 

yes, no no 

ecad_import_holes_as_f
eatures 

Data Exchange Import sections specified as DRILLED_HOLE as 
through-all holes. Boards created with Pro/ENGINEER 
drilled holes export with default value of NPTH for the 
ECAD_HOLE_TYPE parameter. Create this feature 
parameter if a value of PTH is needed (IDF 2.0/3.0). 

yes, no no 

ecad_import_relative_ac
curacy 

Data Exchange Defines the relative accuracy used in ECAD import. - 0.0012 

ecad_mapping_file Data Exchange Specify the ecad_hint.map file that will be used for 
ECAD operations. 

- - 
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Name Category Description Values Default Value 
ecad_missing_componen
t_status 

Data Exchange Setup default status for missing components in 
"Investigate Placement" Dialog. 

keep_missing, delete_missing keep_missing 

ecad_other_outl_csys_de
f_name 

Data Exchange Specifies the default coordinate system name for the 
.OTHER_OUTLINE section of an IDF 2.0 ECAD 
component being imported. If you do not set this 
variable, the system uses ECAD DEFAULT as 
coordinate system name. 

- - 

ecad_panel_csys_def_na
me 

Data Exchange Specifies the default coordinate system name added to 
an ECAD panel being imported. If you do not set this 
variable, the system prompts you for a name. 

- - 

ecad_pin_hole_import Data Exchange Setup the default for the import of ECAD Holes from 
type PIN (IDF 3.0 ONLY) 

yes, no no 

ecad_via_hole_import Data Exchange Setup the default for the import of ECAD Holes from 
type VIA (IDF 3.0 ONLY) 

yes, no yes 

edge_display_quality Model Display Controls display quality of an edge for wireframe and 
hidden-line removal. Normal - Normal quality of edge 
display. High - Increases tessellation by 2. Very_high - 
Increases tessellation by 3. Low - Decreases 
tessellation from normal, speeds up display. 

normal, high, very_high, low normal 

enable_absolute_accurac
y 

Environment Controls display of the ACCURACY menu. Yes - 
ACCURACY menu always appears when you choose 
Accuracy from the PART SETUP menu. No - The 
menu appears only if the part is currently defined with 
absolute accuracy. 

yes, no no 

enable_assembly_accura
cy 

Assembly No - Disables accuracy modification for assembly 
objects. 

yes, no yes 

enable_cadra_export Data Exchange Enables the CADRA command in the EXPORT menu. 
This enables the creation of a CADRA specific IGES 
file. 

no, yes no 

enable_face_preselection Without 
Category 

  yes, no yes 

enable_hlr_hashing Model Display Enables hlr hashing no, yes no 
enable_implied_joints Assembly Allow underconstrained components as mechanism 

connections. 
yes, no yes 
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Name Category Description Values Default Value 
enable_k01_msr_anls Without 

Category 
Enable or disable new UI for Measure Analysis. yes, no no 

enable_offset_fan_curve Without 
Category 

Enables fan curve option for offset tool. yes, no no 

enable_popup_help User Interface Controls pop-up help in dialog boxes. Yes - Help 
enabled. No - Help disabled. 

yes, no yes 

enable_protk_xml_sche
ma 

Application 
Programming 
Interfaces 

Enables XML-Schema validation for Pro/TK feature 
XMLs 

yes, no no 

enable_tree_indep System Setup whether tree customization will allow separating 
the tree window from Pro/E window. 

yes, no no 

erv_show_external_only Assembly Yes - Global Reference Viewer will show objects with 
external references only; No - all the objects will be 
visible 

yes, no no 

excel_analysis_directory File Storage & 
Retrieval 

Sets the default directory for the MS Excel files to be 
used for Excel analysis calculations. Use the full 
pathname to avoid problems. 

- - 

exec_prog_on_assem_ret
r 

File Storage & 
Retrieval 

Execute pro/program for models during assembly 
retrieval. 

yes, no no 

expand_all_with_nested
_layers 

Without 
Category 

Yes - expand all including nested sub layers. yes, no yes 

explode_iges_dimension
_note 

Data Exchange Controls how dimensions are treated when importing 
an IGES drawing file. Yes - Each IGES dimension 
explodes into an independent note with the dimension 
text and a dimension with an empty note. No - 
Dimensions are treated as before. 

yes, no no 

export_3d_force_default
_naming 

Data Exchange Specify whether the Pro/ENGINEER file names should 
be used for export to STEP (only). Yes - Do not 
prompt for a new name. No - Prompt for the name of 
each STEP file. 

yes, no no 

export_to_shipit Data Exchange Enable Ship-it interface export. yes, no no 
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Name Category Description Values Default Value 
extend_cvpath Data Exchange Extends CVPATH search path for CADDS5 data 

exchanging. 
- - 

fail_ref_copy_when_mis
sing_orig 

Assembly Yes - When using a copied geom feature or a backed-
up external reference with the Design Manager, and the 
reference is missing in the original, then the copied 
geom feature fails. No - The feature freezes and does 
not update. 

yes, no yes 

fail_unattached_feature Features Handles unattached protrusion and cuts, when 
retrieving pre-Release 15 models. Yes - When a part is 
retrieved, the system fails an unattached protrusion or 
cut. No - When a part is retrieved, the system does not 
fail an unattached protrusion or cut. 

yes, no no 

fan_significant_locations
_only 

Electromechani
cal 

Setup whether only significant locations should be 
flattened on flattening a harness. 

no, yes yes 

fan_with_network Electromechani
cal 

Setup whether the network should be included on 
flattening a harness. 

yes, no yes 

fast_highlight Model Display Yes - Use simplified highlighting which redisplays 
more quickly at the expense of certain details. This 
option may increase memory usage slightly. 

no, yes no 

fasthlr Model Display Specifies whether fast hidden line removal is on/off by 
default. 

no, yes no 

feature_create_auto_begi
n 

Features In feature creation, determines whether or not the 
Define button is automatically activated when you 
open the dialog box. Yes - Button is activated 
automatically. No - You select the button. 

yes, no no 

feature_create_auto_ok Features In feature creation, determines whether or not the 
system activates the dialog box OK button 
automatically when the last required element is 
defined. Yes - Button is activated automatically. No - 
You select the button. 

yes, no no 
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Name Category Description Values Default Value 
fem_allow_named_mesh
_files 

FEM Yes - The user will be prompted to select a file to 
retrieve the mesh from, or enter a file name to save the 
mesh to. No - The user will not be prompted to select 
or enter a mesh file name. 

yes, no no 

fem_ansys_annotations FEM Toggles transfer of loadcase names to ANSYS. yes, no no 

fem_ansys_grouping FEM Toggles transfer of groups/layers to ANSYS. yes, no no 

fem_asp_ratio FEM The value that FEM created elements of aspect ratio 
are compared against. 

- 7 

fem_default_solver FEM Specifies default solver. ansys, nastran - 
fem_dist_index FEM The value that FEM created elements of distortion 

indices are compared against. 
- 0.4 

fem_edge_angle FEM Sets the minimum acceptable default angle between 
adjacent element edges. Enter value between 0 and 90. 

- 30 

fem_ignore_unpaired FEM Yes - Unpaired surfaces are ignored when meshing the 
model, placing you directly into the AFTER COMP 
menu (the CONT MESH menu is skipped). 

yes, no no 

fem_mesh_operations FEM Yes - The menu item Operations appears in the FEM 
MESH menu, providing access to functionalities to 
manipulate the finite element mesh. No - the menu 
FEM MESH will not have the item Operations. 

yes, no no 

fem_mesh_preserve FEM Yes - The finite element mesh will be automatically 
stored in the mesh file upon creation, and retrieved on 
entering the Structure/Thermal. No - The mesh will not 
be stored or retrieved automatically. 

yes, no no 

fem_mid_ratio FEM The value that FEM created elements of mid ratios are 
compared against. 

- 0.1 

fem_neutral_version FEM Specifies version number of neutral file. - 3 
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Name Category Description Values Default Value 
fem_remove_unopposed FEM Yes - The system ignores unopposed surfaces when 

meshing the model; the system also deselects the 
UseUnopposed option. No - the system uses the 
unopposed surfaces in the shell model. 

yes, no no 

fem_skew_angle FEM Sets the maximum acceptable default skew angle 
value, measured in degrees. Enter a value between 0 
and 90. 

- 45 

fem_solid_shell_auto_co
nstraint 

FEM Yes - SPCs for the rotational DOF will automatically 
be created at the interfacing nodes between solids and 
shells. That is shell rotations will be fixed. No - No 
such constraints will automatically be created. Ask - 
Prompt the user before running. 

yes, no, ask no 

fem_solver_time_limit FEM For NASTRAN solution, uses this option to interrupt 
the solver after the specified time limit. The default 
value is 60 minutes. 

- 60 

fem_taper FEM Sets the minimum acceptable default taper value. Enter 
a value between 0 and 1. 

- 0.5 

fem_twist_angle FEM Sets the maximum acceptable default twist angle 
between opposing element faces. Applies to wedge and 
brick elements only. Enter a value between 0 and 90. 

- 10 

fem_warp_angle FEM Sets the maximum acceptable default warp angle value, 
measured in degrees. Enter a value between 0 and 90. 

- 10 

fem_which_ansys_solver FEM Specifies the ANSYS solver to be used. frontal, iterative, powersolver frontal 

fem_y_dir_compress FEM Specifies the Y-direction based on compressed and 
uncompressed geometry. The default value is 
uncompressed. 

yes, no no 

file_open_default_folder File Storage & 
Retrieval 

Sets default dir for File>Open. Working_directory - 
Search working directory. In_session - Search objects 
in session. Pro_library - Use only if Pro/LIBRARY is 
installed. Workspace - Use only with 
Pro/INTRALINK. Commonspace - Use only with 

default, working_directory, 
in_session, pro_library, 
my_documents 

- 
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Name Category Description Values Default Value 
Pro/INTRALINK. 

fix_autocad_iges_text_sc
ale 

Data Exchange Fixes scaling problems with AutoCAD releases earlier 
than Release 10. Yes - Repairs AutoCAD files 
appropriately. 

yes, no no 

fix_boundaries_on_impo
rt 

Data Exchange Controls fixing of boundaries of imported surfaces. 
Yes - Fixes boundaries by zipping gaps and correcting 
tangencies. No - Does not fix boundaries. 

yes, no no 

fix_catia_iges_sym_note Data Exchange Corrects a problem caused by multiple rotations of a 
note in a CATIA IGES file. Yes - Rectifies any 
discrepancies. 

yes, no no 

fix_imported_set_view_
orient 

Data Exchange Sets viewing characteristics for imported CATIA SET 
files. Yes - Files can have translated views. No - Files 
cannot have translated views. 

yes, no no 

fix_refs_to_intersections Assembly Sets remnant removal ability for the ReIntersect 
command in the ASSY FEAT menu. Yes - You can 
remove remnants. No - You cannot remove remnants. 

yes, no no 

flip_arrow_scale Environment Sets a scale factor for enlarging the size of the flip 
arrow that appears for feature creation direction 
(default = 1). 

- 1 

folder_display_file_limit File Storage & 
Retrieval 

Sets the default number of files that will be displayed 
when viewing the contents of a folder using the Folder 
Navigator. 

- -1 

fonts_size User Interface Determines the relative size of the text in menus and 
dialog boxes. You must restart Pro/ENGINEER for the 
change to take effect. 

small, medium, large - 

foot_grid_interval Features Modify grid space in foot units for handle movement. - 0.083333 

force_new_file_options_
dialog 

File Storage & 
Retrieval 

Force the use of the New File Options dialog. yes, no no 
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Name Category Description Values Default Value 
force_upd_assem_mp_in
_simp_rep 

Assembly Update mass properties parameters even when some of 
the components of the assembly are not in master rep. 

yes, no no 

force_wireframe_in_dra
wings 

Drawing Yes - Displays all views of drawings in wireframe. No 
- Displays views according to the display set for the 
session (wireframe, hidden, and so on). 

yes, no no 

format_setup_file Drawing Assigns a specified setup file to each drawing format. 
To assign the drawing's parameter values to the format, 
you must retrieve the drawing's setup file into the 
format. 

- dwgform.dtl 

frames_per_sec Model Display Determines whether view is animated. no, yes no 
frames_per_sec_value Model Display Used to set the smoothness of view animation changes. 

Higher numbers provide more frames/sec, and giving 
you a smoother animation. Lower numbers cause the 
view to change more quickly. 

- 3 

freeze_failed_assy_comp Assembly No - Requires an action to fix the assembly or freeze 
the component that fails retrieval. Yes - Freezes any 
component failing retrieval at its last known assembly 
location. Missing refs using offsets or internal datums 
do not cause components to freeze. 

yes, no no 

full_hlr_for_cables Electromechani
cal 

Full - Removes hidden lines from view when cables 
hide other geometry (use when Hidden Line active). 
Partial - Cables hide other non-interfering cables 
except when cables route together between same 
locations. None - Display hidden lines (faster). 

none, full, partial full 

general_undo_stack_limi
t 

System Setup the default number of entries in the top level 
Undo/Redo (default = 50). 

- 50 

gerber_360_interpolation Printing & 
Plotting 

Yes - Arcs and circles included in outputted Gerber 
plot files will take this format. 

no, yes no 

gpostpp_dir Manufacturing Specifies the directory containing the post processor 
files to be used by Pro/NCPOST (GPOST). 

- - 
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Name Category Description Values Default Value 
graphics System Sets the optional graphics environment used by certain 

platforms for running Pro/ENGINEER. Refer to the 
Installation Guide for a list of defaults and optional 
graphics. 

public opengl, public 
x_windows, public starbase, 
public xgl, public win32_gdi, 
internal no_graphics 

no_graphics 

grid_snap Sketcher Yes - Makes pick points snap to a grid. No - Turns the 
grid snap off so that any location can be picked. 

yes, no no 

gtol_dim_placement Dimensions & 
Tolerances 

Controls display of geometric tolerances in Part. Use 
like drawing set-up option of the same name. 
On_bottom - Gtols display at bottom (below additional 
lines of text). Under_value - Gtols display under 
dimension value (above additional lines of text). 

on_bottom, under_value on_bottom 

harn_tang_line_display Electromechani
cal 

Display the tangency lines between cable segments in 
thick cable display mode. 

yes, no yes 

help_translation User Interface Specifies the language in which the short help 
messages display when running non-English versions 
of Pro/ENGINEER. Yes - Display in native language. 
No - Display in English. 

yes, no yes 

highlight_erased_dwg_vi
ews 

Drawing Controls the display of erased view outlines 
(environment option Highlight Erased Views). Yes - 
Highlights erased views. No - Turns off highlighting 
for erased views. 

yes, no yes 

highlight_layer_items Layers Specifies whether items selected in the layer tree 
should be highlighted in the graphics area. 

yes, no yes 

highlight_new_dims Drawing In Drawing mode, highlights new dimensions in red 
until you move them or repaint the screen. 

yes, no no 

hlr_for_quilts Drawing In Drawing, controls quilt display in hidden line 
removal. Yes - Includes quilts in the hidden line 
removal process (preselects Qlt HLR in the VIEW 
DISP menu). Default in the VIEW DISP menu, uses 
the value you have set. 

yes, no no 
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Name Category Description Values Default Value 
hole_diameter_override Features No- Uses hole-table-driven standard hole diameter 

value. Yes - Allows specifying the drilled hole value 
instead of the standard value. 

yes, no no 

hole_parameter_file_pat
h 

Features Specifies the directory path for a standard screw-size 
parameters (.hol) file to be loaded from disk. Use the 
full path name to avoid problems. 

- - 

iconify_entire_pro User Interface Determines how many other Pro/ENGINEER 
windows/menus are iconified when one window is 
iconified. Yes - All the windows and menus are 
iconified. No - Only the selected window is iconified. 

no, yes yes 

iges_clip_view_ent Data Exchange Determines whether IGES entities are clipped with 
regards to IGES views. YES - Entities outside the view 
outline are clipped. NO - No clipping. 

yes, no yes 

iges_clip_view_note Data Exchange Determines how IGES notes are clipped with regards 
to IGES views. No_clip - No clipping. Full_clip - 
Notes that are partially outside the view outline are 
clipped. Partial_clip - Notes completely outside the 
view outline are clipped. 

no_clip, full_clip, partial_clip no_clip 

iges_export_dwg_views Data Exchange Yes - Exports drawing view information. No - Does 
not export drawing view information. 

yes, no no 

iges_in_106_f2_as_splin
e 

Data Exchange No - IGES Copious Data Entity type 106, form 2 is 
imported as a set of points in 3D space. Yes - The 
entity is imported as a 3D spline. 

no, yes no 

iges_in_assoc_dim_geo
m_21 

Data Exchange Controls if imported IGES associative dimensions 
remain associative. Yes - If the drawing setup option 
associative_dimensioning is Yes, then the Associativity 
Instance entity is processed during import. No - 
Dimensions do not retain associativity. 

yes, no no 
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Name Category Description Values Default Value 
iges_in_dwg_color Data Exchange Yes - Import RGB information to IGES files. The color 

definition entities in the IGES file are imported to the 
drawings as user-defined colors. No - The color-
definition entities in the IGES files are ignored when 
importing to the drawing. 

yes, no no 

iges_in_dwg_line_font Data Exchange Controls the import of user-defined line fonts. Yes - 
Give default names to user-defined line styles without 
names in order ("IGES_1," "IGES_2" etc.). No - 
Imports the user-defined line fonts as Solid line font. 

yes, no no 

iges_in_group_to_dwg_l
ayer 

Data Exchange Yes - Converts an IGES group to drawing layers. No - 
The IGES group is not converted. 

no, yes no 

iges_note_disp Data Exchange Determines what to do when IGES note entities do not 
point to any views or the drawing entity. See the 
configuration option iges_zero_view_disp. 

as_geometry, all_views, 
no_views, as_is 

all_views 

iges_out_all_srfs_as Data Exchange Default - Outputs all surfaces as appropriate IGES 
surfaces. 114 - This option applies only to 
representations of surface shape. Trimmed surface 
entities (type 144) are exported regardless of setting. 
128 - Outputs all surfaces as IGES B-spline surfaces. 

128, 114, default default 

iges_out_assembly_defa
ult_mode 

Data Exchange Set default for assembly export via IGES. Flat - Single 
level model. One_level - Assy structure with pointers 
to components. All_levels - Assy structure with all 
comps to IGES files. All_parts - Assy to IGES files 
with geom info of comps and assy feats. 

public flat, internal one level, 
internal all levels, public 
one_level, public all_levels, 
internal all parts, public 
all_parts 

flat 

iges_out_catia_gdt_widt
h 

Data Exchange Yes - Enables the desired width of a gtol symbol to be 
exported to CATIA. 

yes, no no 

iges_out_catia_notes Data Exchange Yes - Breaks a large note (greater than 70 strings) 
down into smaller notes, each producing an IGES 
entity. 

yes, no no 
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Name Category Description Values Default Value 
iges_out_dwg_color Data Exchange Yes - Enables the export of RGB information to IGES 

files. The user-defined colors in the drawing are 
exported to an IGES file as color definition entities. No 
- Ignores the user-defined colors in the drawing when 
exporting IGES file. 

yes, no no 

iges_out_dwg_line_font Data Exchange Controls the export of user-defined line font through 
IGES. No - Exports all geometry as solid font. 

yes, no no 

iges_out_ent_as_bspline Data Exchange True - Exports all geometry entities, other than lines or 
arcs, as third-degree B-splines. False - Does not export 
entities as third-degree B-splines. 

true, false FALSE 

iges_out_jamais_compli
ant 

Data Exchange Yes - Specifies IGES output with special JAMA-IS 
subset specification, compliant with the version 1.02 of 
JAMA-IS (Japan Automobile Manufacturers 
Association IGES Subset Specification). No - Specifies 
normal IGES. 

yes, no no 

iges_out_mil_d_28000 Data Exchange Yes - Specifies IGES output that uses the MIL-D-
28000 entity subset. 

yes, no no 

iges_out_spl_crvs_as_12
6 

Data Exchange Converts all part geometry spline curves to IGES entity 
126 (B-spline) when creating an IGES file. 

no, yes yes 

iges_out_spl_srfs_as_12
8 

Data Exchange Converts all part geometry spline surfaces to IGES 
entity 128 (B-spline) when creating an IGES file. 

no, yes yes 

iges_out_start_note Data Exchange Yes - Exports the text specified by 
system_iges_header_file and user_iges_header_file as 
a note on the drawing. To control note placement, use 
the configuration file option put_iges_drawing_entity. 

yes, no no 

iges_out_symbol_entity Data Exchange Exports a drawing symbol as an IGES general symbol 
entity, IGES type number 228 (yes), or as its 
component entities: notes and lines. 

yes, no yes 
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Name Category Description Values Default Value 
iges_out_trim_curve_de
viation 

Data Exchange Sets the maximum value for the distance between an 
XYZ trimming curve (boundary) and the underlying 
surface of a trimmed surface 

- -1 

iges_out_trim_xyz Data Exchange Controls whether or not XYZ data is output in addition 
to UV data for trimmed surfaces. 

yes, no yes 

iges_out_trm_srfs_as_14
3 

Data Exchange Yes - Exports all surfaces to IGES entities 141 and 
143. This overrides option iges_out_trm_xyz. 

no, yes no 

iges_zero_view_disp Data Exchange When IGES geometry does not point to any views or 
the drawing entity. All_views - Creates a copy of the 
entity for each view. No_views - Does not create the 
entity at all. As_is - Creates the entity once, using only 
its own transformation information. 

all_views, no_views, as_is all_views 

ignore_all_ref_scope_set
tings 

Reference 
control 

Controls whether object-specific reference scope 
settings are ignored or not. Environment scope settings 
will still be enforced. See also allow_ref_scope_change 
and default_ext_ref_scope 

yes, no no 

ignore_export_geom_de
claration 

Reference 
control 

Ignore Export Geometry settings. yes, no no 

inch_grid_interval Features Modify grid space in inch units for handle movement. - 0.125 

info_output_format Environment Setup the default format type for information 
presentation. Text - information will be output as 
simple text. HTML - information will be output as html 
data. 

public text, public html, internal 
xml_text, internal dbg_text 

html 

info_output_mode Environment Sets default method for presenting information. Both - 
View information on screen and write information to 
file. Screen - View information on screen only. File - 
Write information to file only. Choose - Select method 
from the INFO OUTPUT menu. 

choose, screen, file, both both 
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Name Category Description Values Default Value 
initial_bend_y_factor Sheetmetal Specifies a constant used to determine the neutral bend 

line for a sheet metal part. This value is always used 
for non-cylindrical bends. It is used for regular bends 
only when no bend table is specified. 

- 0.5 

instance_search_exhausti
ve 

File Storage & 
Retrieval 

Specifies extent of instance search. Yes - Include file 
type when entering instance name in File>Open: type 
in input panel (e.g. inst_name.prt) or select in drop-
down list. If no .idx files are found, only working dir is 
searched; each generic is not. 

no, yes no 

interface_quality Data Exchange Sets amount of checking for overlapping lines and 
collecting lines of same pen color before exporting plot 
or 2-D file. 0 - No check or collection. 1 - No check, 
but collection. 2 - Partial check and collection. 3 - 
Complete check and collection. 

- 3 

intf_cadds_import_make
_solid 

Data Exchange Allows the user to solidify all closed quilts during 
import CADDS5 model. 

yes, no no 

intf_cadds_version Data Exchange Allows the user to switch between the default and 
alternate converter version for interface with CADDS5 

internal 10, internal 11, public 
12, public 13 

- 

intf_in_arclength_repara
m 

Data Exchange Yes - During import, the system attempts to change 
parameters for every non-analytical surface (Tabulated 
Cylinders, Surfaces of Revolution, Ruled Surfaces, 
Spline Surfaces, B-spline Surfaces), whose parameters 
differ significantly from arc-length. 

yes, no no 

intf_in_blanked_entities Data Exchange Filters the import of entities based on their blank status 
in the import file. 

yes, no yes 

intf_in_dwg_pnt_ent Data Exchange Yes - Converts an IGES or DXF point entity to a 
drawing point. 

yes, no no 

intf_in_dwg_view Data Exchange Controls if associativity in an imported IGES view is 
preserved. 3D_VIEWS - tries to create 3D views if 3D 
model exists in the file. 2D_VIEWS - Imported IGES 
views work as 2D. No - Imported IGES views are 
exploded and become unrelated. 

no, 2d_views, 3d_views 2d_views 
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Name Category Description Values Default Value 
intf_in_extract_profiles Data Exchange Default, no profiles in a data exchange file will be 

extracted for use. 
none, comp, all none 

intf_in_granite_direct_en
able 

Data Exchange Allows the user to switch back to the old 'Import 
Feature' method of reading Desktop .des files and 
Granite .g files into Pro/E. By default, Pro/E directly 
opens these models. 

yes, no yes 

intf_in_layer_asm_dialo
g 

Data Exchange Yes - Presents a dialog box to control the import of 
both layers and assemblies. You can choose from the 
list of layers and/or solids available in the file to select 
one or more for import. 

yes, no no 

intf_in_treat_polyline_as Data Exchange Enables you to choose the representation of imported 
independent XYZ polylines. The system interprets the 
imported polylines based on which option is chosen 
and displays them accordingly. 

public single_polyline, public 
single_spline, public 
set_of_curves, internal 
set_of_points 

single_polyline 

intf_in_use_template_m
odels 

Data Exchange Allows the user to use template models in 
Pro/INTERFACE import. 

yes, no no 

intf_out_as_bezier Data Exchange Exports all B-splines as Bezier surfaces. yes, no no 
intf_out_asm_mapped_it
em 

Data Exchange Export assembly components and instances using 
MAPPED ITEM entity. 

yes, no no 

intf_out_assign_names Data Exchange Controls how entity names are handled when an object 
is exported to STEP format from part or assembly 
mode. You can give unique names to Pro/ENGINEER 
datum points, datum axes, datum curves, surfaces, 
edges, and quilts. 

no_name, user_name, id_name no_name 

intf_out_auto_layer_ids Data Exchange Yes - Automatically assigns interface IDs for layers 
that were not assigned IDs during export. No - Does 
not assign interface IDs for layers that were not 
assigned IDs during export. 

yes, no no 

intf_out_blanked_entitie
s 

Data Exchange Filters export of entities based on their blank status yes, no yes 

intf_out_cat_start_model Data Exchange Specifies Catia start model to be used for CATIA II 
.model export. 

- - 
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Name Category Description Values Default Value 
intf_out_layer Data Exchange Layer mapping mechanism providing an ability to 

group entities to layers or blocks. 
none, part_layer, block_layer none 

intf_out_layer_rename_t
able 

Data Exchange Enables you to assign interface ids to layers during 
export 

- - 

intf_out_max_bspl_degr
ee 

Data Exchange Controls the maximum degree of exported B-spline 
surfaces when exporting through IGES 

- 16 

intf_out_text_length Data Exchange Sets text length in exported 2-D. As_is - Width of each 
character is width of strokes. Full_size - Width of each 
character is width of character text box. Adjusted - 
Adjusts spacing so no extra space left and end/start 
character do not overlap. 

as_is, full_size, adjusted full_size 

intf_use_variable_size Data Exchange Yes - IGES,DXF,STEP files with variable sized sheet 
information are imported andput on the appropriate 
variable-size format. Without a sheet size, the system 
tries to apply the correct variable-size format. No - The 
IGES,DXF,STEP drawing isplaced on a standard sized 
format. 

no, yes yes 

intf2d_fit_incompatible_
data 

Data Exchange YES - For import and export, fixes compatibility 
problems between 2-D external formats (such as IGES 
and DXF) and Pro/ENGINEER. 

yes, no no 

intf2d_iges_out_hatch Data Exchange YES - Exports draft xhatching as IGES sectioned area 
entity. NO - exports draft xhatching as separate 
geometric entities. 

yes, no no 

intf2d_in_acad_ignore_3
d 

Data Exchange YES - Ignore the 3DSOLID entities, if they exist, in 
the DXF/DWG file being imported in Drawing mode. 
Only, the 2D entities are processed. NO - Create an 
assembly by processing the 3DSOLID entities in the 
DWG/DXF file being imported in Drawing mode. This 
is the default value for this option. 

yes, no no 
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Name Category Description Values Default Value 
intf2d_in_create_multili
ne_note 

Data Exchange Create a single multi-line note on importing multi-line 
text when is set to YES. 

yes, no yes 

intf2d_in_iges_hatch_bn
d_layer 

Data Exchange Yes - Places all sectioned areas boundary imported 
from the IGES file in one layer named 
IGES_HATCH_BOUNDARY. NO - Does not place 
sectioned areas boundary in one layer. 

yes, no no 

intf2d_out_acad_mtext Data Exchange Create a single MTEXT entity for multi-line text notes 
when is set to YES. 

yes, no yes 

intf2d_out_acad_text_ali
gn 

Data Exchange As_is - Exports notes to DXF/DWG with their original 
alignment values. Fit - Exports notes with FIT 
alignment. 

as_is, fit as_is 

intf2d_out_cgm_ver Data Exchange Provides the ability to choose CGM metafile version 
when exporting from Pro/E drawing. 

1, 3 1 

intf2d_out_enhanced_ent
s 

Data Exchange Controls whether the enhanced entities (SPLINE and 
HATCHING) are converted to the corresponding DXF 
entities or represented as separate lines and polylines. 

spline_and_hatch, spline_only, 
hatch_only, none 

spline_and_hatch

intf2d_out_open_log_wi
ndow 

Data Exchange Yes - Opens Export Log File in special window. No - 
the Log File will not appear in the window. 

yes, no no 

intf2d_out_pnt_ent Data Exchange Yes - Exports a drawing point to IGES, DXF or DWG 
as a point entity. No - Exports a drawing point as shape 
entities. 

yes, no no 

intf3d_ideas_import_filt
er 

Data Exchange Enables UI to selectively import I-DEAS part and 
assembly models from the I-DEAS .mf1 and .pkg 
container files. 

yes, no no 

intf3d_ideas_install_dir Data Exchange Specifies the path for I-DEAS installation. Use the full 
pathname to avoid problems. 

- - 



Parametric Technology Corporation 42 Pro/ENGINEER Wildfire 2.0 Configuration Options 

Name Category Description Values Default Value 
intf3d_ideas_run_comm
and 

Data Exchange Specifies the I-DEAS run command. Default command 
is "ideas". 

- ideas.cmd 

intf3d_in_close_open_bo
undaries 

Data Exchange Controls fixing of open boundaries on imported 
surfaces. 

yes, no no 

intf3d_in_enable_layer_j
oin 

Data Exchange No - Join surfaces on import as geometry is loaded 
from file. Yes - Use new method to join surfaces by 
layer (surfaces contained on the same layer are joined 
together first) with a better chance of joining those 
surface elements to form closed geometry. 

yes, no yes 

intf3d_in_include_items Data Exchange Specifies what entity types you want to import from a 
file. 

srfs_crvs_pnts, srfs_crvs, 
crvs_pnts, srfs_pnts, srfs, crvs, 
pnts 

srfs_crvs_pnts 

intf3d_out_cat2_ident_cr
v 

Data Exchange Specifies model parameter IDENT_CRV while 
exporting to Catia. 

- -1 

intf3d_out_cat2_ident_pt Data Exchange Specifies model parameter IDENT_PT while exporting 
to Catia. 

- -1 

intf3d_out_cat2_infinity Data Exchange Specifies model parameter INFINITY while exporting 
to Catia. 

- -1 

intf3d_out_cat2_model_
sz 

Data Exchange Specifies model parameter MODEL_SZ while 
exporting to Catia. 

- -1 

intf3d_out_cat2_sag Data Exchange Specifies model parameter SAG while exporting to 
Catia. 

- -1 

intf3d_out_cat2_step Data Exchange Specifies model parameter STEP while exporting to 
Catia. 

- -1 

intf3d_out_datums_by_d
efault 

Data Exchange Determines whether datum curves are included when 
exporting IGES files in Batch mode. 

yes, no no 

intf3d_out_default_optio
n 

Data Exchange Controls the type of 3-D data output through 
Pro/BATCH to an IGES or STEP file. 

wireframe, surfaces, 
wireframe_surfaces, solid, 
shells, none 

surfaces 
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Name Category Description Values Default Value 
intf3d_out_extend_surfa
ce 

Data Exchange Specifies how surfaces are handled for exporting files 
to other systems 

yes, no yes 

intf3d_out_force_surf_n
ormals 

Data Exchange IGES and PDGS export. Controls normals of non-
analytic surfaces. Yes - Forces the surface normals to 
point in a consistent direction. No - Does not force the 
surface normals to point in a consistent direction. 

yes, no no 

intf3d_out_surface_devi
ation 

Data Exchange Sets maximum allowable deviation between original 
and resulting surfaces in the process of converting 
Pro/ENGINEER surfaces to spline surfaces. By setting 
this you convert surfaces with a better approximation 
than by using the current model accuracy. 

- -1 

intf3d_parasolid_export_
schema 

Without 
Category 

  - sch_10004 

intf3d_ug_install_dir Without 
Category 

Specifies the path for Unigraphics installation. Use the 
full pathname to avoid problems. 

- - 

isogen_attribute_map_fil
e 

Piping Specifies the mapping between isogen parameter and 
attribute name. 

- $PTCSRC/text/pi
ping_data/isodata
/isogen_attribute_

map.ptd 
isogen_endtype_map_fil
e 

Piping Specify name of file mapping Pro/Piping endtypes with 
ISOGEN endtypes 

- $PTCSRC/text/pi
ping_data/isodata
/isogen_endtype_

map.ptd 
isogen_mandatory_attr_f
ile 

Piping Specify file containing mandatory attribute filenames 
used by ISOGEN. 

- isogen.fls 

isogen_nominal_size_ma
p_file 

Piping Specify name of file mapping Pro/Piping Size with 
Nominal Sizes in MM and Inches 

- $PTCSRC/text/pi
ping_data/isodata
/isogen_nominal_

size_map.ptd 
isogen_output_files_dir Piping Specify directory to save the PCFs created by ISOGEN 

interface 
- - 
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Name Category Description Values Default Value 
isogen_pcf_filename_for
mat 

Piping Specify format to create filenames of PCF files being 
created 

- mnemonic,-
,specification,-

,number 
isogen_symbol_map_file Piping Specify name of file for mapping Pro/Piping selection 

names with ISOGEN symbol keys (SKEY)s 
- $PTCSRC/text/pi

ping_data/isodata
/isogen_symbol_

map.ptd 
jlink_java_command Without 

Category 
Specifies a command to start JRE for J-Link. May 
contain arguments and environment variables. 
Overrides the default, see also jlink_java2. 

- - 

jlink_java2 Application 
Programming 
Interfaces 

Option to force use of Java-2 JRE command line 
("java" instead of "jre") 

off, on on 

kbd_cmd_abbreviation User Interface On - Enables use of abbreviations when entering menu 
commands from the keyboard. 

on, off off 

kbd_selection User Interface Provides the ability to select locations in the graphics 
area via the keyboard. Yes - Selection in the graphics 
area may be performed via the keyboard. No - 
Selection in the graphics area requires a mouse. 

no, yes no 

keep_info_datums Features Sets the initial state of how the system treats datums 
and features created at run time. 

yes, no yes 

lang_propagate File Storage & 
Retrieval 

Specifies language storage options. The option 
provides flexibility for objects that use a different 
language than the current 

yes, no yes 

let_proe_rename_pdm_o
bjects 

Data 
Management 

Determines whether an object fetched from a PDM 
database can be renamed in a Pro/Engineer session. 

no, yes no 
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Name Category Description Values Default Value 
linear_tol Dimensions & 

Tolerances 
An alternate format for setting default linear tolerance 
dimensions. First value sets the number of decimal 
places. Second value is the actual tolerance. For 
example, 6 0.000025 sets tolerance to six decimal 
places. The default tolerance is 0.000025. 

- 0 

linear_tol_0.0 Dimensions & 
Tolerances 

Specify a range for default tolerances of linear and 
angular dimensions. These values affect only models 
created after the tolerance options are specified in the 
configuration file. 

- 1 

linear_tol_0.00 Dimensions & 
Tolerances 

Specify a range for default tolerances of linear and 
angular dimensions. These values affect only models 
created after the tolerance options are specified in the 
configuration file. 

- 1 

linear_tol_0.000 Dimensions & 
Tolerances 

Specify a range for default tolerances of linear and 
angular dimensions. These values affect only models 
created after the tolerance options are specified in the 
configuration file. 

- 1 

linear_tol_0.0000 Dimensions & 
Tolerances 

Specify a range for default tolerances of linear and 
angular dimensions. These values affect only models 
created after the tolerance options are specified in the 
configuration file. 

- 1 

linear_tol_0.00000 Dimensions & 
Tolerances 

Specify a range for default tolerances of linear and 
angular dimensions. These values affect only models 
created after the tolerance options are specified in the 
configuration file. 

- 1 

linear_tol_0.000000 Dimensions & 
Tolerances 

Specify a range for default tolerances of linear and 
angular dimensions. These values affect only models 
created after the tolerance options are specified in the 
configuration file. 

- 1 

lods_enabled Model Display Determines whether or not the system uses Level of 
Detail in shaded models during dynamic orientation 
(panning, zooming and spinning). 

no, yes no 
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Name Category Description Values Default Value 
lods_value Model Display When lods_enabled is Yes, this value specifies the 

default value used to display LODs. The value is a 
percentage of the edge size vs the total size of the 
model. 

- 50 

log_dwg_spr1150166_de
tection 

Without 
Category 

Create a log file and include if a particular drawing 
needs correction for SPR #1150166. 

no, yes no 

maintain_limit_tol_nomi
nal 

Dimensions & 
Tolerances 

Maintains the nominal value of a dimension regardless 
of the changes that you make to the tolerance values. 

yes, no no 

make_parameters_from_
fmt_tables 

Drawing Determines the handling of values entered in a format 
table when you replace one drawing format with 
another. Yes - Stores entered values for format table 
and copies them with the table. No - Prompts you to re-
enter all the values for the format table. 

yes, no no 

make_proj_view_notes Drawing Automatically adds view names to projection views in 
the format "VIEW viewname-viewname." You can 
modify the view name after adding the view to the 
drawing. 

yes, no no 

mapkey Miscellaneous Stores a keyboard macro. Use Tools>Mapkeys to 
create, edit and delete mapkeys. 

- - 

mark_approximate_dims Dimensions & 
Tolerances 

Yes - Displays a tilde (~) in front of a dimension that is 
set to display as a fraction and has an actual value that 
is not rounded to equate exactly to the displayed 
fractional value (the fraction shows 7/32 but the actual 
value is .22, not 0.21875). 

yes, no no 

mass_property_calculate Environment Calculate mass properties upon regeneration or by user 
request. 

by_request, automatic by_request 

max_animation_time Model Display When the orientation, or zoom state, of the 
Pro/ENGINEER window changes, an animation 
sequence of a predefined duration takes place. This 
option controls the maximum time the system spends 
animating. 

- 1 
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Name Category Description Values Default Value 
maximum_texture_size Model Display Allocates a limit to texture size and controls the 

resizing of texture maps that are used inside 
Pro/ENGINEER graphics only. It has no effect on 
PhotoRender. 

64x64, 128x128, 256x256, 
512x512 

- 

mdl_tree_cfg_file User Interface Specifies the Model Tree configuration file to be 
loaded when Pro/ENGINEER is started. 

- - 

mdo_cl_executable Mechanism Path for Custom Load executable. - - 
mdo_density Mechanism Mass density for dynamics. - 0 
mdo_enable_joint_frictio
n 

Mechanism Enable joint axis friction. yes, no no 

mdo_explicit_integration Mechanism Enable explicit integration for dynamic analyses. yes, no no 

mdo_spring_wire_radius Mechanism Spring wire radius for dynamics spring icons. - 0.15 

mdo_use_mm_body_ord
er 

Mechanism Use Mechanica Motion body order. (Make the ground 
to be the first body in connection). 

yes, no no 

measure_sig_figures Environment Sets the number of significant figures displayed as 
results when using the Measure dialog box from the 
Info menu. 

- 6 

medusa_2d_config_file Data Exchange Specifies the Medusa 2D Interface config. file. 
Absolute or relative path to the file can be used. 

- - 

mentor_ver_2_0 Data Exchange Yes - Exports the file in IDF 2.0 format. No - Exports 
the file in IDF 1.0 format unless IDF 2.0 is selected 
from the ECAD FORMAT menu. 

yes, no yes 

menu_font User Interface Specify font used in the Pro/ENGINEER menu bar, 
menus, and all their children. Specify the comma-
delimited variables in any order (italic bold, 24, times 
or 24, times, italic bold have the same effect). Any 
omitted variable uses the standard setting. 

- - 
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Name Category Description Values Default Value 
menu_show_instances File Storage & 

Retrieval 
Determines whether instance names listed in instance 
index files appear in file lists. 

yes, no yes 

menu_translation User Interface Specifies the language in which the menus display 
when running non-English version of Pro/ENGINEER. 

yes, no, both yes 

merge_smt_srfs_without
_seam 

Sheetmetal Yes - no edge left at the merge if the sheetmetal 
surfaces being merged are same surfaces. No - edge is 
left even between same sheetmetal surfaces. 

yes, no yes 

mesh_spline_surf Model Display Turns the blue mesh surface lines on or off. no, yes no 

meter_grid_interval Features Modify grid space in meter units for handle movement. - 0.001 

mfg_auto_ref_prt_as_ch
k_srf 

Manufacturing Yes - In 3, 4, and 5 axis contour and conventional mill 
sequences, the entire reference part is selected as check 
surfaces by default when computing the NC sequence 
toolpath for those sequences. No - You select the check 
surfaces. 

yes, no yes 

mfg_auto_retract_clear_
dist 

Without 
Category 

  - -0.001 

mfg_customize_dialog Manufacturing Yes - Uses the new customize dialog box for 
customizing NC sequences. No - Uses the Release 19.0 
menus. 

yes, no yes 

mfg_ijk_num_digits Manufacturing Sets the number of digits for i, j, k data points in a CL 
data file. 

- 10 

mfg_info_location Manufacturing top left /bottom right -Position of the mfg. Info dialog 
box. 

top_left, bottom_right top_left 

mfg_modal_command_fi
le 

Manufacturing Enables you to make some of the APTn index topics 
modal, which means that you repeatedly get a list of 
major keywords corresponding to this topic upon 
completing a command line. 

- - 
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Name Category Description Values Default Value 
mfg_param_mode Manufacturing Simple - The parameter tree is shown with a subset of 

the parameters. Advanced - The parameter tree is 
shown with the entire set of parameters. 

simplified, advanced simplified 

mfg_process_print_dir Without 
Category 

Specifies the directory where Mfg Process html page 
get stored. Use the full pat hname to avoid problems. 

- - 

mfg_process_table_setup
_dir 

Without 
Category 

Specifies the directory where Mfg Process Table 
settings get stored. Use the full pathname to avoid 
problems. 

- - 

mfg_process_template_d
ir 

Without 
Category 

Specifies the directory where Mfg Process Templates 
get stored. Use the full pathname to avoid problems. 

- - 

mfg_start_model_dir File Storage & 
Retrieval 

Provides the complete path to the directory containing 
mfg start assemblies. 

- - 

mfg_template_dir Manufacturing Specifies the storage directory for NC templates. 
Specify full path to avoid problems. NC templates are 
used in Expert Machinist. Templates store the recipe 
for a toolpath as the method of tool retrieval. 

- - 

mfg_workpiece_transpar
ency 

Manufacturing   - 0.5 

mfg_xyz_num_digits Manufacturing Sets the number of digits for x, y, z data points in a CL 
data file. 

- 10 

millimeter_grid_interval Features Modify grid space in millimeter units for handle 
movement. 

- 1 

min_animation_steps Model Display When the orientation, or zoom state, of the 
Pro/ENGINEER window changes, an animation 
sequence of predefined duration takes place. This 
option controls the minimum number of frames used in 
the animation sequence. 

- 6 

minimum_angle_dimens
ion 

Dimensions & 
Tolerances 

Controls the minimum angle value under which 
Pro/ENGINEER assumes colinearity of the selected 
items when creating a driven dimension. 

- 1 
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Name Category Description Values Default Value 
model_allow_ref_scope_
change 

Reference 
control 

Yes - Users can change the scope setting of 
components. 

yes, no yes 

model_grid_balloon_dis
play 

Environment Controls the display of grid balloons. yes, no yes 

model_grid_neg_prefix Environment Enables you to specify the prefix to use for negative 
numbers in the balloon capture of the grid. 

- - 

model_grid_num_dig Environment Controls the number of decimal places displayed in the 
balloon capture. 0 - Only integers display. 

- 0 

model_grid_spacing Environment Sets the default model grid spacing. - 1.5 
model_note_display Environment Allows users to display all shown model notes. Applies 

to shown notes, and does not change Show/Erase status 
of the notes. 

yes, no yes 

model_notes_as_labels Environment Gives the option to display notes as either full text or 
as label. Can also be toggled with environment option 
"Display Notes as Names." 

no, yes no 

model_rename_template File Storage & 
Retrieval 

Sets the default renaming convention for copied 
assemblies. The default new name is the old name 
appended with an underscore (_). Adding a template 
such as [*a1*=*b1*] changes every occurrence of a1 to 
b1 (e.g. TOP_A1_BRACKET copies to 
TOP_B1_BRACKET). 

- - 

model_tree_start Environment Toggles display of the Model Tree. Yes - Displays the 
Model Tree window along with its model. No - Does 
not display the Model Tree window. 

no, yes yes 

modelcheck_enabled Environment Enable ModelCHECK yes, no yes 
mold_layout_origin_nam
e 

Casting & 
Mold Design 

Sets a specified coordinate system as the default for the 
cavity layout origin. 

- - 
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Name Category Description Values Default Value 
mold_vol_surf_no_auto_
rollback 

Casting & 
Mold Design 

Do not perform automatic rollback while modifying 
mold volumes or parting surfaces. 

yes, no no 

motion_envlp_alert Simulation Displays the Motion Envelope alert the first time the 
quality level is increased. 

yes, no yes 

mp_calc_level Without 
Category 

Specifies the level of mass properties calculation. assembly_only, all_models assembly_only 

msg_translation User Interface Specifies language in which Messages are displayed 
when running non-English version of Pro/ENGINEER. 

yes, no yes 

multiple_skeletons_allo
wed 

Without 
Category 

Allows/restricts multiple skeleton. yes, no no 

multipoint_location_cou
nt 

Electromechani
cal 

Specifies the maximum number of cable locations to 
allow in one feature. To create locations as features, set 
to 1. To limit the number of locations in one feature, 
set to a number between 2 and 100. 

- 1 

native_kbd_macros User Interface Specifies support of keyboard macros written in native 
language (for example, German). 

no, yes no 

nc_jobman_visible Without 
Category 

Yes - make "Submit Path" and "Abort Path" visible. 
No - make "Submit Path" and "Abort Path" invisible. 

yes, no no 

nccheck_type Manufacturing Vericut will be used for NC material removal 
simulation. 

vericut, nccheck vericut 

ncl_file_extension Manufacturing Sets the default file extension for Pro/MFG CL data 
files. Enter the file extension only (without the 
preceding "."). For example, apt produces filename.apt. 

- ncl 

ncmdl_bar_stock_part_p
ath 

Manufacturing Sets path for storage and retrieval of stock instances for 
creating workpiece in NC Model. Specify full path, 
including part name, to avoid problems. 

- $PTCSRC/text/nc
mdl_data/ncmdl_

bar.prt 
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Name Category Description Values Default Value 
ncmdl_billet_stock_part
_path 

Manufacturing Sets path for storage and retrieval of stock instances for 
creating workpiece in NC Model. Specify full path, 
including part name, to avoid problems. 

- $PTCSRC/text/nc
mdl_data/ncmdl_

billet.prt 

ncpost_type Manufacturing Set to GPOST to access the default post processor 
supplied with Pro/NCPOST. 

gpost, ncpost - 

new_asm_regen_revnum
s 

Assembly Yes - Regenerate command will not increase the model 
revision number of the top assembly unless features 
belonging to the top assembly actually get regenerated. 
Regenerate command will increase model revision 
numbers of subassemblies if features in the 
subassembly regenerate. No - Regenerate command 
will always increase the revision number of the top 
assembly and almost never increase the revision 
numbers of subassemblies, regardless of whether or not 
assembly features regenerate. 

yes, no yes 

new_designate_ui Without 
Category 

  yes, no yes 

new_parameter_ui User Interface Enable the new parameter editor and user interface. yes, no yes 

new_ref_part_name_disa
bled 

Without 
Category 

  yes, no yes 

new_relation_ui User Interface Enable the new relations editor and user interface. yes, no yes 

nt_cache_dirs Without 
Category 

Addresses performance issues that occur when 
Pro/ENGINEER is used with NTFS-mounted file 
systems. See Technical Support TAN for more 
information. 

yes, no - 

number_user_colors Colors Specifies the maximum number of different wireframe 
colors that can display in the graphics area(s) at any 
given moment. 

- -1 

offset_line_def_color Assembly 
Process 

Specifies the color that offset lines are displayed in 
drawings. 

- 0 
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Name Category Description Values Default Value 
offset_line_def_font Assembly 

Process 
Specifies the font in which offset lines are displayed in 
drawings. 

- - 

open_simplified_rep_by
_default 

File Storage & 
Retrieval 

Name of rep to retrieve upon file open or "Yes" to 
always invoke open rep dialog. 

- no 

orientation Model Display Establishes the initial standard view orientation. 
User_default - System uses X-axis and Y-axis values 
defined by options x_axis and y_axis. 

isometric, trimetric, 
user_default 

trimetric 

orientation_style Without 
Category 

Set spin orientation style to dynamic or anchored. anchored, dynamic dynamic 

orthogonal_snap Electromechani
cal 

Controls non-90 degree routing in Pro/DIAGRAM. 
Yes - Turns the Ortho Snap function on. You can 
sketch wires only at the default horizontal and vertical 
orientation. No - Enables you to sketch wires in 
drawings at angles other than the default. 

yes, no yes 

output_mfg_xml Without 
Category 

Allows export/import mfg model to/from xml file. Yes 
- make Export/Import options visible. No - make them 
invisible. 

yes, no no 

overlays_enabled System Yes - Enables Pro/ENGINEER screens and menus to 
be placed on different overlay layers of the hardware 
graphics card. This frees memory for Pro/ENGINEER 
use. 

yes, no yes 

override_store_back File Storage & 
Retrieval 

Forces the storage of objects retrieved from other 
directories to the current working directory. 

yes, no no 

package_constraints Assembly Action to take for packaged components in Assembly 
mode. Update - Updates components if assembly 
changes. Freeze - Does not move components if 
assembly changes. Disallow - Does not allow packaged 
components in assembly (must be fully constrained). 

disallow, freeze, update update 

package_ref_alert Assembly Control whether alert dialog is given when packaged 
component is referenced. Yes - Allow alert when a 
packaged component is referenced. No - No Alert is 
given when a packaged component is referenced. 

yes, no no 
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param_dec_places User Interface Sets the number of decimal places (0-14) to display in 

parameters. 
- 6 

parenthesize_ref_dim Dimensions & 
Tolerances 

Encloses reference dimensions in parentheses. No - 
Follows reference dimensions with the text "REF". 

yes, no no 

pdf_plot_config Printing & 
Plotting 

Set the pcf filename to be used when saving to PDF 
format. 

- - 

pdm_rev Data 
Management 

Specify how the system parameter, PDM_REV, should 
be formatted. Only useful for objects submitted to 
Pro/PDM or Pro/INTRALINK. 

pdmrev_fmt_rev_ver, 
pdmrev_fmt_rev, 
pdmrev_fmt_branch_rev_ver, 
pdmrev_fmt_branch_rev 

pdmrev_fmt_rev_
ver 

pen_slew Printing & 
Plotting 

Sets the pen speed for both x and y directions for 
plotters that are compatible with this option. Consult 
your plotter's user guide for more information. 

- -1 

pen_slew_xy Printing & 
Plotting 

Sets the pen speed for the x and y directions 
individually for plotters that are compatible with this 
option. The first value is the x value and the second, 
the y value. They should be separated by a space. 

- -1 

pen_table_file Printing & 
Plotting 

Specifies a default pen mapping table which 
supersedes other pen mapping information. 

- table.pnt 

pen1_line_weight Printing & 
Plotting 

Sets the weight of entities plotted with pens using an 
electrostatic plotter. The weight is a range from 1 
(thinnest) to 16 (thickest). 

- 4 

pen2_line_weight Printing & 
Plotting 

Sets the weight of entities plotted with pens using an 
electrostatic plotter. The weight is a range from 1 
(thinnest) to 16 (thickest). 

- 1 

pen3_line_weight Printing & 
Plotting 

Sets the weight of entities plotted with pens using an 
electrostatic plotter. The weight is a range from 1 
(thinnest) to 16 (thickest). 

- 2 
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pen4_line_weight Printing & 

Plotting 
Sets the weight of entities plotted with pens using an 
electrostatic plotter. The weight is a range from 1 
(thinnest) to 16 (thickest). 

- 3 

pen5_line_weight Printing & 
Plotting 

Sets the weight of entities plotted with pens using an 
electrostatic plotter. The weight is a range from 1 
(thinnest) to 16 (thickest). 

- 2 

pen6_line_weight Printing & 
Plotting 

Sets the weight of entities plotted with pens using an 
electrostatic plotter. The weight is a range from 1 
(thinnest) to 16 (thickest). 

- 3 

pen7_line_weight Printing & 
Plotting 

Sets the weight of entities plotted with pens using an 
electrostatic plotter. The weight is a range from 1 
(thinnest) to 16 (thickest). 

- 1 

pen8_line_weight Printing & 
Plotting 

Sets the weight of entities plotted with pens using an 
electrostatic plotter. The weight is a range from 1 
(thinnest) to 16 (thickest). 

- 4 

photorender_capability_
warnings 

Photorender Allows the user to disable warnings about PhotoLux 
only capabilities. 

yes, no yes 

photorender_default_hei
ght 

Photorender Sets the default height (in pixels) for the custom size 
rendered output 

- 450 

photorender_default_wid
th 

Photorender Sets the default width (in pixels) for the custom size 
rendered output 

- 600 

photorender_memory_us
age 

Photorender Sets the memory limit that Pro/PHOTORENDER 
allows for model processing. Do not use commas in the 
memory value, as Pro/ENGINEER interprets these as 
decimals. 

- 256 

photorender_preview_sc
ale 

Photorender Allows user defined size ratio at which 
Pro/PHOTORENDER will render, using the default 
Render To: Full Window Preview setting. Increasing 
the value creates higher quality rendering with slower 
performance. Reducing the value produces reverse 
results. 

- 0.5 
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pick_aperture_radius System Specifies the size of the area about the mouse when 

making selections. Units are 1/1000 of screen size. 
- 7 

pick_chain_tangent_only Drawing Specifies the extent of draft entity chains selected. Yes 
- Only entities in the chain that are tangent will be 
selected. No - All entities connected end to end will be 
selected. 

yes, no no 

pipe_3d_bend_theor_int
_pts 

Without 
Category 

Yes - Displays theoretical intersections and bends in 
three-dimensional models. 

no, yes no 

pipe_bend_locations_csy
s_units 

Piping Define which assembly units will be used for the 
piping bend locations calculations. Yes - to use 
coordinate system assembly units. No - to use pipeline 
assembly units. 

yes, no no 

pipe_pre_22_bendinfo_c
onv 

Piping Convert bend report information generated prior to 
Pro/ENGINEER 2000i-2 to current saved analysis 
format. 

yes, no yes 

pipe_solid_centerline Piping Yes - Display Pro/PIPING centerlines. No - Do not 
display Pro/PIPING centerlines. 

yes, no yes 

pipe_solid_label_format Piping Specify the pipe solid label format that will be used to 
automatically generate pipeline labels. 

- size,-
,specification,-
,mnemonic,-

,number,-
,insulation 

pipe_update_pre_20_int
_pts 

Piping Yes - Pipelines created prior to Release 20.0 are 
updated with intersection point entities. The entities are 
created in session by Info>Regen Info or when you 
retrieve the model. 

yes, no no 

pipeline_assembly_librar
y_dir 

Piping Sets the default pipeline assembly library directory. - $PTCSRC/text/pi
ping_data/pipelin

elib 
pipeline_assembly_name
_format 

Piping Sets the default pipeline assembly name format. - mnemonic,-
,number 
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Name Category Description Values Default Value 
pipeline_label_format Piping Specify the pipeline label format that will be used to 

automatically generate pipeline labels. 
- size,-

,specification,-
,mnemonic,-

,number,-
,insulation 

pipeline_solid_start_part
_name 

Piping Sets the default pipeline solid start part name. - pipeline_solid_sta
rt.prt 

pipeline_spool_label_for
mat 

Piping Specify the pipeline spool label format that will be 
used to generate the spool labels during pipeline spool 
generation. 

- mnemonic-
number-

prefix[0]spoolnu
m[01]suffix[] 

pipeline_start_assembly_
name 

Piping Sets the default pipeline start assembly name. - pipeline_start.asm

piping_appearance_map
_file 

Piping Sets the default piping appearance map filename. - $PTCSRC/text/pi
ping_data/master
_catalog/piping_a

ppearance.map 
piping_bolt_nut_select_f
ile 

Piping Piping bolts and nuts selection file. - $PTCSRC/text/pi
ping_data/master
_catalog/piping_b
olt_nut_select.ptd

piping_design_method Piping Sets the current Piping design method for pipeline 
modeling. 

non_spec_driven, spec_driven, 
user_driven 

non_spec_driven

piping_end_compatibilit
y_file 

Piping Sets the default piping end compatibility filename. - $PTCSRC/text/pi
ping_data/master
_catalog/piping_e
nd_compatibility.

ptd 
piping_extend_dim_sche
me 

Piping Specify a dimension scheme for piping extend 
segment. 

cartesian, cylindrical, spherical spherical 

piping_fitt_angle_toleran
ce 

Piping Sets the default piping fitting angle tolerance value. - 1.5 
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piping_fitt_category_ma
p_file 

Piping Sets the default piping fitting category map filename. - $PTCSRC/text/pi
ping_data/sample
_project/piping_fi
tt_category_map.

ptd 
piping_fitt_library_dir Piping Sets the default piping fitting library directory. - $PTCSRC/text/pi

ping_data/fittingli
b 

piping_fluid_parameter Piping Enables/disables the Parameters tab in Create Pipeline 
Dialog 

no, yes no 

piping_insulation_dir_fil
e 

Piping Sets the default piping insulation directory filename. - $PTCSRC/text/pi
ping_data/sample
_project/piping_i
nsulation_dir.ptd

piping_joint_fitting_clea
rance 

Piping Sets the piping joint minimum fitting clearance value. - 1 

piping_joint_fitting_offs
et 

Piping Sets the piping joint minimum fitting offset value. - 1 

piping_manufacture_dir_
file 

Piping Sets the default piping manufacture directory filename. - $PTCSRC/text/pi
ping_data/master
_catalog/piping_
manufacture_dir.

ptd 
piping_material_file Piping Sets the default piping material filename. - $PTCSRC/text/pi

ping_data/master
_catalog/piping_

material.ptd 
piping_mcat_dir Piping Sets the default piping master catalog directory. - $PTCSRC/text/pi

ping_data/master
_catalog 

piping_mcat_dir_file Piping Sets the default piping master catalog directory 
filename. 

- $PTCSRC/text/pi
ping_data/master
_catalog/piping_

mcat_dir.ptd 
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Name Category Description Values Default Value 
piping_min_bolting_clea
rance 

Piping Sets the default piping minimum bolting clearance 
value. 

- 1 

piping_project_data_dir Piping Sets the default Project data directory. - $PTCSRC/text/pi
ping_data/sample

_project 
piping_schematic_driven Piping Set the Schematic Driven Pipeline Modeling ON/OFF no, yes no 

piping_schematic_xml_d
ir 

Piping Specify directory with full path containing schematic 
information XML file(s). 

- c:/tmp/dump 

piping_spec_dir_file Piping Sets the default piping specification directory filename. - $PTCSRC/text/pi
ping_data/sample
_project/piping_s

pec_dir.ptd 
piping_system_tree_for
mat 

Piping Sets the default piping model tree format. - mnemonic 

piping_thumb_wheel_in
crement 

Piping Sets the default piping thumb wheel increment value. - 1 

piping_thumb_wheel_rat
io_inc 

Piping Sets the default piping thumb wheel ratio increment 
value. 

- 0.01 

piping_wildfire_convert Piping Always ask before converting old piping assemblies to 
update the network structure. 

manual, never, automatic manual 

plot_file_dir Printing & 
Plotting 

Specifies the directory where plot files should be 
written. Use the full pathname to avoid problems. For 
example /home/users/plotfiles. 

- - 

plot_linestyle_scale Printing & 
Plotting 

Specifies the scaling factor for the DOTFONT line 
style in a plot. 

- 1 

plot_names Printing & 
Plotting 

Yes - Plot files are given descriptive extensions when 
created. No - All plot files (except PostScript plots) are 
simply given the extension .plt, as before. 

yes, no - 
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plot_proceed_dialog Printing & 

Plotting 
Yes - Enables the Plot Proceed dialog which provides a 
choice for delaying the printing of plot files. This is 
useful for large plots when using lp print commands. 
The lp command may not access the plot file before it 
is removed resulting in no output. 

yes, no no 

plot_to_scale_full_wind
ow 

Printing & 
Plotting 

Provides the ability to exclude empty window space 
when plotting the model to scale. 

yes, no - 

plotter Printing & 
Plotting 

Establishes the default plotter for making plot files. - - 

plotter_command Printing & 
Plotting 

Sets the command that you use to start a plot on your 
system; for Windows NT or Windows 95, 
windows_print_manager option configures 
Pro/ENGINEER to plot to a recognized device in the 
Windows NT or Windows 95 print manager. 

windows_print_manager - 

plotter_handshake Printing & 
Plotting 

Specifies the type of plotter handshake initialization 
sequence generated in the plotter files. 

hardware, software - 

popuphelp_font User Interface Specify font used in the Pro/ENGINEER pop-up help. 
Add the comma-delimited variables in any order (italic 
bold, 24, times or 24, times, italic bold have the same 
effect). Any omitted variable uses the standard setting. 

- - 

postscript_compression Printing & 
Plotting 

Specifies whether or not to compress exported shaded 
PostScript files. Yes - A shaded postscript file created 
with File>Export will be compressed. This will 
increase processing time. 

yes, no no 

preferred_save_as_type File Storage & 
Retrieval 

Allows customizing the order of the Type selections 
found under File ->Save A Copy. 

- - 
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Name Category Description Values Default Value 
prehighlight Environment Yes - Selectable items beneath the pointer are 

highlighted prior to being selected. No - Selectable 
items beneath the pointer are not highlighted prior to 
being selected. 

internal none, internal all, 
internal geom_only, public yes, 
public no 

- 

prev_proc_comp_def_co
lor 

Assembly 
Process 

Specify the default color for components added to a 
process assembly in a previous step. 

- 0 

prev_proc_comp_def_fo
nt 

Assembly 
Process 

Specify the default font for previously added 
components in a process assembly. 

- - 

pro_ansys_path FEM Specifies path to ANSYS executable. - - 
pro_catalog_dir Casting & 

Mold Design 
Sets the path to the catalog directory containing the 
catalog menu and the names of other catalog files, such 
as ejector pins. For example: pro_catalog_dir 
proe_loadpoint/apps_data/mold_data/catalog. Use full 
path name to avoid problems. 

- - 

pro_cav_lay_rule_dir Casting & 
Mold Design 

Sets the default directory for cavity layout rules. Use 
the full path name to avoid problems. 

- - 

pro_cbltrm_dir Electromechani
cal 

Sets the directory from which terminators are retrieved. 
Use the full pathname to avoid problems. 

- - 

pro_colormap_path Colors Specifies the directory path for a color map (.map) file 
to be loaded from disk. Use the full path name to avoid 
problems. 

- - 

pro_crosshatch_dir File Storage & 
Retrieval 

Specifies a default directory for your cross-hatch 
library in which you can save cross-hatching patterns 
for later retrieval. Its value is the full path name of the 
default directory. 

- - 

pro_dtl_setup_dir Drawing Sets the directory for the drawing setup files. If this 
option is not set, the system uses the default setup 
directory. 

- - 
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pro_editor_command User Interface Enables use of an editor other than the system editor 

when the option editor has been specified as the value 
for the options drawing_file_editor and/or 
part_table_editor and/or relation_file_editor. 

- - 

pro_font_dir File Storage & 
Retrieval 

Sets the default font directory (Pro/ENGINEER will 
load all fonts in this directory into the drawing 
regardless of the contents of the system and working 
directories). 

- $PTCSRC/text 

pro_format_dir Drawing Sets the default directory for the drawing format 
library. Use the full pathname to avoid problems. 

- - 

pro_gplug_dir Data Exchange Specifies the directory in which Granite application 
plug-ins are located. Use the full pathname to avoid 
problems. 

- $PTCSRC/i486_n
t/gplugs 

pro_group_dir Features Sets the default directory for the user-defined feature 
(UDF) library. If not specified, your current working 
directory is the default. Use the full pathname to avoid 
problems. 

- - 

pro_insulation_dir Piping Specifies the directory to search for insulation files 
used in Pro/PIPING. Use full path name to avoid 
problems. 

- - 

pro_library_dir File Storage & 
Retrieval 

Sets the default directory for the Pro/ENGINEER 
libraries (or any libraries you have built containing the 
proper index menu files). Use the full pathname to 
avoid problems. 

- - 

pro_material_dir File Storage & 
Retrieval 

Sets the default directory for the part material library. 
Use the full pathname to avoid problems. 

- - 

pro_mdb_dir Manufacturing Sets the default directory for the Machinability 
Database (MDB) files. Use the full pathname to avoid 
problems. 

- - 
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pro_mf_cl_dir Manufacturing Sets the default directory for the manufacturing CL 

data files.Use the full pathname to avoid problems. 
- - 

pro_mf_clamp_dir Manufacturing Specifies the directory where the manufacturing 
clamps can be found. 

- - 

pro_mf_param_dir Manufacturing Sets the default directory for the manufacturing 
parameter files. Use the full pathname to avoid 
problems. 

- - 

pro_mf_tprm_dir Manufacturing Sets the default directory for the manufacturing tool 
files. Use the full pathname to avoid problems. 

- - 

pro_mf_workcell_dir Manufacturing Sets the default directory for the manufacturing 
workcell files. Use the full pathname to avoid 
problems. 

- - 

pro_mfg_cmdsyn_dir Manufacturing Sets the default directory for the syntax menu files in 
Pro/MFG. Use the full pathname to avoid problems. 

- - 

pro_nastran_path FEM Specifies the path to the MSC/NASTRAN executable 
(nastran). 

- - 

pro_note_dir Drawing Specifies the directory from which to retrieve notes 
entered from a file. Use the full path name to avoid 
problems. 

- c:/tmp/dump 

pro_palette_dir Drawing Sets the default directory for drawing symbol palette 
files. 

- $PTCSRC/symbo
ls/palette 

pro_pip_fitt_dir Piping Specifies the directory to search for fittings used in 
Pro/PIPING. 

- - 

pro_pip_lnstk_dir Piping Specifies the directory to search for linestock files used 
in Pro/PIPING. Use full path name to avoid problems. 

- - 

pro_plot_config_dir Printing & 
Plotting 

Sets the directory of your user-defined plotter 
configuration file. Use the full pathname to avoid 
problems. 

- - 
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pro_sheet_met_dir Sheetmetal Sets the default directory of your user-defined bend 

tables. If not set, the Pro/SHEETMETAL supplied 
bend tables are used. Use the full path name to avoid 
problems. 

- - 

pro_smt_params_dir Sheetmetal Specifies the directory to save/retrieve Sheet metal 
parameters files. Use full path name to avoid problems. 

- - 

pro_solver_name FEM Specifies the name of the user-defined solver to be 
included in the SOLVE menu. See also 
pro_solver_path. 

- - 

pro_solver_path FEM Specifies the path to the user-defined solver whose 
name is defined in the SOLVE menu. See also 
pro_solver_name 

- - 

pro_spool_dir Electromechani
cal 

Sets the directory from which spools are retrieved. Use 
the full pathname to avoid problems. 

- c:/tmp/dump 

pro_stheno_command Data Exchange Specifies the command for Stheno launch. - - 

pro_surface_finish_dir File Storage & 
Retrieval 

Sets the default directory for your user-defined surface 
finish symbols. Use the full pathname to avoid 
problems. 

- $PTCSRC/symbo
ls/surffins 

pro_symbol_dir Drawing Set and automatically create the default directory for 
saving and retrieving user-defined symbols. If you do 
not specify a directory, the system uses the current 
working directory. Use full path name to avoid 
problems. 

- c:/tmp/dump 

pro_texture_library Photorender Allows the user to specify a different graphics library. - - 

pro_unit_length Environment Sets the default units for new objects. unit_inch, unit_foot, unit_mm, 
unit_cm, unit_m 

unit_inch 

pro_unit_mass Environment Sets the default units for mass for new objects. unit_ounce, unit_pound, 
unit_ton, unit_gram, 
unit_kilogram, unit_tonne 

unit_pound 
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pro_unit_sys Environment Specifies the default system of units for new models. mks, cgs, mmns, fps, ips, 

proe_def, mmks 
- 

pro_weld_params_dir Weld Specifies the directory to search when a weld 
parameter file is needed. 

- - 

prodevdat Application 
Programming 
Interfaces 

Specify the name of the Pro/Develop registry file. - - 

profile_output_utils Manufacturing Affects CL-Data output for profile milling sequences. 
Yes - Sequence parameter output_point is available 
with options: tip - Toolpath is output with respect to 
the tool center; on_profile - Toolpath is output with 
respect to the profile of the tool. 

yes, no no 

prompt_on_erase_not_di
sp 

File Storage & 
Retrieval 

Specifies whether or not to display a prompt allowing 
you to save your undisplayed objects. This option is 
used in conjunction with the Erase > Not Displayed 
command on the File menu. 

yes, no no 

prompt_on_exit User Interface Determines if you are prompted to save objects when 
exiting a Pro/ENGINEER session. 

yes, no no 

proncpost_dbf Manufacturing Enter directory path to NCPost database file. - - 

propagate_change_to_pa
rents 

File Storage & 
Retrieval 

When saving objects with option save_objects set to 
Changed or Changed_and_specified, Pro/ENGINEER 
verifies which models are. Yes - Any model that is a 
parent of a changed model is considered to be a 
changed model when determining what to save. 

yes, no no 

prorembatch_queue_man
ager 

Manufacturing Enables toolpath computation on a separate host 
machine. Required values are Processor name, Remote 
machine's hostname, Type of transport (always 0), 
RPC processor number (same as that of remote 
processor), Version of queue manager. 

- - 

protable_in_background System Yes - Starts Pro/TABLE editor in the background. 
Reduces time between pressing a menu button that uses 
Pro/TABLE and entering the data. 

no, yes yes 
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protkdat Application 

Programming 
Interfaces 

Specify the Pro/TOOLKIT registry file. - - 

provide_pick_message_a
lways 

User Interface No - A message describing the (pre)selected item is 
provided only while querying. Yes - A message 
describing the selected item is provided in all cases 
(i.e. even when Query is not used). 

yes, no no 

ps_output_with_pagesize Printing & 
Plotting 

Specifies whether or not to include pagesize 
information when generating postscript files from 
Pro/ENGINEER. No - Pro/ENGINEER will omit 
Adobe level 2 pagesize information from the header of 
the postscript file. 

yes, no yes 

ptncpost_dbf Manufacturing Enter directory path to NCPost database file. - - 

punch_axis_points Sheetmetal Yes - Enables the creation of punch axis points in 
Sheetmetal cuts and punches. 

yes, no no 

put_iges_drawing_entity Data Exchange Specifies whether or not to suppress the output of the 
IGES drawing entity, #404, to the IGES file. No - The 
drawing entity is not output. 

yes, no yes 

radial_hole_linear_dim Without 
Category 

YES - Option for creation of radial hole with a linear 
dimension will be available. 

yes, no no 

raster_plot_dpi Printing & 
Plotting 

Determines the resolution for plotter outputs variables 
are in dots per inch. 

100, 200, 300, 400 100 

ratio_grid_interval Features Modify grid space in percentage units for handle 
movement. 

- 0.05 

read_famtab_file_on_ret
rieve 

File Storage & 
Retrieval 

No - Ignores filename.ptd. Yes - Creates and saves 
filename.ptd and uses that file when retrieving the 
generic. 

no, yes no 

read_parameters_of_excl
uded 

Data 
Management 

Allow Pro/ENGINEER designated parameters on 
excluded objects in Simplified Representation to be 
visible in Model Tree columns. 

yes, no no 
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read_vda_in_pset_as_spl
ine 

Data Exchange Specifies whether a VDA Pset entity is imported to 
Pro/ENGINEER as a spline. 

yes, no yes 

recompute_iges_dim_val
ue 

Data Exchange Indicates whether to recompute associative dimensions 
upon import of an IGES file. 

yes, no no 

ref_scope_copy_color Reference 
control 

Set color of backuped references. - 55 

ref_scope_copy_color_c
hange 

Reference 
control 

Enable changing colors of backuped references during 
selection. 

no, yes yes 

ref_scope_no_pick_to_c
opy 

Reference 
control 

Disable selecting references backuped by references 
control. 

no, yes no 

ref_scope_no_pick_to_p
rohibit 

Reference 
control 

Disable selecting references prohibited by references 
control. 

no, yes yes 

ref_scope_prohibit_color Reference 
control 

Set color of prohibited references. - 45 

ref_scope_prohibit_color
_change 

Reference 
control 

Enable changing colors of prohibited references during 
selection. 

no, yes yes 

regen_backup_directory Environment Specifies the directory in which the system stores 
regen_backup models. (See 
regen_backup_using_disk.) The primary default is the 
current directory, but if that directory is read-only, the 
secondary default is the /tmp directory. 

- - 

regen_backup_using_dis
k 

Environment Specifies whether or not the system backs up the 
current model to disk before each regeneration. 

yes, no no 

regen_int_mdls_on_retr Without 
Category 

Yes to regen models intersected with assem feats 
during assembly retrieval. 

yes, no no 

regen_layout_w_assem Assembly Specifies whether or not the layout will be 
automatically regenerated upon assembly regeneration. 

yes, no yes 

regenerate_read_only_ob
jects 

Data 
Management 

Determines whether an object fetched from a 
Pro/INTRALINK database with blocking status can be 
regenerated in a Pro/Engineer session. 

yes, no yes 

relation_file_editor User Interface Sets the editor used to edit relations. protab, editor editor 
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Name Category Description Values Default Value 
relation_text_trail_outpu
t 

Miscellaneous No - Disable trail output from Text layout in Relation 
Parameter UI if it hasn't been changed. 

yes, no yes 

relations_num_const_uni
ts 

Without 
Category 

Specifies whether diagnostic should be issued when an 
unitless numeric value causes relation expression 
evaluation trouble. 

yes, no no 

relations_units_sensitive Without 
Category 

Set the default unit sensitivity (ignore or take into 
account parameter/dimensions units) in creation of new 
relation data (legacy relation data will not be unit 
sensitive until "converted" to one). 

yes, no yes 

remember_last_attach_ty
pe 

Without 
Category 

Yes - Sets the default of the ATTACH TYPE menu of 
the last options picked. 

yes, no yes 

remember_last_get_poin
t_option 

Drawing Yes - Sets the default of the GET POINT menu as the 
last option picked among Pick Pnt, Vertex and On 
Entity. 

yes, no no 

rename_drawings_with_
object 

File Storage & 
Retrieval 

Controls whether the system copies associated 
drawings automatically with parts and assemblies. 

none, part, assem, both none 

replace_comp_name_me
thod 

Assembly Sets the naming convention used when replacing 
components. 

transfer, remove, preserve transfer 

replace_comp_notes_me
thod 

Without 
Category 

Specify treatment of notes when components are 
replaced. Transfer - transfer to new component. 
Remove - remove the notes. Preserve - save notes in 
case component is restored. 

transfer, remove, preserve transfer 

reserved_menu_space User Interface Reserves space for extra menus to the right of the 
Pro/ENGINEER window (1.0-4.0). This option 
overrides windows_scale. 

- 1 

restricted_gtol_dialog Dimensions & 
Tolerances 

Determines whether the Geometric Tolerance dialog 
restricts the user by graying out elements that are 
considered "illegal". 

yes, no yes 

restricted_val_definition Without 
Category 

Specify name and path of the file contained restricted 
values definition. 

- - 



Parametric Technology Corporation 69 Pro/ENGINEER Wildfire 2.0 Configuration Options 

Name Category Description Values Default Value 
retain_display_memory File Storage & 

Retrieval 
Determines if the display of an object currently on the 
screen is kept in memory when you quit the window. 
Doing so (yes) makes the retrieval of objects in 
memory faster. 

yes, no yes 

retrieve_data_sharing_re
f_parts 

File Storage & 
Retrieval 

Automatic reference parts retrieval for dependent data 
sharing features. 

yes, no, ignore_missing no 

retrieve_merge_ref_parts Without 
Category 

Automatic reference parts retrieval for dependent 
Merge. 

yes, no, ignore_missing no 

reverse_spiral_finish_typ
e 

Without 
Category 

If the option value is 1, the tool path is obtained from 
standard one by reversing it; if the option value is 2, 
the tool path starts from an inner circle. 

- 0 

right_mouse_button_pop
up 

User Interface Specify whether or not the right mouse button pop up 
menu is available or not. 

yes, no yes 

rotate_postscript_print Printing & 
Plotting 

Specifies rotation for printing. Yes - Rotates a 
PostScript plot 90 degrees counterclockwise. Use when 
you are plotting a landscape drawing on a portrait-type 
laser printer, or a portrait drawing on a landscape-type 
laser printer. 

yes, no - 

save_bitmap Data 
Management 

When performing a save on a model, determines what 
level of the assembly will have bitmap images created 
of modified components. 

none, toplevelonly, alllevels none 

save_bitmap_type Data 
Management 

When performing a save on a model, determines the 
type of image file that is created for that model. Used 
with "save_bitmap" option. 

bmp, tiff, gif, cgm, jpeg bmp 

save_display Drawing Yes - Stores view geometry and detail items such as 
solid dimensions. These items are displayed when 
retrieving the drawing in View-Only mode. 

no, yes no 

save_drawing_picture_fi
le 

Drawing Embed - Embeds a picture file inside a drawing for 
preview purposes. Export - Saves a drawing file as a 
picture file in the working directory when saving a 
drawing. Both - Does both embed and export. 

no, export, embed, both no 
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Name Category Description Values Default Value 
save_hidden_items_w_st
atus 

Without 
Category 

The items on the "Hidden Items" temporary layer are 
stored permanently when layer display status is saved 
with Save Status command. 

yes, no yes 

save_instance_accelerato
r 

File Storage & 
Retrieval 

With family tables of solid parts, determines how 
instances are saved. None - Instance accelerator files 
not used. Explicit - Save instance accelerator files 
when instances explicitly saved. Always - Always save 
instance accelerator files. 

none, explicit, always none 

save_model_display File Storage & 
Retrieval 

Sets amount of graphical data stored. Wireframe - 
Wireframe data. Shading_high - Most detail (shaded). 
Shading_low - Least detail (shaded). Shading_lod - 
Detail determined by View Performance dialog 
(shaded). 

public wireframe, public 
shading_low, public 
shading_high, public 
shading_lod, internal 
no_display 

shading_lod 

save_modified_draw_mo
dels_only 

Drawing Determines whether the system saves the model after 
you have changed it. No - Saves the model every time 
that you store the drawing. 

no, yes yes 

save_object_in_current File Storage & 
Retrieval 

Use with the override_store_back option. Yes - Objects 
retrieved from a directory where you do not have write 
permission will be stored in the current directory. No - 
These objects are not saved at all. 

yes, no no 

save_objects File Storage & 
Retrieval 

Determines when an object and its dependent objects 
(such as a part used in an assembly) are stored. 

all, changed, 
changed_and_specified, 
changed_and_updated 

changed_and_spe
cified 

save_triangles_flag Model Display Spinning shaded images with software graphics only. 
Note: This option has no effect if your system uses 
hardware graphics. 

no, yes no 

save_unchanged_pdm_o
bject 

Data 
Management 

Determines how to save in the current working 
directory an object fetched from a Pro/PDM database 
into a Pro/ENGINEER session. 

as_ref, as_copy as_ref 
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scope_invalid_refs Reference 

control 
Prohibit - System will abort all attempts to create 
external reference violating the scope. Backup - 
Warning appears. Abort reference creation or declare 
as out-of-scope reference. If you declare, backup 
copies to part/assembly and backup is referenced. 

copy, prohibit copy 

search_path File Storage & 
Retrieval 

Specifies list of directories to search (in order) for 
object/file retrieval. These directories, the working 
directory, and directories in search.pro file (refer to 
search_path_file) are Pro/ENGINEER's search path. 
Use full path name to avoid problems. 

- - 

search_path_file File Storage & 
Retrieval 

Specifies path to text file search.pro (a list of directory 
path names). The directories listed in search.pro, the 
working directory, and directories specified by 
search_path are Pro/ENGINEER's search path. Use full 
path name to avoid problems. 

- - 

section_color Sketcher Specifies the color of sketched sections. default, drawing_color - 
sel_insts_on_comp_retri
eval 

Assembly Yes - If the components used in the assembly instances 
are themselves generics, the systems asks if you want 
to choose an instance as each component is retrieved. 
No - The generic model of the component is retrieved 
automatically. 

yes, no no 

select_hidden_edges_in_
dwg 

Drawing Controls selectability of hidden edges in no-hidden 
drawing views. 

yes, no yes 

select_on_dtm_edges Environment All_modes - Select a datum plane by clicking on its 
visual boundary. Sketcher_only - Select a datum plane 
by clicking on its tag in modes other than Sketcher. If 
you use Query frequently, set this option to 
Sketcher_only. 

all_modes, sketcher_only all_modes 

selection_of_removed_e
ntities 

Drawing Yes - Entities in front of cross-section (planar or offset) 
can be selected, clipped (using Z-clipping), or erased 
with EDGE DISP menu. No - Geometry, datum points 
or curves, cosmetic features, threads, grooves, or 
coordinate systems cannot be erased. 

yes, no no 
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Name Category Description Values Default Value 
set_menu_width User Interface Determines width of menu manager panels. Default 

value is equivalent to 8 character widths. Acceptable 
range is from 8 to 20. Values lower than 8 and higher 
than 20 are ignored. 

- -1 

set_model_types_to_sav
e 

File Storage & 
Retrieval 

Determines which model types are used in the Save 
Changed command. The format is a list of extensions 
separated by spaces. 

- asm 

set_trail_single_step System Yes - Enables a trail file to be single-stepped by 
entering . 

yes, no no 

shade_mfg_ref_models Manufacturing No - Does not process reference parts when generating 
the shaded image (to save time). Yes - Shades 
reference parts when generating shaded images. 

no, yes yes 

shade_moving_comp Model Display Yes - Shades assembly components while they are 
being moved. No - Displays components in wireframe 
while they are being moved. 

yes, no yes 

shade_surface_feat Model Display Controls the shading of surface features. yes, no yes 
shade_windows Model Display Enables shading of objects in all windows. This option 

does not also enable color shading. 
all_windows, one_window all_windows 

shade_with Model Display Controls the display of datum curves on shaded 
objects. 

curves, no curves 

shaded_postscript_backg
round 

Printing & 
Plotting 

Specifies how background colors are handled in 
Postscript files of shaded objects. 

yes, no no 

show_all_mold_layout_b
uttons 

Casting & 
Mold Design 

Sets all mold layout buttons visible. yes, no no 

show_axes_for_extr_arc
s 

Model Display Determines if axes are created for newly extruded arcs. yes, no no 

show_cav_fit_loc_sys Miscellaneous Allows the printing of the transformation matrix of a 
Pro/Verify Fit into a file. 

yes, no no 
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Name Category Description Values Default Value 
show_dim_sign Environment No - Dimension values always appear positive. 

Negative value creates geometry to opposite side. Yes - 
Entering negative value for dim displayed as negative 
creates geometry to same side. Dims for csys and 
datum point offsets always show neg/pos value. 

yes, no no 

show_geom_checks_on_
creation 

Features Yes - The SHOW ERRORS menu appears at the end of 
feature creation when the feature being created has 
Geometry Checks. 

yes, no no 

show_preview_default Drawing This option determines the default behavior for 
preview in Show/Erase. 

keep, remove remove 

show_shaded_edges Model Display Controls the edge color when shading. Yes - Edges are 
displayed in darker color than the surfaces to which 
they belong. No - Edges are displayed in the same 
color as the surfaces to which they belong. 

no, yes no 

shrinkage_value_display Casting & 
Mold Design 

Determines how dimensions are displayed when 
shrinkage is applied to a model with 
Pro/MOLDESIGN. Percent_shrink - Dimensions 
appear with the shrinkage percent. 

final_value, percent_shrink percent_shrink 

shrinkwrap_alert Assembly Displays the Shrinkwrap alert the first time the quality 
level is increased. 

yes, no yes 

silhouettes Model Display Specifies whether silhouette edges are displayed or not 
by default. 

no, yes yes 

sim_additive_mass Simulation Treats Mass Idealizations as additive if they are applied 
to the same entity and suppresses Mass precedence 
rules. 

yes, no no 

sim_asm_modeling Simulation Controls automatic creation of assembly links and free 
connections in Mechanica. The default is YES. 

yes, no yes 

sim_beamsection_path FEM Specifies the path where the Beam Sections will be 
stored. 

- - 

sim_display_agem_contr
ols 

Simulation Toggles display of AutoGEM Controls. yes, no yes 
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Name Category Description Values Default Value 
sim_display_arrow_scale Simulation Toggles automatic arrow scaling. yes, no yes 
sim_display_arrow_tail_
touching 

Simulation Toggles display of Load arrows to have tails or heads 
touching. 

yes, no no 

sim_display_beam_relea
ses 

Simulation Toggles display of Beam Release icons. yes, no yes 

sim_display_beam_secti
ons 

Simulation Toggles display of beam section icons. yes, no yes 

sim_display_beams Simulation Toggles display of beam icons. no, yes yes 
sim_display_contact_reg
ions 

Simulation Toggles display of Contact Region icons. yes, no - 

sim_display_fasteners Simulation Toggles display of Fastener icons. yes, no - 
sim_display_gaps Simulation Toggles display of gap icons. no, yes - 
sim_display_in_spin Simulation Toggles display of simulation objects in Dynamic Spin. yes, no yes 

sim_display_interfaces Without 
Category 

Toggles display of structure connection icons. no, yes yes 

sim_display_load_colors Simulation Toggles display of Load colors. yes, no yes 
sim_display_load_distrib
ution 

Simulation Toggles display of distributed load vectors over entire 
entity. 

yes, no yes 

sim_display_load_icons Simulation Toggles display of load icons. yes, no yes 
sim_display_load_value Simulation Toggles display of Load values. yes, no yes 
sim_display_masses Simulation Toggles display of mass icons. no, yes - 
sim_display_matl_assign
ments 

Simulation Toggles display of Material Assignment icons. yes, no yes 

sim_display_measures Simulation Toggles display of Simulation Measure icons. yes, no yes 

sim_display_mesh_and_
model 

Simulation Toggles display of Mesh together with Model. yes, no no 

sim_display_mesh_contr
ols 

Simulation Toggles display of Mesh Controls. yes, no yes 

sim_display_mesh_entiti
es 

Simulation Toggles display of Mesh entities. yes, no yes 
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Name Category Description Values Default Value 
sim_display_mesh_mode Simulation Specifies the mode of mesh display in FEM 

preprocessor. Values: NO_MESH, WIREFRAME, 
HIDDEN, NOHIDDEN, SHADING. 

no_mesh, wireframe, hidden, 
nohidden, shading 

wireframe 

sim_display_mesh_quali
ty 

Simulation Specifies the quality of mesh display in Mechanica. 
Values: FINE, MEDIUM, COARSE. 

fine, medium, coarse coarse 

sim_display_mesh_shell
s_thick 

Simulation Toggles the display of shell thickness in Mechanica 
mesh. YES - Display shells with real thickness. NO - 
Display shells with zero thickness. 

no, yes no 

sim_display_mesh_shrin
k_elems 

Simulation Controls display of Mesh through a specified 
percentage of shrinking of its elements. 

- -1 

sim_display_motion_ca
ms 

Simulation Toggles display of motion cam icons. yes, no yes 

sim_display_motion_con
nections 

Simulation Toggles display of motion connection icons. yes, no yes 

sim_display_motion_con
tact_rgns 

Simulation Toggles display of motion contact region icons. yes, no yes 

sim_display_motion_des
ign_vars 

Simulation Toggles display of design variable icons. yes, no yes 

sim_display_motion_dri
vers 

Simulation Toggles display of motion driver icons. yes, no yes 

sim_display_motion_gea
rs 

Simulation Toggles display of motion gear icons. yes, no yes 

sim_display_motion_gro
und_pnts 

Simulation Toggles display of motion ground point icons. yes, no yes 

sim_display_motion_lcs Simulation Toggles display of local coordinate systems icons. yes, no yes 

sim_display_motion_loa
ds 

Simulation Toggles display of motion load icons. yes, no yes 

sim_display_motion_slot
s 

Simulation Toggles display of motion slot icons. yes, no yes 
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sim_display_names Simulation Toggles display of Simulation Object names. yes, no no 

sim_display_rigid_conne
ctions 

Simulation Toggles display of rigid connection icons. yes, no - 

sim_display_rigid_dof Simulation Toggles display of Rigid Link DOF icons. yes, no - 
sim_display_rigid_links Simulation Toggles display of Rigid Link icons. yes, no - 
sim_display_shells Simulation Toggles display of shell icons. no, yes yes 
sim_display_spot_welds Simulation Toggles display of spot weld icons. yes, no yes 
sim_display_springs Simulation Toggles display of spring icons. no, yes - 
sim_display_struct_const
raints 

Simulation Toggles display of structure constraint icons. yes, no - 

sim_display_struct_loads Simulation Toggles display of structure load icons. yes, no - 
sim_display_therm_bcs Simulation Toggles display of Thermal Boundary Condition icons. yes, no - 

sim_display_therm_load
s 

Simulation Toggles display of thermal load icons. yes, no - 

sim_display_weighted_d
of 

Simulation Toggles display of Weighted Link DOF icons. yes, no - 

sim_display_weighted_li
nks 

Simulation Toggles display of Weighted Link icons. yes, no - 

sim_display_welds Simulation Toggles display of Weld icons. yes, no yes 
sim_fatigue_biaxiality_c
orrect 

Simulation Controls the use of biaxiality correction. The default 
value is YES. 

yes, no yes 

sim_fatigue_biaxiality_
method 

Simulation Controls which method is used to model biaxiality: 
Klann-Tipton-Cordes, Hoffman-Seeger, or the most 
conservative (worst) of the two methods. The default 
value is WORST. 

worst, ktc, hs worst 

sim_fatigue_confidence_
level 

Simulation Specifies the percentage confidence in the predicted 
life result value. The default value is 90, and range is 
from 0.1 to 99.9 

- 90 

sim_fatigue_external_ma
tdata 

Simulation Controls the use of external material data. The default 
value is NO. 

no, yes no 
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Name Category Description Values Default Value 
sim_fatigue_hysteresis_g
ate 

Simulation Specifies the gate applied to cycle counting as a 
percentage of peak load. The default value is 1 and 
range is from 0 to 50. 

- 1 

sim_fatigue_infinite_life
_value 

Simulation Specifies the value for the lives beyond cutoff. The 
default value is 1e20 and range is from 1e15 to 1e30. 

- 1E+20 

sim_fatigue_mean_stress Simulation Controls the application of the mean stress correction. 
The default value is YES. 

yes, no yes 

sim_fatigue_mean_stress
_method 

Simulation Controls which method is used to model mean stress: 
the Smith-Watson-Topper Approach, Morrow 
Correction, or the most conservative (worst) of the two 
methods. The default value is WORST. 

worst, swt, morrow worst 

sim_fatigue_safety_marg
in 

Simulation Specifies a factor used to determine the Life 
Confidence quantity. The default value is 3 and range 
is from 1.1 to 100. 

- 3 

sim_fatigue_user_directo
ry 

Simulation Specifies the directory for user files (for example, 
external material files). The default value is the current 
directory. 

- - 

sim_fatigue_write_surf_
stress 

Simulation Controls writing of surface stresses to a neutral file. 
The default value is NO. 

no, yes no 

sim_fem_nastran_use_ps
hell 

Simulation Yes - use PSHELL cards, No - use PCOMP cards for 
laminate composite shells in NASTRAN output file. 

yes, no no 

sim_html_report_prefs_f
ile 

FEM Specifies the path to the Simulation post processor 
HTML report preferences file. 

- - 

sim_load_mech_mesh Simulation No - The user is prompted to load the existing 
Mechanica mesh file from the current working 
directory. Yes - The mesh file, if exists, is loaded 
automatically and the mesh is displayed. 

no, yes yes 
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Name Category Description Values Default Value 
sim_mat_poissons_notati
on 

Simulation Specifies the convention used for defining Poisson's 
ratio for anisotropic materials as being either Tsai 
(Column-normalized) or Jones (Row-normalized). This 
option affects only the labels for Poisson's ratio on the 
Material data form. 

tsai, jones tsai 

sim_max_memory_usag
e 

Simulation Specifies the amount of memory in megabytes to be 
used in Mechanica run and FEM mesher. The default 
value is 128. 

- 128 

sim_motion_analysis_ac
curacy 

Simulation Specifies the default accuracy to which Mechanica 
determines values at each increment of the analysis. 
This number represents the acceptable fractional error 
in the computation of joint axis positions and rates at 
each time increment of the analysis. The default value 
is 0.0001. 

- 0.0001 

sim_motion_analysis_as
sem_tol 

Simulation Specifies the default error allowed for the assembly 
analysis. The default value is 0.001. 

- 0.001 

sim_motion_analysis_du
ration 

Simulation Specifies the default length of time in seconds during 
which the analysis runs. The analysis duration can be 
less than the duration of the motion simulation. The 
default value is 10.0. 

- 10 

sim_motion_analysis_in
crement 

Simulation Specifies the default increment between steps at which 
Mechanica reports the motion of the mechanism. The 
default value is 0.1 

- 0.1 

sim_motion_analysis_int
egrator 

Simulation Controls the default integrator Mechanica uses when 
running the motion analysis. The value types are 
IMPLICIT (default) and EXPLICIT. 

implicit, explicit implicit 

sim_motion_analysis_m
ethod 

Simulation Controls the default method Mechanica uses to analyze 
the motion of your model. The default is 
FASTEST_AVAILABLE. 

fastest_available, 
time_integration, kinetostatic 

fastest_available

sim_motion_analysis_sta
rt_time 

Simulation Specifies the default time in seconds at which the 
motion analysis begins. The default value is 0. 

- 0 
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Name Category Description Values Default Value 
sim_motion_analysis_ve
l_tol 

Simulation Specifies the default error allowed for the velocity 
analysis. The default value is 0.001. 

- 0.001 

sim_motion_output_fly_
file 

Simulation Controls the creation of .fra file when saving results for 
a motion model, The .fra file is used to import a motion 
animation into Pro/FLY-THROUGH. The default is 
NO. 

no, yes no 

sim_nastran_use_coupm
ass 

Without 
Category 

Add PARAM,COUPMASS,1 in the Nastran deck file 
to enforce consistent mass matrix generation. 

yes, no no 

sim_output_ids_for_laye
rs 

Simulation Outputs FEM mesh element IDs on each layer into 
XML file. 

yes, no no 

sim_output_obj_names Without 
Category 

Output Beam Sections names, Analyses names, 
Coordinate Systems names as comments. 

yes, no no 

sim_pp_background_col
or 

Simulation Specifies the background color of the work area for the 
results display. The default value is PROE. 

proe, blue, black, white proe 

sim_pp_path_absolute Simulation Choose Absolute (Yes) or Relative (No) path to "rwd" 
file. 

yes, no yes 

sim_pp_template_dir Simulation Sets the default directory for results template files. - - 

sim_pp_vector_plot_arro
w_2d 

Simulation "Yes" plots 2D arrows, "NO" plots 3D arrows in 
Vector Plot of Mechanica Postporcessor. 

yes, no no 

sim_pp_vrml_export_for
mat 

Simulation Flags to denote VRML1.0 or VRML2.0 (default) 
output. 

vrml2.0, vrml1.0 vrml2.0 

sim_pp_vrml_feature_ed
ges 

Simulation Flag to enable the inclusion of feature edges in the 
VRML file. The default value is NO. 

no, yes no 
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Name Category Description Values Default Value 
sim_regen_on_entry Simulation Yes - Regenerate model on entrance to Simulation 

Application. No - Don't regenerate the model. 
yes, no yes 

sim_run_copy_fem_neut
ral_file 

Simulation Controls whether the FEM neutral file (with extension 
.fnf) is copied into the study directory. The default 
value is YES. 

yes, no yes 

sim_run_out_dir Simulation Specifies the directory for Mechanica run output 
storage. By default, the current directory is used. 

- - 

sim_run_tmp_dir Simulation Specifies the directory for Mechanica run temporary 
storage. By default, the current directory is used. 

- - 

sim_smooth_aspect_rati
o 

Simulation Sets the element aspect ratio criterion for the mesh 
smoothing process. 

- 7 

sim_smooth_edge_angle Simulation Sets the element edge angle criterion (Quad elements 
only), measured in degrees, for the mesh smoothing 
process. 

- 30 

sim_smooth_skew Simulation Sets the element skew angle criterion (Quad elements 
only), measured in degrees, for the mesh smoothing 
process. 

- 45 

sim_smooth_taper Simulation Sets the element taper criterion (Quad elements only) 
for the mesh smoothing process. 

- 0.5 

sim_smooth_warp_angle Simulation Sets the element warp angle criterion (Quad elements 
only), measured in degrees, for the mesh smoothing 
process. 

- 10 

sim_use_layers Simulation Allows layers to become groups for Mechanica 
Independent mode. 

no, yes no 
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Name Category Description Values Default Value 
simulation_fem_mode Simulation Yes - Activates FEM mode. No - Allows access to 

Mechanica only. Prompt (default) - Brings Mechanica 
Model Type Dialog. This option is used only if 
information about FEM mode is not yet stored with 
model. 

yes, no, prompt prompt 

simulation_process_auto
_advance 

Simulation If set to yes the Process Guide will advance to the next 
set automatically upon completion of the current step. 

yes, no no 

simulation_process_pro
mpt 

Simulation If set to yes, the Process Guide will be launched 
automatically upon entry into Mechanica, if template 
files are present. 

yes, no no 

simulation_process_tem
plate_dir 

Simulation Specifies the default location of the Process Guide 
template files. 

- - 

simulation_product Simulation Set Mechanica product being selected 
(Structure/Thermal/Motion). Prompt (default) - Brings 
Mechanica Model Type Dialog. This option is used 
only if information about Mechanica product is not yet 
stored with model. 

public structure, public thermal, 
internal mold, internal motion, 
public prompt 

prompt 

skeleton_model_default_
color 

Assembly Specifies the color Pro/ENGINEER uses to display 
new skeleton models. The three decimal values ranging 
from 0 through 100 specify (in order) the percentages 
of red, green, and blue in the resulting color. For 
example, 0 0 49 specifies medium blue. 

- 0 

sketcher_animated_modi
fy 

Sketcher No - The section is not animated as modifications are 
regenerated. 

yes, no yes 

sketcher_blended_backg
round 

Sketcher This option controls whether the blended background 
should be used in 3D Sketcher. The option has no 
effect if blended background is turned off generally. 

no, yes no 

sketcher_collinear_skam
ps 

Sketcher Yes - collinear constraints will be used by Intent 
Manager; No - collinear constraints will not be used by 
Intent Manager. 

no, yes yes 
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Name Category Description Values Default Value 
sketcher_dec_places Sketcher Sets the default number of decimal places displayed for 

dimensions in Sketcher. The extrusion depth or any 
other dimension you enter to create 3D geometry is 
controlled by the default_dec_places option. 

- 2 

sketcher_disp_constraint
s 

Sketcher Shows the constraints when sketching in Sketcher 
Mode; for example, H for horizontal, V for vertical, 
and so on. 

yes, no yes 

sketcher_disp_dimension
s 

Sketcher No - Suppresses the display of all dimensions while in 
sketcher. 

yes, no yes 

sketcher_disp_grid Sketcher Specify whether or not to display the sketcher grid. yes, no no 

sketcher_disp_vertices Sketcher No - Suppresses the display of yellow points on all 
vertices while in sketcher. 

yes, no yes 

sketcher_disp_weak_dim
ensions 

Sketcher Yes - weak dimensions will be displayed; No - weak 
dimensions will not be displayed. 

yes, no yes 

sketcher_equal_length_s
kamps 

Sketcher Yes - equal length constraints will be used by Intent 
Manager; No - equal length constraints will not be used 
by Intent Manager. 

no, yes yes 

sketcher_equal_radii_ska
mps 

Sketcher Yes - equal radii constraints will be used by Intent 
Manager; No - equal radii constraints will not be used 
by Intent Manager. 

no, yes yes 

sketcher_grid_angle Sketcher Enter a grid angle value to overide the default grid 
angle value. 

- 0 

sketcher_import_exact_g
eom 

Sketcher During import in sketcher use exact geometry. yes, no yes 

sketcher_intent_manager Sketcher Specifies which sketcher to use. Yes - Intent Manager 
is the default. No - Old sketcher is the default. 

yes, no yes 
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sketcher_lineup_hor_ska
mps 

Sketcher Yes - line up horizontal constraints will be used by 
Intent Manager; No - line up horizontal constraints will 
not be used by Intent Manager. 

no, yes yes 

sketcher_lineup_ver_ska
mps 

Sketcher Yes - line up vertical constraints will be used by Intent 
Manager; No - line up vertical constraints will not be 
used by Intent Manager. 

no, yes yes 

sketcher_lock_modified_
dims 

Sketcher Yes - modified dimensions will be locked; No - 
modified dimensions will not be locked. 

yes, no no 

sketcher_midpoint_skam
ps 

Sketcher Yes - midpoint constraints will be used by Intent 
Manager; No - midpoint constraints will not be used by 
Intent Manager. ) 

no, yes yes 

sketcher_num_digits Sketcher Enter a number of digits for scetcher accuracy. - 2 

sketcher_parallel_skamp
s 

Sketcher Yes - parallel constraints will be used by Intent 
Manager; No - parallel constraints will not be used by 
Intent Manager. 

no, yes yes 

sketcher_perpendicular_
skamps 

Sketcher Yes - perpendicular constraints will be used by Intent 
Manager; No - perpendicular constraints will not be 
used by Intent Manager. 

no, yes yes 

sketcher_point_on_entry
_skamps 

Sketcher Yes - point on entry constraints will be used by Intent 
Manager; No - point on entry constraints will not be 
used by Intent Manager. 

no, yes yes 

sketcher_refit_after_dim
_modify 

Sketcher Refits section after dimension modification in 2D 
section or when creating the first feature. 

yes, no yes 

sketcher_rel_accuracy Sketcher Enter a sketcher relative accuracy. - -1 
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sketcher_same_point_sk
amps 

Sketcher Yes - same points constraints will be used by Intent 
Manager; No - same points constraints will not be used 
by Intent Manager. 

no, yes yes 

sketcher_save_preview_i
mage 

Sketcher This option controls whether section files should be 
saved with embedded image information which can be 
used to preview sections in File/Open dialog. 

no, yes no 

sketcher_set_grid_metho
d 

Sketcher "Automatic" - grid spacing will be automatically set, 
"Manual" - grid spacing will be manually set. 

automatic, manual automatic 

sketcher_set_grid_x_spa
cing 

Sketcher Enter a x-grid spacing value to overide the default x-
grid spacing value. 

- 1 

sketcher_set_grid_y_spa
cing 

Sketcher Enter a y-grid spacing value to overide the default y-
grid spacing value. 

- 1 

sketcher_starts_in_2d Sketcher Defines initial model orientation in Sketcher mode. 
Yes - (2D orientation) Looking directly at section 
(sketching) plane. No - (Orientation unchanged) Sketch 
directly on the 3D part. 

yes, no yes 

sketcher_symmetric_ska
mps 

Sketcher Yes - symmetric constraints will be used by Intent 
Manager; No - symmetric constraints will not be used 
by Intent Manager. 

no, yes yes 

sketcher_tangent_skamp
s 

Sketcher Yes - tangent constraints will be used by Intent 
Manager; No - tangent constraints will not be used by 
Intent Manager. 

no, yes yes 

sketcher_undo_stack_li
mit 

Sketcher Sketcher saves a copy of each function performed. The 
number of possible saved functions depend on the 
number specified in the option. The undo menu can be 
used to remove the stored functions. 

- 200 
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skip_small_surfaces Model Display Gives the user the option not to display small shaded 

surfaces. Disabling this option will improve display 
quality at the expense of speed. It is most useful for 
creating screen snap shots. 

no, yes yes 

smooth_lines Model Display Choose whether to smooth lines by default or not. no, yes no 

smt_bend_notes_dflt_dis
play 

Sheetmetal Define the default state of Bend Note display 
(sheetmetal Mode) 

yes, no yes 

smt_bend_notes_directio
n_down 

Sheetmetal Define the Down Direction symbol for Bend Notes 
(sheetmetal Mode) 

- default 

smt_bend_notes_directio
n_up 

Sheetmetal Define the Up Direction symbol for Bend Notes 
(sheetmetal Mode) 

- default 

smt_bend_notes_order Sheetmetal Define the Fields Order for Bend Notes (sheetmetal 
Mode) 

- &type&direction
&angle 

smt_bend_notes_type_fo
rmed 

Sheetmetal Define the Formed symbol for Bend Notes (sheetmetal 
Mode) 

- default 

smt_bend_notes_type_ro
lled 

Sheetmetal Define the Rolled symbol for Bend Notes (sheetmetal 
Mode) 

- default 

smt_crn_rel_display Sheetmetal Yes - Corner relief notes will be displayed. No - 
Corner relief notes will not be displayed. 

no, yes yes 

smt_mp_method Sheetmetal MASS - Suppressed Flat Pattern and Flatten Forms 
will be temporary resumed before mass properties 
calculation of sheetmetal part. CG - Mass Properties 
calculation will be performed on current state of 
sheetmetal part. BOTH - Both methods will be used 
one after the other. 

mass, cg, both cg 

smt_outside_mold_lines Sheetmetal Yes - Outside Mold Lines will be created during Flat 
Pattern creation. 

yes, no no 

spherical_map_size Drawing Size of Spherical map texture image used for 
environment mapping. Bigger size will have better 
image quality but will be slow to regenerate. 

256x256, 512x512, 1024x1024 256x256 
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Name Category Description Values Default Value 
spin_center_display Environment Determines whether or not the spin center symbol 

displays. 
yes, no yes 

spin_rate_zoom_sensitiv
e 

Model Display Allows slower spinning when zoomed in on a model. yes, no no 

spin_with_notes Model Display Yes - 3D feature and model notes are displayed during 
dynamic spinning of a model. 

yes, no yes 

spin_with_orientation_ce
nter 

Without 
Category 

Display orientation center while reorienting. yes, no yes 

spin_with_part_entities Model Display Yes - Datum features will be displayed during dynamic 
spinning of a model. 

yes, no no 

spin_with_silhouettes Model Display Yes - Silhouette lines will be displayed during dynamic 
spinning of a model. 

no, yes no 

start_appmgr Environment Determines whether or not the application manager 
starts when Pro/ENGINEER is started. 

yes, no yes 

start_model_dir File Storage & 
Retrieval 

Provides the complete path to the directory containing 
start parts and assemblies. 

- - 

std_nastran_template FEM Sets the file path of a NASTRAN deck template. Use 
full path to avoid problems. 

- - 

step_appearance_layers_
groups 

Data Exchange No - Output of Appearances, Layers, and Groups is 
enabled for STEP standard AP214. Yes - Output of 
Appearances, Layers, and Groups is enabled for STEP 
standard AP203. 

yes, no no 

step_export_ap214_asm
_def_mode 

Data Exchange Toggles the default setting of the File Structure field in 
the STEP Export dialog box for supported assembly 
STEP export files. 

single_file, 
separate_parts_only, 
separate_all_objects 

single_file 
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step_export_dwg_views Data Exchange AS_3D_VIEWS - Export 3-D model geometry with its 

associative views. AS_3D_VIEWS_ASSOC_DRAFT - 
Export 3-D model geometry with its associative views 
and view related annotations. NO - Export only 2-D 
representations of the 3-D models. This is the default. 

no, as_3d_views, 
as_3d_views_assoc_draft 

no 

step_export_format Data Exchange Specifies output format when exporting to STEP. 
AP203_IS - Formats output to ISO 10303 AP203IS 
format. AP214_CD - Formats output with geometry 
that meets the specification for the long-term schema 
for AP214cc1. 

public ap203_is, internal 
ap203_dis, public ap214_cd, 
public ap202_is, public 
203_is_ext, public ap214_dis, 
public ap209_dis, public 
ap214_is 

ap203_is 

store_tool_path_file Manufacturing Specifies how tool path information is computed. Yes - 
Tool path information stored in file filename.tph 
(filename is manufacturing model name). No - Tool 
path is computed each time manufacturing model is 
retrieved or parameters are changed. 

yes, no yes 

style_default_connection
s 

Without 
Category 

Yes - Add connections to a newly created Style 
surface. 

yes, no yes 

summary_help User Interface Refers to the one-line help Messages that are either 
displayed or not displayed. 

yes, no yes 

suppress_dlg_license_ex
pired 

User Interface Suppresses "License expired: List of options and 
expiration days" dialog 

- 7 

suppress_license_loss_di
alog 

User Interface Yes - Suppresses the 'Regained Floating License' 
dialog box. No - The 'Regained Floating License' 
dialog box will display. 

yes, no no 

switch_dims_for_notes Drawing Yes - Dimensions will be displayed in their symbolic 
format during drawing note creation. No - Dimensions 
will be displayed in drawing notes as numerical values. 

yes, no yes 
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sym_leader_orient_move
_text 

Drawing With Pro/DETAIL, automatically regroups weld 
symbol instances after you move the text. 

yes, no no 

symbol_instance_palette
_file 

Drawing Specifies the location of the symbol instance palette. - - 

symbol_palette_input Drawing Controls the display of the special symbol palette 
during note creation. 

yes, no yes 

system_background_col
or 

Colors Defines default graphics area background color. The 
three decimal values specify (in order) percentage of 
red, green and blue in the resulting color. For example, 
0 0 49 specifies a medium blue. Change in session 
using View>Display Settings>System Colors. 

- 0 

system_colors_file Colors Specifies the system color file. Use the full path name 
to avoid problems. 

- - 

system_curves_color Colors Defines default curve color. The three decimal values 
specify (in order) percentage of red, green and blue in 
the resulting color. For example, 0 0 49 specifies a 
medium blue. Change in session using View>Display 
Settings>System Colors. 

- 0 

system_dimmed_menu_
color 

Colors Defines default secondary highlight color. The three 
decimal values specify (in order) percentage of red, 
green and blue in the resulting color. For example, 0 0 
49 specifies a medium blue. Change in session using 
View>Display Settings>System Colors. 

- 0 

system_edge_high_color Colors Defines default edge highlight color. The three decimal 
values specify (in order) percentage of red, green and 
blue in the resulting color. For example, 0 0 49 
specifies a medium blue. Change in session using 
View>Display Settings>System Colors. 

- 0 
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system_geometry_color Colors Defines default color of solid wireframe entities. The 

three decimal values specify (in order) percentage of 
red, green and blue in the resulting color. For example, 
0 0 49 specifies a medium blue. Change in session 
using View>Display Settings>System Colors. 

- 0 

system_hidden_color Colors Defines default color of hidden, wireframe entities. 
The three decimal values specify (in order) percentage 
of red, green and blue in the resulting color. For 
example, 0 0 49 specifies a medium blue. Change in 
session using View>Display Settings>System Colors. 

- 0 

system_highlight_color Colors Defines default primary highlight color. The three 
decimal values specify (in order) percentage of red, 
green and blue in the resulting color. For example, 0 0 
49 specifies a medium blue. Change in session using 
View>Display Settings>System Colors. 

- 0 

system_iges_header_file Data Exchange Inserts specified text file into the Start section of IGES 
files (refer to user_iges_header_file). When used with 
user_iges_header_file, the system text appears first. 

- - 

system_letter_color Colors Defines default color of datum tags. The three decimal 
values specify (in order) percentage of red, green and 
blue in the resulting color. For example, 0 0 49 
specifies a medium blue. Change in session using 
View>Display Settings>System Colors. 

- 0 

system_section_color Colors Defines default section color. The three decimal values 
specify (in order) percentage of red, green and blue in 
the resulting color. For example, 0 0 49 specifies a 
medium blue. Change in session using View>Display 
Settings>System Colors. 

- 0 

system_sheetmetal_color Colors Defines default color of Sheetmetal parts. The three 
decimal values specify (in order) percentage of red, 
green and blue in the resulting color. For example, 0 0 
49 specifies a medium blue. Change in session using 
View>Display Settings>System Colors. 

- 0 
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Name Category Description Values Default Value 
system_volume_color Colors Defines default color of Manufacturing volumes. The 

three decimal values specify (in order) percentage of 
red, green and blue in the resulting color. For example, 
0 0 49 specifies a medium blue. Change in session 
using View>Display Settings>System Colors. 

- 0 

tablet_device_name System Specifies the name of a digitizing tablet. - - 
tan_angle_for_disp Model Display For display purposes only. Sets the angle between two 

quilt surfaces below which the edge will be displayed 
as tangent. Enter an angle between 1.5 and 15 degrees. 

- 0.02618 

tangent_edge_display Model Display Determines how edges between tangent surfaces are 
displayed. 

no, solid, centerline, phantom, 
dimmed 

solid 

tbl_driven_tol_val_edit Dimensions & 
Tolerances 

Tbl_driven_tol_val_edit Y/N* - "Yes" allows users to 
directly edit the tolerance value of dimensions whose 
tolerance values are driven by tolerance tables. Editing 
the tolerance value of a dimension will make the 
dimension non-table-driven. "No" disallows direct 
editing of the tolerance values of table driven 
tolerances. 

yes, no no 

template_designasm File Storage & 
Retrieval 

Specifies the designated template assembly. Use full 
path to avoid problems. 

- inlbs_asm_design
.asm 

template_drawing File Storage & 
Retrieval 

Specify the drawing used as the default drawing 
template. 

- c_drawing.drw 

template_ecadasm File Storage & 
Retrieval 

Specify the model used as the default ECAD assembly 
template. 

- - 

template_ecadpart File Storage & 
Retrieval 

Specify the model used as the default ECAD part 
template. 

- - 

template_mfgcast File Storage & 
Retrieval 

Specify the model used as the default manufacturing 
cast template. 

- inlbs_mfg_cast.m
fg 

template_mfgcmm File Storage & 
Retrieval 

Specify the model used as the default manufacturing 
cmm template. 

- inlbs_mfg_cmm.
mfg 

template_mfgemo File Storage & 
Retrieval 

Specify the model used as the default manufacturing 
expert machinist template. 

- inlbs_mfg_emo.m
fg 
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Name Category Description Values Default Value 
template_mfgmold File Storage & 

Retrieval 
Specify the model used as the default manufacturing 
mold template. 

- inlbs_mfg_mold.
mfg 

template_mfgnc File Storage & 
Retrieval 

Specify the model used as the default manufacturing 
assembly template. 

- inlbs_mfg_nc.mf
g 

template_mold_layout File Storage & 
Retrieval 

Specify the mold layout assembly used as a default 
template. 

- inlbs_mold_lay.as
m 

template_sheetmetalpart File Storage & 
Retrieval 

Specify the model used as the default sheetmetal part 
template. 

- inlbs_part_sheet
metal.prt 

template_solidpart File Storage & 
Retrieval 

Specify the model used as the default part template. - inlbs_part_solid.p
rt 

terminal_command User Interface Specifies the full path to the terminal emulator 
command (the command that starts shell windows). 
Use the command for your system. Enter the complete 
path name and the terminal command. 

- - 

texture Model Display Yes - Applied textures will be displayed when the 
model is shaded. 

no, yes yes 

texture_search_path Model Display Appends a directory to the search path for textures. - - 

thermo_position_hint User Interface Enables you to position the thermometer-type scales 
whenever they appear, so that they do not overlap the 
Pro/ENGINEER windows (if space permits, for 
example, if windows have been scaled). 

no_window_overlap, 
window_overlap 

window_overlap

tiff_compression Data Exchange Determines whether or not to-tiff exports are 
compressed using G4 compression 

none, g4 none 

tiff_type Data Exchange Determines the type of tiff items are exported to 
variables refer to color sets 

rgb, palette, grayscale, mono rgb 
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todays_date_note_format Drawing Controls the initial format of the date displayed in a 

drawing. The format for the setting is a string 
consisting of three portions: the year, the month, and 
the date. You can enter the portions in any order. 

- %dd-%mmm-
%yy 

tol_display Dimensions & 
Tolerances 

Displays dimensions with or without tolerances. yes, no no 

tol_mode Dimensions & 
Tolerances 

Nominal - Displays dimensions without tolerances. 
Limits - Displays upper and lower limits. Plusminus - 
Displays as nominal with plus-minus tolerances. 
Plusminussym - Displays as nominal with single value 
for positive and negative tolerance. 

nominal, limits, plusminus, 
plusminussym 

limits 

tolerance_class Dimensions & 
Tolerances 

Sets the default tolerance class for ISO-standard 
models. The system uses the tolerance class in 
conjunction with the dimension value when retrieving 
tolerances for General or Broken Edge dimensions. 

fine, medium, coarse, 
very_coarse 

- 

tolerance_standard Dimensions & 
Tolerances 

Sets the tolerance standard used when creating the 
model. 

ansi, iso ansi 

tolerance_table_dir Dimensions & 
Tolerances 

Sets the default directory for user-defined tolerance 
tables for ISO-standard models. All Holes and Shafts 
tables overwrite existing tables when loaded. 

- - 

toolkit_registry_file Application 
Programming 
Interfaces 

Tells Pro/E the full path to which toolkit registry file to 
be used. This option replaces the R17 option 
prodevdat. 

- - 

topobus_enable Data Exchange Enables usage of the Associative Topology Bus for 
exchanging data. 

yes, no no 

tracesketch Without 
Category 

Display tracesketches outside of Style feature no, yes yes 

trail_delay System Sets a delay in seconds between trail file steps. - 0 

trail_dir System Instructs Pro/ENGINEER to create its trail file in the 
specified directory rather than in the startup directory. 

- - 
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train_file_path System Specifies the default directory for training files. The 

path name must start from the root of the directory, for 
example, /home/users/library/training. 

- - 

transparency Model Display Yes - Transparent colors will appear as such when the 
model is shaded. 

no, yes yes 

triangulate_filled_areas Drawing Subdivide filled areas into triangles (may affect 
memory usage and plot files). 

yes, no no 

ui_theme Without 
Category 

Setup Pro/E Theme. Standard will result in the 
Wildfire Theme on UNIX and "following the Windows 
theme on Windows XP & Win2K. Wildfire - Will 
always use the Wildfire Theme regardless of the OS 
settings. 

wildfire, standard standard 

unattached_geometry_lo
g_path 

Without 
Category 

Sets a path to log files with checked objects listing and 
ghost features details. 

- - 

units_system_dic_file Piping Specifies the file containing the mapping for MCAT 
filename and units. 

- $PTCSRC/text/pi
ping_data/master
_catalog/piping_u
nits_system_dic_f

ile.ptd 
update_harness_mfg_lin
e_color 

Electromechani
cal 

Update cable line color for harness-mfg part created in 
release 2000i or earlier. 

yes, no no 

update_pre_130_harness Electromechani
cal 

Yes - When a cable is added between two previously 
laid out locations in a three-dimensional reference 
harness, display of the new cable will update 
automatically in pre-Release 13 flattened cable models. 

yes, no no 

update_pre_16_cable_la
yers 

Electromechani
cal 

Yes - Harnesses containing cables routed prior to 
Release 16.0 will be automatically updated upon 
retrieval to comply with new display standards. 

yes, no no 
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Name Category Description Values Default Value 
update_rep_refs Assembly "Yes" updates top assembly simplified reps for 

replacements during regeneration and upon 
replacement. 

yes, no yes 

use_8_plotter_pens Printing & 
Plotting 

Specifies whether to support up to 8 plotter pens. The 
initial default is 4 pens. 

no, yes no 

use_cadam_plot_data Data Exchange Determines whether the information in the Plot Axis 
System element should be taken into account when 
importing a CADAM drawing. 

yes, no no 

use_export_2d_dialog Data Exchange Yes - Opens export options dialog when exporting 
Pro/E drawing. No - exports file without the options 
dialog. 

yes, no yes 

use_iges_font_1003 Data Exchange Used to disable the use of IGES font 1003. yes, no yes 

use_iges_kanji_font_200
1 

Data Exchange Specifies whether to convert Kanji notes in 
Pro/ENGINEER to IGES Kanji notes (font code) when 
exporting. Yes - Converts Kanji notes to IGES Kanji 
notes. No - Converts using Font 1. 

yes, no no 

use_major_units Dimensions & 
Tolerances 

Determines if fractional dimensions are displayed in 
terms of feet-inches or meter-mm. Yes - The major 
units are used. For example, when the units are inches 
and 25.125 is converted to a fraction, the dimension 
becomes 2' 1-1/8". 

yes, no no 

use_master_for_bad_dis
p_reps 

Without 
Category 

Yes to retrieve master rep when graphics rep has no 
display data. 

yes, no no 

use_new_intchg Assembly "yes"-Pro/ENGINEER uses the consolidated 
interchange assembly functionality. "no"-
Pro/ENGINEER uses the separate functional 
interchange assemblies and simplify interchange 
assemblies. 

yes, no yes 
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Name Category Description Values Default Value 
use_nom_dim_val_in_ex
pr 

Dimensions & 
Tolerances 

Yes - use dimensions' nominal values in expressions. 
No - use current values. 

yes, no no 

use_part_color_for_hidd
en_lines 

Colors Determines how to color the hidden lines of parts that 
have user defined colors. "YES" - Use the dimmed part 
color for hidden lines. SYSTEM_HIDDEN_COLOR is 
ignored if it has been specified. 

no, yes no 

use_pre_wildfire_text_fo
nt 

Model Display Yes - Use the old stroke-based PTC font as the default 
font. No - Use a True Type font as the default font. 

no, yes no 

use_software_linefonts Printing & 
Plotting 

Yes - The exact line style used in Pro/ENGINEER is 
plotted, stroked out dot by dot, dash by dash, and space 
by space. No - plots lines using the line font it supports 
which most closely resembles the font used in 
Pro/ENGINEER. 

yes, no no 

use_temp_dir_for_inst File Storage & 
Retrieval 

Explicitly makes Pro/ENGINEER use the Temp 
directory for regenerating instances of models. 

no, yes no 

user_defined_grid_interv
al 

Features Modify grid space in user defined length units for 
handle movement. 

- 0.5 

user_iges_header_file Data Exchange Filename - Insert specified text file into the Start 
section of IGES file. Valid parametric note symbols 
will be replaced during export. For example, 
&dwg_name in the text file is replaced by the drawing 
name when a drawing is exported. 

- - 

variable_plots_in_inches Printing & 
Plotting 

No - Variable plot sizes may be entered in millimeters. yes, no yes 

variant_drawing_item_si
zes 

Drawing No - Drawing items moved/copied to a different sheet 
or located on a changed sheet keep same size and 
relative orientation on paper. Yes - Some items 
scale/reposition to be the same on paper, and others 
scale and/or reposition to be the same on screen. 

yes, no no 
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vda_header Data Exchange The complete filename of the text file containing VDA 

header information. If you intend to use the same 
header for all VDA files, specify the full pathname. 

- - 

verify_on_save_by_defa
ult 

File Storage & 
Retrieval 

Yes - "Verify Now" action will be selected in the 
conflict dialog by default when an unverified family 
table instance is to be saved in PDM workspace. No - 
"Verify Now" action will not be selected by default. 
The user may explicitly specify the "Verify Now" 
action in the conflict dialog. 

yes, no no 

versatec_cutter_installed Printing & 
Plotting 

Yes - Indicates that a cutter is installed on a Versatec 
plotter. 

no, yes - 

visible_mapkeys User Interface No - Mapkeys will run without displaying picks being 
made in the Menu Manager menus. This does not 
affect the display of picks being made in menu bar 
menus or dialog boxes. 

no, yes no 

visible_message_lines User Interface Sets the default number of visible message lines in the 
Pro/ENGINEER message area. 

- 6 

vrml_anchor_url Data Exchange Enables you to place an anchor on a specified VRML 
component during the export to VRML. The keywords 
are optional. 

- - 

vrml_background_color Data Exchange Yes - Exports a model to VRML with the 
Pro/ENGINEER background color. 

yes, no no 

vrml_explode_lines Data Exchange Yes - Exports a model to VRML with explode lines for 
assembly or assembly process data. 

yes, no yes 

vrml_export_resolution Data Exchange Specifies the number of levels of detail (LODs) in 
models exported in VRML format. 

high, medium, low medium 

vrml_export_version Data Exchange   2.0, 1.0 2 
vrml_file_duplicate_mat
erial 

Data Exchange Yes - Ensures that the model components retain their 
true color. No - In some viewers, component colors 
might not be consistent. 

yes, no no 
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vrml_multiple_views Data Exchange All - Exports top-level and lower-level assembly 

component views into VRML format. None - Does not 
export component views into VRML format. Top - 
Exports top-level object view only into VRML format. 

none, all, top all 

vrml_parameters Data Exchange Controls the export of user parameters. Designated - 
Export only designated parameters. All - Export all 
parameters. None - Do not export parameters. 

designated, all, none designated 

vrml_simprep_export Data Exchange Yes - Specifies direct and in memory export of top-
level assembly simplified representation to Pro/FLY-
THROUGH package files. 

yes, no no 

web_browser_history_da
ys 

System Enter number of days to store history records. - 20 

web_browser_homepage System Enter location of Pro/E browser home page. - $PTCSRC/html/u
sascii/proe/helpsy
stop/resource_cen

ter_index.htm 
web_disable_js_comman
d 

Application 
Programming 
Interfaces 

Enter a specific javascript command to be disabled - - 

web_enable_javascript Without 
Category 

Enables or disables Pro/Web.Link in the embedded 
browser. 

on, off off 

web_enable_subscription Application 
Programming 
Interfaces 

Enable the subscription mechanism for Connections no, yes yes 

web_link_file_read Application 
Programming 
Interfaces 

Sets Pro/Web.Link permission to read data from the 
local file system. 

yes, no no 

web_link_file_write Application 
Programming 
Interfaces 

Sets Pro/Web.Link permission to write data to the local 
file system. 

yes, no no 

web_link_proe_read Application 
Programming 
Interfaces 

Sets Pro/Web.Link permission to read data from a 
Pro/ENGINEER session. 

yes, no no 



Parametric Technology Corporation 98 Pro/ENGINEER Wildfire 2.0 Configuration Options 

Name Category Description Values Default Value 
web_link_proe_write Application 

Programming 
Interfaces 

Sets Pro/Web.Link permission to modify data in a 
Pro/Engineer session. 

yes, no no 

web_link_security_autop
rompt 

Application 
Programming 
Interfaces 

Yes - The Security dialog box is displayed when a 
Pro/Web.Link function requires security access beyond 
the current settings. 

yes, no yes 

web_max_mail_size Without 
Category 

Set the maximum email attachment size in kilobytes. - 5000 

weld_ask_xsec_refs Weld No - Do not ask for X-section references when creating 
weld features. Yes - Ask for X-section references when 
creating weld features. 

no, yes no 

weld_color Weld Defines default weld color. The three decimal values 
specify (in order) percentage of red, green and blue in 
the resulting color. For example, 0 0 49 specifies a 
medium blue. Change in session using 
Tools>Colors>System. 

- 0 

weld_dec_places Weld Sets the default number of decimal places (0-10) to 
display in weld parameters. 

- 3 

weld_edge_prep_driven_
by 

Weld Determines if the edge preparation feature is created in 
the part or the assembly level. 

part, assembly part 

weld_edge_prep_groove
_angle 

Weld Specifies an initial default value for the angle cut edge 
preparation. 

- 45 

weld_edge_prep_groove
_depth 

Weld Specifies an initial default value for the edge 
preparation depth. 

- 0.25 

weld_edge_prep_instanc
e 

Weld Controls whether a family table instance is created for 
edge preparation. Yes - Instances of the components 
that receive edge preparation are created. 

yes, no - 

weld_edge_prep_name_s
uffix 

Weld Specifies the suffix name for the instance that will be 
created during edge preparation. Part name plus 
extension makes the instance name. 

- _noep 
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weld_edge_prep_root_o
pen 

Weld Specifies an initial default value for the root opening 
edge preparation. 

- 0.25 

weld_edge_prep_visibilit
y 

Weld Applies only if weld_edge_prep is set to Yes. Generic - 
Edge preparation features are resumed in the generic 
and suppressed in the instance. Instance - Edge 
preparation features are suppressed in the generic and 
resumed in the instance. 

generic, instance - 

weld_notch_corner_radi
us 

Weld Specifies an initial default value for the radius at weld 
notch corner. 

- 0.1 

weld_notch_height Weld Specifies an initial default value for the weld notch 
height. 

- 0.4 

weld_notch_radius Weld Specifies an initial default value for the weld notch 
radius. 

- 0.5 

weld_notch_width Weld Specifies an initial default value for the weld notch 
width. 

- 0.5 

weld_ui_standard Weld Specifies standard for welding user interface. ANSI - 
Use ANSI standards. ISO - Use ISO standards. 

iso, ansi ansi 

windows_scale User Interface Scales Pro/ENGINEER windows with a given 
coefficient. A value of 0.85 is usually adequate to 
allow dynamic menus to display to the right of the 
Pro/ENGINEER window. 

- 1 

www_add_aux_frame Data Exchange Creates additional frame for each process step or for 
assembly publication. Yes - Auxiliary files aux.html 
are created for each step in assembly process (in each 
step00 directory) to be replaced by your .html file. No - 
Auxiliary files are not created. 

no, yes no 

www_export_geometry_
as 

Data Exchange Specifies the output format by to one of the values vrml, cgm, jpg, cgm_vrml, 
jpg_vrml, cgm_jpg, all 

jpg_vrml 
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www_multiple_views Data Exchange All - Writes all views in any component to the 

appropriate VRML files. Top - Writes only named 
views that reside in the assembly or process assembly 
to top-level VRML files. None - Does not write named 
views to VRML files. 

none, all, top top 

www_tree_location Data Exchange Specifies the location of the model tree in the browser 
window. Out - Opens model tree in a separate window. 
In - Includes model tree in the Web page and removes 
the Tree checkbox from the control panel. 

out, in out 

x_angle Model Display Sets the default view orientation for models (appears in 
the Orientation dialog box). The default orientation is 
the last option, x_angle, y_angle, or orientation, in the 
configuration file. 

- 0 

y_angle Model Display Sets the default view orientation for models (appears in 
the Orientation dialog box). The default orientation is 
the last option, x_angle, y_angle, or orientation, in the 
configuration file. 

- 0 
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Configuration Option Changes Between Pro/ENGINEER 2001 and Pro/ENGINEER Wildfire 2.0 
Name Status Category Description Values Default Value

acis_out_version Changed Without Category Allows the user to choose ACIS export 
version. 

public 4, public 5, internal 6, internal 7 5 

activate_sketch_wit
h_dflt 

New Features Activate sketcher automatically using 
system defaults. 

yes, no no 

add_lower_level_co
mps_to_layer 

New Layers Setting this option to yes will check off the 
Favor Current Layer option, which allows 
lower level components to be added to top 
level layers. 

yes, no no 

adobe_distiller New Printing & 
Plotting 

Sets the Adobe Distiller command path. 
Required for PDF and COLOR PDF 
creation. 

- - 

advanced_intersecti
on 

New Assembly Control the appearance of the intersection 
tool and scope of available functionalities. 

yes, no no 

aec_parameter_file New Without Category Specifies the file name of the user defined 
piping parameter codes. 

- - 

af_copy_references_
flag 

New User Interface Toggle display of Copy References column 
in Annotation Feature definition dialog 

no, yes no 

align_cable_bundles New Electromechanica
l 

Align NEWLY CREATED bundles where 
they meet or branch out 

yes, no yes 

allow_move_view_
with_move 

Changed Drawing Disallow the movement of drawing views 
with the mouse. 

yes, no no 

allow_multiple_tool
_tips 

New Manufacturing Allows to use for machining cutting tool 
with multiple tips. 

yes, no no 

allow_ref_scope_ch
ange 

Changed Reference control No - Displays the message "Reference 
scope changes are prohibited by the 
configuration file settings" when the Ref 
Scope user interface is changed. 

yes, no yes 

allow_shrink_dim_b
efore 

New Casting & Mold 
Design 

Allow calculation before relations. yes, no no 
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Name Status Category Description Values Default Value
allow_solid_perspec
tive_hlr 

New Model Display Yes - Allows a solid to be displayed with 
hidden lines while in perspective. 

no, yes no 

allow_workpiece_sil
houette 

New Without Category Determines if the workpiece is allowed for 
Silhouette Mach Window creation. NO - 
only reference part is allowed; YES - both 
workpiece and reference part are allowed; 
AUTO - only workpiece is allowed. 

yes, no, auto no 

angle_grid_interval New Features Modify grid space in angular units for 
handle movement. 

- 1 

ask_designate_owne
rs 

New Without Category Show the both required and optional 
owners to be designated. 

yes, no yes 

atb_auto_check_on_
activate 

New Data Exchange Sets state of ATB 'Auto Check Status On 
Activate' toggle. 

on, off off 

atb_auto_check_on_
retrieve 

New Data Exchange Sets state of ATB 'Auto Check Status On 
Retrieve' toggle. 

on, off on 

atb_auto_check_on_
update 

New Data Exchange Sets state of ATB 'Auto Check Status On 
Update' toggle. 

on, off off 

atb_prod_asm_upd_
by_comp_ids 

New Data Exchange Allows to update a Pro/DESKTOP 
assembly based on assembly component 
ids, if set to YES. Otherwise, the update 
will be based on component names. 

yes, no yes 

atb_search_path New Without Category Extends search path for ATB Update and 
ATB Check Status commands. 

- - 

atb_show_log New Data Exchange Sets state of ATB 'Show Log' toggle. on, off on 
auto_ae_param_file New User Interface Define path and file name of external file 

used to define parameters that are 
automatically created in all Annotation 
Elements. 

- - 
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Name Status Category Description Values Default Value
auto_constr_always
_use_offset 

Changed Assembly Control whether auto constraint should 
create offsets. Yes - Auto constraint alw 
ays creates offsets. No - Auto constraint 
snaps align or mate if surfaces are wi thin 
tolerance. Never - Auto constraint never 
create offsets. 

yes, no, never no 

auto_regen_views Changed Drawing Yes - Automatically repaints the drawing 
display when changing from one window to 
another. No - Update to drawing views will 
only occur when manual updates are made 
via Repaint or View> Update. 

yes, no yes 

auto_traceback New System When set to yes, traceback.log file will be 
generated when fatal error occurs. 

yes, no yes 

auto_xml_on_retrie
ve 

Changed Electromechanica
l 

Automatically load Cabling Logical 
Reference from an XML file when 
retrieving the cabling assembly 

yes, no no 

auto_xml_on_save Changed Electromechanica
l 

Automatically create an XML Logical 
Reference when saving a cabling assembly 

yes, no no 

autobuildz_enabled New Drawing Loads AutobuildZ application. yes, no no 
autoplace_single_co
mp 

New Assembly Assembling components with an interface 
will automatically place the component at 
the first position satisfying the interface 
definitions. 

no, yes yes 

auxapp_popup_men
u_info 

New User Interface Enable display of popup menu info in the 
trail file. 

yes, no no 

bell Changed Environment Yes - Turns on the keyboard bell that rings 
after each prompt. No - Turns off the 
keyboard bell. To override this setting use 
the Environment dialog box on the Tools 
menu. 

yes, no no 
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blended_transparenc
y 

New Model Display Yes - Transparent colors will appear using 
alpha blending (if supported) when the 
model is shaded. 

no, yes yes 

bm_graph_tool Changed User Interface BMX graph tool public default, public excel_linked, 
public excel_embedded, internal 
generic_graphtool 

default 

bmgr_pref_file New User Interface Specifies the location of the Graph Tool 
preference file. 

- - 

bmx_param_restricti
ons 

New Without Category   yes, no yes 

bump_revnum_on_r
etr_regen 

New Assembly Determines whether or not revision number 
is increased for generic models that 
regenerate and change during assembly 
retrieval. Only applies if 
new_asm_regen_revnums is yes 
(otherwise, there will be no revision 
number bumping). 

yes, no yes 

can_snap_to_missin
g_ref 

Changed Assembly Controls whether to enable snapping to 
missing references while dragging 
components for placement. Yes - Snapping 
is enabled while dragging. No - Snapping is 
disabled while dragging. 

yes, no yes 

capped_clip Changed Model Display Yes - Displays the model as a solid when 
shaded and clipped. No - Displays the 
model as surfaces when shaded and 
clipped. 

no, yes yes 

centimeter_grid_inte
rval 

New Features Modify grid space in centimeter units for 
handle movement. 

- 0.1 

cgm_use_reversed_i
eee_floats 

Changed Data Exchange Yes - Enables a metafile to be viewed in 
Advanced Technology Center's ForReview. 

yes, no yes 

check_ghost_feature
s 

New Without Category Skip features that are already marked non-
ghost. 

skipchecked, never, always skipchecked 
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color_windows Changed Colors All_windows - Wireframe colors display in 

the main window and all auxiliary 
windows. One_window - Colors display 
only in the main window. Auxiliary 
windows display wireframe in the default 
color. 

all_windows, one_window all_windows 

comp_angle_offset_
eps 

New Assembly Specifies the angle epsilon such that if the 
desired surfaces are equal or greater than 
the epsilon (in degrees), than an angle 
offset constraint will be created. 

- 10 

compress_output_fil
es 

Changed File Storage & 
Retrieval 

You can compress object files to store 
them. Compressed files are slower to read 
and write, one-half to one-third the size, 
and fully compatible across systems. Yes - 
Stores object files in compressed format. 
No - Object files are not compressed. 

yes, no no 

conf_mouse_anim New Miscellaneous Display the presenter's mouse motions 
when observing a shared Pro/ENGINEER 
session. 

no, yes yes 

copy_dxf_dim_pict Changed Data Exchange YES - Imports each component of 
AutoCAD dimension separately. NO - 
Imports AutoCAD dimensions as 
dimensions in Pro/ENGINEER. 
AS_SYMBOL - Imports AutoCAD 
dimensions as symbols in Pro/ENGINEER. 

yes, no, as_symbol no 

create_temp_interfa
ces 

New Assembly Allow the automatic creation of interfaces 
based on previous assembly instructions. 

yes, no no 

def_layer Changed Layers Specifies default layer names for different 
types of items. The first value string is the 
layer type. The second value string is the 
layer name. 

layer_assem_member, 
layer_assy_cut_feat, layer_axis, 
layer_chamfer_feat, 
layer_comp_design_model, 
layer_comp_fixture, 
layer_comp_workpiece, 
layer_copy_geom_feat, 
layer_corn_chamf_feat, 

- 
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layer_cosm_round_feat, 
layer_cosm_sketch, layer_csys, 
layer_curve, layer_curve_ent, 
layer_cut_feat, layer_datum, 
layer_datum_plane, 
layer_datum_point, layer_detail_item, 
layer_dgm_conn_comp, 
layer_dgm_highway, layer_dgm_rail, 
layer_dgm_wire, layer_dim, 
layer_draft_constr, layer_draft_dim, 
layer_draft_dtm, layer_draft_entity, 
layer_draft_feat, layer_draft_geom, 
layer_draft_grp, layer_draft_hidden, 
layer_draft_others, layer_draft_refdim, 
layer_driven_dim, layer_dwg_table, 
layer_ext_copy_geom_feat, 
layer_feature, layer_geom_feat, 
layer_gtol, layer_hole_feat, 
layer_intchg_funct, 
layer_intchg_simp, 
layer_nogeom_feat, 
layer_nongraph_annot_elem, 
layer_note, layer_parameter_dim, 
layer_part_refdim, layer_point, 
layer_protrusion_feat, layer_quilt, 
layer_refdim, layer_ribbon_feat, 
layer_rib_feat, layer_round_feat, 
layer_sfin, layer_shell_feat, 
layer_skeleton_model, layer_slot_feat, 
layer_snap_line, layer_solid_geom, 
layer_surface, layer_symbol, 
layer_thread_feat, 
layer_trim_line_feat, layer_weld_feat 

default_comp_geom
_scope 

New Reference control Set thespecified Shared Geometry reference 
control conditions to newly added 
components. 

all, pg, none all 
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default_comp_invali
d_refs 

New Reference control Set the specified handling method of out-
of-scope Accessible references to newly 
added components. 

copy, prohibit copy 

default_comp_scope
_setting 

New Reference control Set the specified Accessible reference 
control conditions to newly added 
components. 

all, none, subassemblies, 
skeleton_model 

all 

default_comp_skel_
geom_scope 

New Reference control Set the specified Shared Geometry 
reference control conditions to newly added 
Skeleton components. 

all, pg, none all 

default_comp_skel_
scope_setting 

New Reference control Set the specified Accessible reference 
control conditions to newly added Skeleton 
components. 

all, none, subassemblies, 
skeleton_model 

all 

default_ext_ref_sco
pe 

Changed Without Category Set default scope for externally referenced 
models. All - Any model. None - Only 
current model and children. Skeletons - 
Any component in model's assembly and 
higher skeletons on branch. Subassembly - 
Only components and children in model's 
assembly. 

all, none, subassemblies, 
skeleton_model 

all 

default_geom_scope Changed Reference control Default value for Geometry Scope allowed 
for referencing. 

all, pg_if_exists, pg_only all 

default_layer_model New Layers Name of the model which is used to drive 
rule-based layer placement of new items in 
all models of the same type in session. 

- - 

default_obj_constrai
nts_scope 

New Reference control Set the specified Shared Placement 
reference control conditions to newly 
created models if template models were not 
used. 

all, interfaces, none all 

default_object_geo
m_scope 

New Reference control Set the specified Shared Geometry 
reference control conditions to newly 
created models if template models were not 
used. 

all, pg, none all 
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Name Status Category Description Values Default Value
default_object_inval
id_refs 

Changed Reference control Sets default condition for reference 
handling. Prohibit - System will abort all 
attempts to create ext. reference that 
violates scope. Copy - System will issue 
warning upon all attempts to create ext. 
reference that violates scope. 

copy, prohibit copy 

default_object_scop
e_setting 

Changed Reference control Set default condition for reference control. 
All - Any model. None - Only current 
model and children. Skeletons - Any 
component in model's assembly ang higher 
skeletons on branch. Subassembly - Only 
components and children in model's 
assembly. 

all, none, subassemblies, 
skeleton_model 

all 

default_placement_s
cope 

Changed Reference control Default value for Component Placement 
Reference filter. 

all, intrf_if_exists, intrf_only all 

default_shrink_form
ula 

New Casting & Mold 
Design 

Default option of shrinkage formula: 1/(1-
S) - ASME standard or 1+S (simple). 

asme, simple simple 

dim_offscreen_limit Changed Dimensions & 
Tolerances 

If more than zero, sets the margin beyond 
which dimensions are automatically 
snapped back onto the screen. For example, 
a value of .2 lets a dimension be 20% of the 
window size outside the window. If set to 
zero, disables snapping of offscreen 
dimensions. 

- 0.2 

disp_in_open_rep_c
reate 

New Without Category Simplified Rep to display initially in Open 
Rep Create: "No" for none, "Yes" for 
graphics rep, or "Default Rep" to display 
the rep indicated by option 
"open_simplified_rep_by_default". 

yes, default rep, no no 

display_dwg_sketch
_constraint 

New Drawing When set to yes, parametric sketching 
constraints, such as V for vertical, are 
displayed when a drawing object is selected 

yes, no no 

display_florin New Model Display Yes: display of the florin (international 
currency symbol) where possible. No: use 
the euro symbol exclusively. 

no, yes no 
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Name Status Category Description Values Default Value
display_in_adding_
view 

Changed Drawing Controls model display in a drawing when 
auto_regen_views is No. Wireframe - Adds 
new views in wireframe, displays datums. 
Minimal_wireframe - Displays in 
wireframe, no datums, axes, or silhouette 
edges. Default - Displays using the 
Environment setting. 

wireframe, minimal_wireframe, 
default 

wireframe 

display_tol_by_100
0 

New Dimensions & 
Tolerances 

If set to Yes, tolerances for non-angular 
dimensions will be displayed multiplied by 
1000. 

yes, no no 

dm_auto_open_zip New Data 
Management 

YES - Windchill CAD packages or zip files 
will open automatically. NO - User selects 
which file in contents to open. 

yes, no yes 

dm_cache_mode New Data 
Management 

Indicate which objects will be written to 
local cache when objects in Pro/E memory 
are saved. 

none, modified, all all 

dm_cache_size New Data 
Management 

Enter amount of disk space (in megabytes) 
to allocate for local file storage. 

- 400 

dm_http_compressi
on_level 

New Data 
Management 

Set the data compression factor (0-9, 0= no 
compression) for data exchange with a 
Windchill server. 

- 0 

dm_overwrite_conte
nts_on_update 

New Data 
Management 

Yes: Windchill Workspace Update will 
overwrite locally/modified out of date 
objects with the ones in the server. No 
(Default): Windchill Workspace Update 
will update metadata only. 

yes, no no 

dm_remember_serv
er 

New Data 
Management 

Primary server/workspace must be set by 
user for each Pro/E session. 

no, yes yes 

dm_secondary_uplo
ad 

New Data 
Management 

Indicate when modified Pro/E objects on a 
secondary server will be moved from the 
local cache to the user's workspace on the 
server. 

automatic, explicit automatic 
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dm_upload_objects New Data 

Management 
Indicate when modified Pro/E objects will 
be moved from the local cache to the user 
workspace on the server. 

automatic, explicit explicit 

draw_models_read_
only 

Changed Drawing Yes - Drawing model files are read-only. 
Driven dimensions, gtols, and similar items 
cannot be added to the model. 
Cosmetic_only - Driven dimensions, gtols, 
cross sections, and explode states can be 
added to the model, design changes are not 
allowed. 

yes, no, cosmetic_only no 

drawing_view_origi
n_csys 

Changed Drawing The named coordinate system will be used 
as the origin of a newly created view or of a 
modified view. None - The system will not 
use a previously specified coordinate 
system. 

none - 

dwg_export_format Changed Data Exchange Provides the ability to choose DWG file 
version when exporting from Pro/E 
drawing. 

12, 13, 14, 2000 2000 

dxf_block_to_pro_s
ymbol 

New Data Exchange Specifies whether or not DXF BLOCKS to 
be imported as Pro/E symbols. Yes - 
Imports BLOCKS as symbol definitions, 
No - Imports BLOCKS as separate entities. 

yes, no no 

dxf_export_format Changed Data Exchange Provides the ability to choose DXF file 
version when exporting from Pro/E 
drawing. 

12, 13, 14, 2000 2000 

dxf_in_faceted_brep New Data Exchange Default, faceted boundary representation is 
allowed in import. 

yes, no yes 

dxf_out_comments Changed Data Exchange YES - comments (999 group codes) will be 
created in DXF file exported from 
Pro/ENGINEER. NO - DXF file will be 
created without comment lines. 

yes, no yes 

ecad_export_cuts_as
_holes 

New Data Exchange Exports Pro/ENGINEER cuts as holes to 
ECAD systems. 

yes, no yes 



Parametric Technology Corporation 111 Configuration Option Changes Between  
   Pro/ENGINEER 2001 and Pro/ENGINEER Wildfire 2.0 

Name Status Category Description Values Default Value
ecad_missing_comp
onent_status 

New Data Exchange Setup default status for missing 
components in "Investigate Placement" 
Dialog. 

keep_missing, delete_missing keep_missing

ecad_other_outl_csy
s_def_name 

Changed Data Exchange Specifies the default coordinate system 
name for the .OTHER_OUTLINE section 
of an IDF 2.0 ECAD component being 
imported. If you do not set this variable, the 
system uses ECAD DEFAULT as 
coordinate system name. 

- - 

ecad_pin_hole_imp
ort 

New Data Exchange Setup the default for the import of ECAD 
Holes from type PIN (IDF 3.0 ONLY) 

yes, no no 

ecad_via_hole_impo
rt 

New Data Exchange Setup the default for the import of ECAD 
Holes from type VIA (IDF 3.0 ONLY) 

yes, no yes 

enable_face_presele
ction 

New Without Category   yes, no yes 

enable_implied_join
ts 

New Assembly Allow underconstrained components as 
mechanism connections. 

yes, no yes 

enable_k01_msr_anl
s 

New Without Category Enable or disable new UI for Measure 
Analysis. 

yes, no no 

enable_offset_fan_c
urve 

New Without Category Enables fan curve option for offset tool. yes, no no 

enable_protk_xml_s
chema 

New Application 
Programming 
Interfaces 

Enables XML-Schema validation for 
Pro/TK feature XMLs 

yes, no no 

enable_tree_indep New System Setup whether tree customization will 
allow separating the tree window from 
Pro/E window. 

yes, no no 

expand_all_with_ne
sted_layers 

New Without Category Yes - expand all including nested sub 
layers. 

yes, no yes 

fan_significant_loca
tions_only 

New Electromechanica
l 

Setup whether only significant locations 
should be flattened on flattening a harness. 

no, yes yes 
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fan_with_network New Electromechanica

l 
Setup whether the network should be 
included on flattening a harness. 

yes, no yes 

fast_highlight New Model Display Yes - Use simplified highlighting which 
redisplays more quickly at the expense of 
certain details. This option may increase 
memory usage slightly. 

no, yes no 

fem_allow_named_
mesh_files 

New FEM Yes - The user will be prompted to select a 
file to retrieve the mesh from, or enter a file 
name to save the mesh to. No - The user 
will not be prompted to select or enter a 
mesh file name. 

yes, no no 

fem_default_solver Changed FEM Specifies default solver. ansys, nastran - 
fem_mesh_preserve Changed FEM Yes - The finite element mesh will be 

automatically stored in the mesh file upon 
creation, and retrieved on entering the 
Structure/Thermal. No - The mesh will not 
be stored or retrieved automatically. 

yes, no no 

fem_solid_shell_aut
o_constraint 

Changed FEM Yes - SPCs for the rotational DOF will 
automatically be created at the interfacing 
nodes between solids and shells. That is 
shell rotations will be fixed. No - No such 
constraints will automatically be created. 
Ask - Prompt the user before running. 

yes, no, ask no 

file_open_default_f
older 

Changed File Storage & 
Retrieval 

Sets default dir for File>Open. 
Working_directory - Search working 
directory. In_session - Search objects in 
session. Pro_library - Use only if 
Pro/LIBRARY is installed. Workspace - 
Use only with Pro/INTRALINK. 
Commonspace - Use only with 
Pro/INTRALINK. 

default, working_directory, in_session, 
pro_library, my_documents 

- 
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folder_display_file_
limit 

New File Storage & 
Retrieval 

Sets the default number of files that will be 
displayed when viewing the contents of a 
folder using the Folder Navigator. 

- -1 

foot_grid_interval New Features Modify grid space in foot units for handle 
movement. 

- 0.083333 

force_upd_assem_m
p_in_simp_rep 

New Assembly Update mass properties parameters even 
when some of the components of the 
assembly are not in master rep. 

yes, no no 

general_undo_stack
_limit 

New System Setup the default number of entries in the 
top level Undo/Redo (default = 50). 

- 50 

highlight_layer_ite
ms 

New Layers Specifies whether items selected in the 
layer tree should be highlighted in the 
graphics area. 

yes, no yes 

hole_diameter_overr
ide 

Changed Features No- Uses hole-table-driven standard hole 
diameter value. Yes - Allows specifying the 
drilled hole value instead of the standard 
value. 

yes, no no 

hole_parameter_file
_path 

Changed Features Specifies the directory path for a standard 
screw-size parameters (.hol) file to be 
loaded from disk. Use the full path name to 
avoid problems. 

- - 

iges_out_assembly_
default_mode 

Changed Data Exchange Set default for assembly export via IGES. 
Flat - Single level model. One_level - Assy 
structure with pointers to components. 
All_levels - Assy structure with all comps 
to IGES files. All_parts - Assy to IGES 
files with geom info of comps and assy 
feats. 

public flat, internal one level, internal 
all levels, public one_level, public 
all_levels, internal all parts, public 
all_parts 

flat 
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ignore_all_ref_scop
e_settings 

Changed Reference control Controls whether object-specific reference 
scope settings are ignored or not. 
Environment scope settings will still be 
enforced. See also allow_ref_scope_change 
and default_ext_ref_scope 

yes, no no 

ignore_export_geom
_declaration 

Changed Reference control Ignore Export Geometry settings. yes, no no 

inch_grid_interval New Features Modify grid space in inch units for handle 
movement. 

- 0.125 

info_output_format New Environment Setup the default format type for 
information presentation. Text - 
information will be output as simple text. 
HTML - information will be output as html 
data. 

public text, public html, internal 
xml_text, internal dbg_text 

html 

instance_search_exh
austive 

Changed File Storage & 
Retrieval 

Specifies extent of instance search. Yes - 
Include file type when entering instance 
name in File>Open: type in input panel 
(e.g. inst_name.prt) or select in drop-down 
list. If no .idx files are found, only working 
dir is searched; each generic is not. 

no, yes no 

intf_cadds_version New Data Exchange Allows the user to switch between the 
default and alternate converter version for 
interface with CADDS5 

internal 10, internal 11, public 12, 
public 13 

- 

intf_in_dwg_view Changed Data Exchange Controls if associativity in an imported 
IGES view is preserved. 3D_VIEWS - tries 
to create 3D views if 3D model exists in the 
file. 2D_VIEWS - Imported IGES views 
work as 2D. No - Imported IGES views are 
exploded and become unrelated. 

no, 2d_views, 3d_views 2d_views 

intf_in_granite_dire
ct_enable 

New Data Exchange Allows the user to switch back to the old 
'Import Feature' method of reading Desktop 
.des files and Granite .g files into Pro/E. By 
default, Pro/E directly opens these models. 

yes, no yes 
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intf_in_use_templat
e_models 

New Data Exchange Allows the user to use template models in 
Pro/INTERFACE import. 

yes, no no 

intf_out_cat_start_m
odel 

New Data Exchange Specifies Catia start model to be used for 
CATIA II .model export. 

- - 

intf_out_max_bspl_
degree 

Changed Data Exchange Controls the maximum degree of exported 
B-spline surfaces when exporting through 
IGES 

- 16 

intf_use_variable_si
ze 

New Data Exchange Yes - IGES,DXF,STEP files with variable 
sized sheet information are imported 
andput on the appropriate variable-size 
format. Without a sheet size, the system 
tries to apply the correct variable-size 
format. No - The IGES,DXF,STEP drawing 
isplaced on a standard sized format. 

no, yes yes 

intf2d_iges_out_hat
ch 

New Data Exchange YES - Exports draft xhatching as IGES 
sectioned area entity. NO - exports draft 
xhatching as separate geometric entities. 

yes, no no 

intf2d_in_acad_igno
re_3d 

New Data Exchange YES - Ignore the 3DSOLID entities, if they 
exist, in the DXF/DWG file being imported 
in Drawing mode. Only, the 2D entities are 
processed. NO - Create an assembly by 
processing the 3DSOLID entities in the 
DWG/DXF file being imported in Drawing 
mode. This is the default value for this 
option. 

yes, no no 

intf2d_in_create_mu
ltiline_note 

New Data Exchange Create a single multi-line note on importing 
multi-line text when is set to YES. 

yes, no yes 

intf2d_out_acad_mt
ext 

New Data Exchange Create a single MTEXT entity for multi-
line text notes when is set to YES. 

yes, no yes 

intf2d_out_acad_tex
t_align 

New Data Exchange As_is - Exports notes to DXF/DWG with 
their original alignment values. Fit - 
Exports notes with FIT alignment. 

as_is, fit as_is 
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intf2d_out_cgm_ver New Data Exchange Provides the ability to choose CGM 

metafile version when exporting from 
Pro/E drawing. 

1, 3 1 

intf2d_out_open_lo
g_window 

New Data Exchange Yes - Opens Export Log File in special 
window. No - the Log File will not appear 
in the window. 

yes, no no 

intf2d_out_pnt_ent New Data Exchange Yes - Exports a drawing point to IGES, 
DXF or DWG as a point entity. No - 
Exports a drawing point as shape entities. 

yes, no no 

intf3d_ideas_import
_filter 

New Data Exchange Enables UI to selectively import I-DEAS 
part and assembly models from the I-DEAS 
.mf1 and .pkg container files. 

yes, no no 

intf3d_ideas_install
_dir 

New Data Exchange Specifies the path for I-DEAS installation. 
Use the full pathname to avoid problems. 

- - 

intf3d_ideas_run_co
mmand 

New Data Exchange Specifies the I-DEAS run command. 
Default command is "ideas". 

- ideas.cmd 

intf3d_out_cat2_ide
nt_crv 

Changed Data Exchange Specifies model parameter IDENT_CRV 
while exporting to Catia. 

- -1 

intf3d_out_cat2_ide
nt_pt 

Changed Data Exchange Specifies model parameter IDENT_PT 
while exporting to Catia. 

- -1 

intf3d_out_cat2_infi
nity 

Changed Data Exchange Specifies model parameter INFINITY 
while exporting to Catia. 

- -1 

intf3d_out_cat2_mo
del_sz 

Changed Data Exchange Specifies model parameter MODEL_SZ 
while exporting to Catia. 

- -1 

intf3d_out_cat2_sag Changed Data Exchange Specifies model parameter SAG while 
exporting to Catia. 

- -1 

intf3d_out_cat2_ste
p 

Changed Data Exchange Specifies model parameter STEP while 
exporting to Catia. 

- -1 

intf3d_parasolid_ex
port_schema 

New Without Category   - sch_10004 

intf3d_ug_install_di
r 

New Without Category Specifies the path for Unigraphics 
installation. Use the full pathname to avoid 
problems. 

- - 
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isogen_attribute_ma
p_file 

New Piping Specifies the mapping between isogen 
parameter and attribute name. 

- $PTCSRC/text/
piping_data/iso
data/isogen_attr
ibute_map.ptd

jlink_java_comman
d 

New Without Category Specifies a command to start JRE for J-
Link. May contain arguments and 
environment variables. Overrides the 
default, see also jlink_java2. 

- - 

jlink_java2 New Application 
Programming 
Interfaces 

Option to force use of Java-2 JRE 
command line ("java" instead of "jre") 

off, on on 

log_dwg_spr115016
6_detection 

New Without Category Create a log file and include if a particular 
drawing needs correction for SPR 
#1150166. 

no, yes no 

mapkey Changed Miscellaneous Stores a keyboard macro. Use 
Tools>Mapkeys to create, edit and delete 
mapkeys. 

- - 

mass_property_calc
ulate 

New Environment Calculate mass properties upon 
regeneration or by user request. 

by_request, automatic by_request 

mdo_cl_executable New Mechanism Path for Custom Load executable. - - 
mdo_density Changed Mechanism Mass density for dynamics. - 0 
mdo_enable_joint_f
riction 

New Mechanism Enable joint axis friction. yes, no no 

mdo_explicit_integr
ation 

New Mechanism Enable explicit integration for dynamic 
analyses. 

yes, no no 

mdo_spring_wire_ra
dius 

Changed Mechanism Spring wire radius for dynamics spring 
icons. 

- 0.15 

mdo_use_mm_body
_order 

New Mechanism Use Mechanica Motion body order. (Make 
the ground to be the first body in 
connection). 

yes, no no 

meter_grid_interval New Features Modify grid space in meter units for handle 
movement. 

- 0.001 
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mfg_auto_retract_cl
ear_dist 

New Without Category   - -0.001 

mfg_process_print_
dir 

New Without Category Specifies the directory where Mfg Process 
html page get stored. Use the full pat 
hname to avoid problems. 

- - 

mfg_process_table_
setup_dir 

New Without Category Specifies the directory where Mfg Process 
Table settings get stored. Use the full 
pathname to avoid problems. 

- - 

mfg_process_templa
te_dir 

New Without Category Specifies the directory where Mfg Process 
Templates get stored. Use the full 
pathname to avoid problems. 

- - 

mfg_start_model_di
r 

New File Storage & 
Retrieval 

Provides the complete path to the directory 
containing mfg start assemblies. 

- - 

mfg_workpiece_tran
sparency 

New Manufacturing   - 0.5 

millimeter_grid_inte
rval 

New Features Modify grid space in millimeter units for 
handle movement. 

- 1 

minimum_angle_di
mension 

New Dimensions & 
Tolerances 

Controls the minimum angle value under 
which Pro/ENGINEER assumes colinearity 
of the selected items when creating a driven 
dimension. 

- 1 

model_allow_ref_sc
ope_change 

Changed Reference control Yes - Users can change the scope setting of 
components. 

yes, no yes 

mp_calc_level New Without Category Specifies the level of mass properties 
calculation. 

assembly_only, all_models assembly_only

nc_jobman_visible New Without Category Yes - make "Submit Path" and "Abort 
Path" visible. No - make "Submit Path" and 
"Abort Path" invisible. 

yes, no no 
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new_asm_regen_rev
nums 

Changed Assembly Yes - Regenerate command will not 
increase the model revision number of the 
top assembly unless features belonging to 
the top assembly actually get regenerated. 
Regenerate command will increase model 
revision numbers of subassemblies if 
features in the subassembly regenerate. No 
- Regenerate command will always 
increase the revision number of the top 
assembly and almost never increase the 
revision numbers of subassemblies, 
regardless of whether or not assembly 
features regenerate. 

yes, no yes 

new_designate_ui New Without Category   yes, no yes 
new_parameter_ui Changed User Interface Enable the new parameter editor and user 

interface. 
yes, no yes 

new_relation_ui Changed User Interface Enable the new relations editor and user 
interface. 

yes, no yes 

number_user_colors Changed Colors Specifies the maximum number of different 
wireframe colors that can display in the 
graphics area(s) at any given moment. 

- -1 

orientation Changed Model Display Establishes the initial standard view 
orientation. User_default - System uses X-
axis and Y-axis values defined by options 
x_axis and y_axis. 

isometric, trimetric, user_default trimetric 

orientation_style New Without Category Set spin orientation style to dynamic or 
anchored. 

anchored, dynamic dynamic 

output_mfg_xml New Without Category Allows export/import mfg model to/from 
xml file. Yes - make Export/Import options 
visible. No - make them invisible. 

yes, no no 
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overlays_enabled Changed System Yes - Enables Pro/ENGINEER screens and 

menus to be placed on different overlay 
layers of the hardware graphics card. This 
frees memory for Pro/ENGINEER use. 

yes, no yes 

param_dec_places New User Interface Sets the number of decimal places (0-14) to 
display in parameters. 

- 6 

pdf_plot_config New Printing & 
Plotting 

Set the pcf filename to be used when saving 
to PDF format. 

- - 

pen1_line_weight Changed Printing & 
Plotting 

Sets the weight of entities plotted with pens 
using an electrostatic plotter. The weight is 
a range from 1 (thinnest) to 16 (thickest). 

- 4 

pen2_line_weight Changed Printing & 
Plotting 

Sets the weight of entities plotted with pens 
using an electrostatic plotter. The weight is 
a range from 1 (thinnest) to 16 (thickest). 

- 1 

pen3_line_weight Changed Printing & 
Plotting 

Sets the weight of entities plotted with pens 
using an electrostatic plotter. The weight is 
a range from 1 (thinnest) to 16 (thickest). 

- 2 

pen4_line_weight Changed Printing & 
Plotting 

Sets the weight of entities plotted with pens 
using an electrostatic plotter. The weight is 
a range from 1 (thinnest) to 16 (thickest). 

- 3 

pen5_line_weight Changed Printing & 
Plotting 

Sets the weight of entities plotted with pens 
using an electrostatic plotter. The weight is 
a range from 1 (thinnest) to 16 (thickest). 

- 2 

pen6_line_weight Changed Printing & 
Plotting 

Sets the weight of entities plotted with pens 
using an electrostatic plotter. The weight is 
a range from 1 (thinnest) to 16 (thickest). 

- 3 

pen7_line_weight Changed Printing & 
Plotting 

Sets the weight of entities plotted with pens 
using an electrostatic plotter. The weight is 
a range from 1 (thinnest) to 16 (thickest). 

- 1 
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pen8_line_weight Changed Printing & 

Plotting 
Sets the weight of entities plotted with pens 
using an electrostatic plotter. The weight is 
a range from 1 (thinnest) to 16 (thickest). 

- 4 

photorender_capabil
ity_warnings 

New Photorender Allows the user to disable warnings about 
PhotoLux only capabilities. 

yes, no yes 

photorender_default
_height 

Changed Photorender Sets the default height (in pixels) for the 
custom size rendered output 

- 450 

photorender_default
_width 

Changed Photorender Sets the default width (in pixels) for the 
custom size rendered output 

- 600 

photorender_memor
y_usage 

Changed Photorender Sets the memory limit that 
Pro/PHOTORENDER allows for model 
processing. Do not use commas in the 
memory value, as Pro/ENGINEER 
interprets these as decimals. 

- 256 

pipe_bend_locations
_csys_units 

Changed Piping Define which assembly units will be used 
for the piping bend locations calculations. 
Yes - to use coordinate system assembly 
units. No - to use pipeline assembly units. 

yes, no no 

pipe_solid_label_for
mat 

New Piping Specify the pipe solid label format that will 
be used to automatically generate pipeline 
labels. 

- size,-
,specification,-
,mnemonic,-

,number,-
,insulation 

pipeline_assembly_l
ibrary_dir 

New Piping Sets the default pipeline assembly library 
directory. 

- $PTCSRC/text/
piping_data/pip

elinelib 
pipeline_solid_start
_part_name 

New Piping Sets the default pipeline solid start part 
name. 

- pipeline_solid_
start.prt 

pipeline_spool_label
_format 

Changed Piping Specify the pipeline spool label format that 
will be used to generate the spool labels 
during pipeline spool generation. 

- mnemonic-
number-

prefix[0]spooln
um[01]suffix[]
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piping_bolt_nut_sel
ect_file 

New Piping Piping bolts and nuts selection file. - $PTCSRC/text/
piping_data/ma
ster_catalog/pip
ing_bolt_nut_s

elect.ptd 
piping_extend_dim_
scheme 

New Piping Specify a dimension scheme for piping 
extend segment. 

cartesian, cylindrical, spherical spherical 

piping_joint_fitting_
clearance 

New Piping Sets the piping joint minimum fitting 
clearance value. 

- 1 

piping_joint_fitting_
offset 

New Piping Sets the piping joint minimum fitting offset 
value. 

- 1 

piping_min_bolting
_clearance 

Changed Piping Sets the default piping minimum bolting 
clearance value. 

- 1 

piping_schematic_d
riven 

New Piping Set the Schematic Driven Pipeline 
Modeling ON/OFF 

no, yes no 

piping_schematic_x
ml_dir 

New Piping Specify directory with full path containing 
schematic information XML file(s). 

- c:/tmp/dump 

piping_wildfire_con
vert 

New Piping Always ask before converting old piping 
assemblies to update the network structure. 

manual, never, automatic manual 

prehighlight Changed Environment Yes - Selectable items beneath the pointer 
are highlighted prior to being selected. No - 
Selectable items beneath the pointer are not 
highlighted prior to being selected. 

internal none, internal all, internal 
geom_only, public yes, public no 

- 

pro_cbltrm_dir New Electromechanica
l 

Sets the directory from which terminators 
are retrieved. Use the full pathname to 
avoid problems. 

- - 
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pro_editor_comman
d 

Changed User Interface Enables use of an editor other than the 
system editor when the option editor has 
been specified as the value for the options 
drawing_file_editor and/or 
part_table_editor and/or 
relation_file_editor. 

- - 

pro_palette_dir New Drawing Sets the default directory for drawing 
symbol palette files. 

- $PTCSRC/sym
bols/palette 

pro_stheno_comma
nd 

New Data Exchange Specifies the command for Stheno launch. - - 

pro_unit_sys Changed Environment Specifies the default system of units for 
new models. 

mks, cgs, mmns, fps, ips, proe_def, 
mmks 

- 

provide_pick_messa
ge_always 

Changed User Interface No - A message describing the 
(pre)selected item is provided only while 
querying. Yes - A message describing the 
selected item is provided in all cases (i.e. 
even when Query is not used). 

yes, no no 

ratio_grid_interval New Features Modify grid space in percentage units for 
handle movement. 

- 0.05 

read_parameters_of
_excluded 

New Data 
Management 

Allow Pro/ENGINEER designated 
parameters on excluded objects in 
Simplified Representation to be visible in 
Model Tree columns. 

yes, no no 

ref_scope_copy_col
or 

Changed Reference control Set color of backuped references. - 55 

ref_scope_copy_col
or_change 

Changed Reference control Enable changing colors of backuped 
references during selection. 

no, yes yes 

ref_scope_no_pick_
to_copy 

Changed Reference control Disable selecting references backuped by 
references control. 

no, yes no 

ref_scope_no_pick_
to_prohibit 

Changed Reference control Disable selecting references prohibited by 
references control. 

no, yes yes 

ref_scope_prohibit_
color 

Changed Reference control Set color of prohibited references. - 45 
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ref_scope_prohibit_
color_change 

Changed Reference control Enable changing colors of prohibited 
references during selection. 

no, yes yes 

relation_text_trail_o
utput 

New Miscellaneous No - Disable trail output from Text layout 
in Relation Parameter UI if it hasn't been 
changed. 

yes, no yes 

relations_num_const
_units 

New Without Category Specifies whether diagnostic should be 
issued when an unitless numeric value 
causes relation expression evaluation 
trouble. 

yes, no no 

relations_units_sens
itive 

New Without Category Set the default unit sensitivity (ignore or 
take into account parameter/dimensions 
units) in creation of new relation data 
(legacy relation data will not be unit 
sensitive until "converted" to one). 

yes, no yes 

remember_last_attac
h_type 

New Without Category Yes - Sets the default of the ATTACH 
TYPE menu of the last options picked. 

yes, no yes 

reserved_menu_spa
ce 

Changed User Interface Reserves space for extra menus to the right 
of the Pro/ENGINEER window (1.0-4.0). 
This option overrides windows_scale. 

- 1 

restricted_val_defini
tion 

New Without Category Specify name and path of the file contained 
restricted values definition. 

- - 

retrieve_data_sharin
g_ref_parts 

Changed File Storage & 
Retrieval 

Automatic reference parts retrieval for 
dependent data sharing features. 

yes, no, ignore_missing no 

retrieve_merge_ref_
parts 

Changed Without Category Automatic reference parts retrieval for 
dependent Merge. 

yes, no, ignore_missing no 

reverse_spiral_finis
h_type 

New Without Category If the option value is 1, the tool path is 
obtained from standard one by reversing it; 
if the option value is 2, the tool path starts 
from an inner circle. 

- 0 
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save_hidden_items_
w_status 

New Without Category The items on the "Hidden Items" temporary 
layer are stored permanently when layer 
display status is saved with Save Status 
command. 

yes, no yes 

save_instance_accel
erator 

Changed File Storage & 
Retrieval 

With family tables of solid parts, 
determines how instances are saved. None - 
Instance accelerator files not used. Explicit 
- Save instance accelerator files when 
instances explicitly saved. Always - 
Always save instance accelerator files. 

none, explicit, always none 

save_model_display Changed File Storage & 
Retrieval 

Sets amount of graphical data stored. 
Wireframe - Wireframe data. Shading_high 
- Most detail (shaded). Shading_low - Least 
detail (shaded). Shading_lod - Detail 
determined by View Performance dialog 
(shaded). 

public wireframe, public shading_low, 
public shading_high, public 
shading_lod, internal no_display 

shading_lod 

scope_invalid_refs Changed Reference control Prohibit - System will abort all attempts to 
create external reference violating the 
scope. Backup - Warning appears. Abort 
reference creation or declare as out-of-
scope reference. If you declare, backup 
copies to part/assembly and backup is 
referenced. 

copy, prohibit copy 

section_color Changed Sketcher Specifies the color of sketched sections. default, drawing_color - 
select_on_dtm_edge
s 

Changed Environment All_modes - Select a datum plane by 
clicking on its visual boundary. 
Sketcher_only - Select a datum plane by 
clicking on its tag in modes other than 
Sketcher. If you use Query frequently, set 
this option to Sketcher_only. 

all_modes, sketcher_only all_modes 

show_all_mold_lay
out_buttons 

New Casting & Mold 
Design 

Sets all mold layout buttons visible. yes, no no 

sim_additive_mass New Simulation Treats Mass Idealizations as additive if they 
are applied to the same entity and 
suppresses Mass precedence rules. 

yes, no no 
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sim_asm_modeling New Simulation Controls automatic creation of assembly 

links and free connections in Mechanica. 
The default is YES. 

yes, no yes 

sim_beamsection_p
ath 

New FEM Specifies the path where the Beam Sections 
will be stored. 

- - 

sim_display_agem_
controls 

New Simulation Toggles display of AutoGEM Controls. yes, no yes 

sim_display_arrow_
scale 

Changed Simulation Toggles automatic arrow scaling. yes, no yes 

sim_display_arrow_
tail_touching 

New Simulation Toggles display of Load arrows to have 
tails or heads touching. 

yes, no no 

sim_display_beam_r
eleases 

New Simulation Toggles display of Beam Release icons. yes, no yes 

sim_display_beam_
sections 

Changed Simulation Toggles display of beam section icons. yes, no yes 

sim_display_beams Changed Simulation Toggles display of beam icons. no, yes yes 
sim_display_contact
_regions 

New Simulation Toggles display of Contact Region icons. yes, no - 

sim_display_fastene
rs 

New Simulation Toggles display of Fastener icons. yes, no - 

sim_display_in_spin New Simulation Toggles display of simulation objects in 
Dynamic Spin. 

yes, no yes 

sim_display_interfa
ces 

New Without Category Toggles display of structure connection 
icons. 

no, yes yes 

sim_display_load_c
olors 

New Simulation Toggles display of Load colors. yes, no yes 

sim_display_load_di
stribution 

Changed Simulation Toggles display of distributed load vectors 
over entire entity. 

yes, no yes 

sim_display_load_ic
ons 

Changed Simulation Toggles display of load icons. yes, no yes 

sim_display_load_v
alue 

New Simulation Toggles display of Load values. yes, no yes 

sim_display_matl_a
ssignments 

New Simulation Toggles display of Material Assignment 
icons. 

yes, no yes 
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sim_display_measur
es 

New Simulation Toggles display of Simulation Measure 
icons. 

yes, no yes 

sim_display_mesh_
and_model 

New Simulation Toggles display of Mesh together with 
Model. 

yes, no no 

sim_display_mesh_
controls 

New Simulation Toggles display of Mesh Controls. yes, no yes 

sim_display_mesh_
entities 

New Simulation Toggles display of Mesh entities. yes, no yes 

sim_display_mesh_
mode 

New Simulation Specifies the mode of mesh display in FEM 
preprocessor. Values: NO_MESH, 
WIREFRAME, HIDDEN, NOHIDDEN, 
SHADING. 

no_mesh, wireframe, hidden, 
nohidden, shading 

wireframe 

sim_display_mesh_
quality 

New Simulation Specifies the quality of mesh display in 
Mechanica. Values: FINE, MEDIUM, 
COARSE. 

fine, medium, coarse coarse 

sim_display_mesh_s
hells_thick 

New Simulation Toggles the display of shell thickness in 
Mechanica mesh. YES - Display shells 
with real thickness. NO - Display shells 
with zero thickness. 

no, yes no 

sim_display_mesh_s
hrink_elems 

New Simulation Controls display of Mesh through a 
specified percentage of shrinking of its 
elements. 

- -1 

sim_display_motion
_cams 

Changed Simulation Toggles display of motion cam icons. yes, no yes 

sim_display_motion
_connections 

Changed Simulation Toggles display of motion connection 
icons. 

yes, no yes 

sim_display_motion
_contact_rgns 

Changed Simulation Toggles display of motion contact region 
icons. 

yes, no yes 

sim_display_motion
_design_vars 

Changed Simulation Toggles display of design variable icons. yes, no yes 

sim_display_motion
_drivers 

Changed Simulation Toggles display of motion driver icons. yes, no yes 
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sim_display_motion
_gears 

Changed Simulation Toggles display of motion gear icons. yes, no yes 

sim_display_motion
_ground_pnts 

Changed Simulation Toggles display of motion ground point 
icons. 

yes, no yes 

sim_display_motion
_lcs 

Changed Simulation Toggles display of local coordinate systems 
icons. 

yes, no yes 

sim_display_motion
_loads 

Changed Simulation Toggles display of motion load icons. yes, no yes 

sim_display_motion
_slots 

Changed Simulation Toggles display of motion slot icons. yes, no yes 

sim_display_names New Simulation Toggles display of Simulation Object 
names. 

yes, no no 

sim_display_rigid_d
of 

New Simulation Toggles display of Rigid Link DOF icons. yes, no - 

sim_display_rigid_li
nks 

New Simulation Toggles display of Rigid Link icons. yes, no - 

sim_display_shells Changed Simulation Toggles display of shell icons. no, yes yes 
sim_display_spot_w
elds 

Changed Simulation Toggles display of spot weld icons. yes, no yes 

sim_display_therm_
bcs 

New Simulation Toggles display of Thermal Boundary 
Condition icons. 

yes, no - 

sim_display_weight
ed_dof 

New Simulation Toggles display of Weighted Link DOF 
icons. 

yes, no - 

sim_display_weight
ed_links 

New Simulation Toggles display of Weighted Link icons. yes, no - 

sim_display_welds New Simulation Toggles display of Weld icons. yes, no yes 
sim_fatigue_biaxiali
ty_correct 

New Simulation Controls the use of biaxiality correction. 
The default value is YES. 

yes, no yes 

sim_fatigue_biaxiali
ty_method 

New Simulation Controls which method is used to model 
biaxiality: Klann-Tipton-Cordes, Hoffman-
Seeger, or the most conservative (worst) of 
the two methods. The default value is 
WORST. 

worst, ktc, hs worst 
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sim_fatigue_confide
nce_level 

New Simulation Specifies the percentage confidence in the 
predicted life result value. The default 
value is 90, and range is from 0.1 to 99.9 

- 90 

sim_fatigue_externa
l_matdata 

New Simulation Controls the use of external material data. 
The default value is NO. 

no, yes no 

sim_fatigue_hystere
sis_gate 

New Simulation Specifies the gate applied to cycle counting 
as a percentage of peak load. The default 
value is 1 and range is from 0 to 50. 

- 1 

sim_fatigue_infinite
_life_value 

New Simulation Specifies the value for the lives beyond 
cutoff. The default value is 1e20 and range 
is from 1e15 to 1e30. 

- 1E+20 

sim_fatigue_mean_s
tress 

New Simulation Controls the application of the mean stress 
correction. The default value is YES. 

yes, no yes 

sim_fatigue_mean_s
tress_method 

New Simulation Controls which method is used to model 
mean stress: the Smith-Watson-Topper 
Approach, Morrow Correction, or the most 
conservative (worst) of the two methods. 
The default value is WORST. 

worst, swt, morrow worst 

sim_fatigue_safety_
margin 

New Simulation Specifies a factor used to determine the 
Life Confidence quantity. The default value 
is 3 and range is from 1.1 to 100. 

- 3 

sim_fatigue_user_di
rectory 

New Simulation Specifies the directory for user files (for 
example, external material files). The 
default value is the current directory. 

- - 

sim_fatigue_write_s
urf_stress 

New Simulation Controls writing of surface stresses to a 
neutral file. The default value is NO. 

no, yes no 

sim_fem_nastran_us
e_pshell 

New Simulation Yes - use PSHELL cards, No - use PCOMP 
cards for laminate composite shells in 
NASTRAN output file. 

yes, no no 
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sim_html_report_pr
efs_file 

New FEM Specifies the path to the Simulation post 
processor HTML report preferences file. 

- - 

sim_load_mech_me
sh 

New Simulation No - The user is prompted to load the 
existing Mechanica mesh file from the 
current working directory. Yes - The mesh 
file, if exists, is loaded automatically and 
the mesh is displayed. 

no, yes yes 

sim_mat_poissons_
notation 

New Simulation Specifies the convention used for defining 
Poisson's ratio for anisotropic materials as 
being either Tsai (Column-normalized) or 
Jones (Row-normalized). This option 
affects only the labels for Poisson's ratio on 
the Material data form. 

tsai, jones tsai 

sim_max_memory_
usage 

New Simulation Specifies the amount of memory in 
megabytes to be used in Mechanica run and 
FEM mesher. The default value is 128. 

- 128 

sim_motion_analysi
s_accuracy 

New Simulation Specifies the default accuracy to which 
Mechanica determines values at each 
increment of the analysis. This number 
represents the acceptable fractional error in 
the computation of joint axis positions and 
rates at each time increment of the analysis. 
The default value is 0.0001. 

- 0.0001 

sim_motion_analysi
s_assem_tol 

New Simulation Specifies the default error allowed for the 
assembly analysis. The default value is 
0.001. 

- 0.001 

sim_motion_analysi
s_duration 

New Simulation Specifies the default length of time in 
seconds during which the analysis runs. 
The analysis duration can be less than the 
duration of the motion simulation. The 
default value is 10.0. 

- 10 
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sim_motion_analysi
s_increment 

New Simulation Specifies the default increment between 
steps at which Mechanica reports the 
motion of the mechanism. The default 
value is 0.1 

- 0.1 

sim_motion_analysi
s_integrator 

New Simulation Controls the default integrator Mechanica 
uses when running the motion analysis. The 
value types are IMPLICIT (default) and 
EXPLICIT. 

implicit, explicit implicit 

sim_motion_analysi
s_method 

New Simulation Controls the default method Mechanica 
uses to analyze the motion of your model. 
The default is FASTEST_AVAILABLE. 

fastest_available, time_integration, 
kinetostatic 

fastest_availabl
e 

sim_motion_analysi
s_start_time 

New Simulation Specifies the default time in seconds at 
which the motion analysis begins. The 
default value is 0. 

- 0 

sim_motion_analysi
s_vel_tol 

New Simulation Specifies the default error allowed for the 
velocity analysis. The default value is 
0.001. 

- 0.001 

sim_motion_output_
fly_file 

New Simulation Controls the creation of .fra file when 
saving results for a motion model, The .fra 
file is used to import a motion animation 
into Pro/FLY-THROUGH. The default is 
NO. 

no, yes no 

sim_nastran_use_co
upmass 

New Without Category Add PARAM,COUPMASS,1 in the 
Nastran deck file to enforce consistent mass 
matrix generation. 

yes, no no 

sim_output_ids_for_
layers 

New Simulation Outputs FEM mesh element IDs on each 
layer into XML file. 

yes, no no 

sim_output_obj_na
mes 

New Without Category Output Beam Sections names, Analyses 
names, Coordinate Systems names as 
comments. 

yes, no no 
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sim_pp_background
_color 

New Simulation Specifies the background color of the work 
area for the results display. The default 
value is PROE. 

proe, blue, black, white proe 

sim_pp_path_absolu
te 

New Simulation Choose Absolute (Yes) or Relative (No) 
path to "rwd" file. 

yes, no yes 

sim_pp_template_di
r 

New Simulation Sets the default directory for results 
template files. 

- - 

sim_pp_vector_plot
_arrow_2d 

New Simulation "Yes" plots 2D arrows, "NO" plots 3D 
arrows in Vector Plot of Mechanica 
Postporcessor. 

yes, no no 

sim_pp_vrml_expor
t_format 

New Simulation Flags to denote VRML1.0 or VRML2.0 
(default) output. 

vrml2.0, vrml1.0 vrml2.0 

sim_pp_vrml_featur
e_edges 

New Simulation Flag to enable the inclusion of feature 
edges in the VRML file. The default value 
is NO. 

no, yes no 

sim_run_copy_fem_
neutral_file 

New Simulation Controls whether the FEM neutral file 
(with extension .fnf) is copied into the 
study directory. The default value is YES. 

yes, no yes 

sim_run_out_dir New Simulation Specifies the directory for Mechanica run 
output storage. By default, the current 
directory is used. 

- - 

sim_run_tmp_dir New Simulation Specifies the directory for Mechanica run 
temporary storage. By default, the current 
directory is used. 

- - 

sim_smooth_aspect
_ratio 

New Simulation Sets the element aspect ratio criterion for 
the mesh smoothing process. 

- 7 

sim_smooth_edge_a
ngle 

New Simulation Sets the element edge angle criterion (Quad 
elements only), measured in degrees, for 
the mesh smoothing process. 

- 30 
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sim_smooth_skew New Simulation Sets the element skew angle criterion 

(Quad elements only), measured in degrees, 
for the mesh smoothing process. 

- 45 

sim_smooth_taper New Simulation Sets the element taper criterion (Quad 
elements only) for the mesh smoothing 
process. 

- 0.5 

sim_smooth_warp_a
ngle 

New Simulation Sets the element warp angle criterion (Quad 
elements only), measured in degrees, for 
the mesh smoothing process. 

- 10 

sim_use_layers New Simulation Allows layers to become groups for 
Mechanica Independent mode. 

no, yes no 

simulation_fem_mo
de 

Changed Simulation Yes - Activates FEM mode. No - Allows 
access to Mechanica only. Prompt (default) 
- Brings Mechanica Model Type Dialog. 
This option is used only if information 
about FEM mode is not yet stored with 
model. 

yes, no, prompt prompt 

simulation_process_
auto_advance 

New Simulation If set to yes the Process Guide will advance 
to the next set automatically upon 
completion of the current step. 

yes, no no 

simulation_process_
prompt 

New Simulation If set to yes, the Process Guide will be 
launched automatically upon entry into 
Mechanica, if template files are present. 

yes, no no 

simulation_process_
template_dir 

New Simulation Specifies the default location of the Process 
Guide template files. 

- - 

simulation_product New Simulation Set Mechanica product being selected 
(Structure/Thermal/Motion). Prompt 
(default) - Brings Mechanica Model Type 
Dialog. This option is used only if 
information about Mechanica product is not 
yet stored with model. 

public structure, public thermal, 
internal mold, internal motion, public 
prompt 

prompt 
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sketcher_collinear_s
kamps 

New Sketcher Yes - collinear constraints will be used by 
Intent Manager; No - collinear constraints 
will not be used by Intent Manager. 

no, yes yes 

sketcher_disp_weak
_dimensions 

New Sketcher Yes - weak dimensions will be displayed; 
No - weak dimensions will not be 
displayed. 

yes, no yes 

sketcher_equal_leng
th_skamps 

New Sketcher Yes - equal length constraints will be used 
by Intent Manager; No - equal length 
constraints will not be used by Intent 
Manager. 

no, yes yes 

sketcher_equal_radii
_skamps 

New Sketcher Yes - equal radii constraints will be used by 
Intent Manager; No - equal radii constraints 
will not be used by Intent Manager. 

no, yes yes 

sketcher_grid_angle New Sketcher Enter a grid angle value to overide the 
default grid angle value. 

- 0 

sketcher_import_ex
act_geom 

Changed Sketcher During import in sketcher use exact 
geometry. 

yes, no yes 

sketcher_lineup_hor
_skamps 

New Sketcher Yes - line up horizontal constraints will be 
used by Intent Manager; No - line up 
horizontal constraints will not be used by 
Intent Manager. 

no, yes yes 

sketcher_lineup_ver
_skamps 

New Sketcher Yes - line up vertical constraints will be 
used by Intent Manager; No - line up 
vertical constraints will not be used by 
Intent Manager. 

no, yes yes 

sketcher_lock_modi
fied_dims 

New Sketcher Yes - modified dimensions will be locked; 
No - modified dimensions will not be 
locked. 

yes, no no 

sketcher_midpoint_s
kamps 

New Sketcher Yes - midpoint constraints will be used by 
Intent Manager; No - midpoint constraints 
will not be used by Intent Manager. ) 

no, yes yes 

sketcher_num_digits New Sketcher Enter a number of digits for scetcher 
accuracy. 

- 2 



Parametric Technology Corporation 135 Configuration Option Changes Between  
   Pro/ENGINEER 2001 and Pro/ENGINEER Wildfire 2.0 

Name Status Category Description Values Default Value
sketcher_parallel_sk
amps 

New Sketcher Yes - parallel constraints will be used by 
Intent Manager; No - parallel constraints 
will not be used by Intent Manager. 

no, yes yes 

sketcher_perpendicu
lar_skamps 

New Sketcher Yes - perpendicular constraints will be used 
by Intent Manager; No - perpendicular 
constraints will not be used by Intent 
Manager. 

no, yes yes 

sketcher_point_on_e
ntry_skamps 

New Sketcher Yes - point on entry constraints will be 
used by Intent Manager; No - point on 
entry constraints will not be used by Intent 
Manager. 

no, yes yes 

sketcher_rel_accura
cy 

New Sketcher Enter a sketcher relative accuracy. - -1 

sketcher_same_poin
t_skamps 

New Sketcher Yes - same points constraints will be used 
by Intent Manager; No - same points 
constraints will not be used by Intent 
Manager. 

no, yes yes 

sketcher_save_previ
ew_image 

New Sketcher This option controls whether section files 
should be saved with embedded image 
information which can be used to preview 
sections in File/Open dialog. 

no, yes no 

sketcher_set_grid_m
ethod 

New Sketcher "Automatic" - grid spacing will be 
automatically set, "Manual" - grid spacing 
will be manually set. 

automatic, manual automatic 

sketcher_set_grid_x
_spacing 

New Sketcher Enter a x-grid spacing value to overide the 
default x-grid spacing value. 

- 1 

sketcher_set_grid_y
_spacing 

New Sketcher Enter a y-grid spacing value to overide the 
default y-grid spacing value. 

- 1 

sketcher_symmetric
_skamps 

New Sketcher Yes - symmetric constraints will be used by 
Intent Manager; No - symmetric constraints 
will not be used by Intent Manager. 

no, yes yes 
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sketcher_tangent_sk
amps 

New Sketcher Yes - tangent constraints will be used by 
Intent Manager; No - tangent constraints 
will not be used by Intent Manager. 

no, yes yes 

sketcher_undo_stac
k_limit 

Changed Sketcher Sketcher saves a copy of each function 
performed. The number of possible saved 
functions depend on the number specified 
in the option. The undo menu can be used 
to remove the stored functions. 

- 200 

skip_small_surfaces Changed Model Display Gives the user the option not to display 
small shaded surfaces. Disabling this option 
will improve display quality at the expense 
of speed. It is most useful for creating 
screen snap shots. 

no, yes yes 

smt_bend_notes_dfl
t_display 

New Sheetmetal Define the default state of Bend Note 
display (sheetmetal Mode) 

yes, no yes 

smt_bend_notes_dir
ection_down 

New Sheetmetal Define the Down Direction symbol for 
Bend Notes (sheetmetal Mode) 

- default 

smt_bend_notes_dir
ection_up 

New Sheetmetal Define the Up Direction symbol for Bend 
Notes (sheetmetal Mode) 

- default 

smt_bend_notes_ord
er 

New Sheetmetal Define the Fields Order for Bend Notes 
(sheetmetal Mode) 

- &type&directio
n&angle 

smt_bend_notes_typ
e_formed 

New Sheetmetal Define the Formed symbol for Bend Notes 
(sheetmetal Mode) 

- default 

smt_bend_notes_typ
e_rolled 

New Sheetmetal Define the Rolled symbol for Bend Notes 
(sheetmetal Mode) 

- default 

smt_mp_method Changed Sheetmetal MASS - Suppressed Flat Pattern and 
Flatten Forms will be temporary resumed 
before mass properties calculation of 
sheetmetal part. CG - Mass Properties 
calculation will be performed on current 
state of sheetmetal part. BOTH - Both 
methods will be used one after the other. 

mass, cg, both cg 
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spherical_map_size New Drawing Size of Spherical map texture image used 

for environment mapping. Bigger size will 
have better image quality but will be slow 
to regenerate. 

256x256, 512x512, 1024x1024 256x256 

spin_rate_zoom_sen
sitive 

Changed Model Display Allows slower spinning when zoomed in on 
a model. 

yes, no no 

spin_with_orientatio
n_center 

New Without Category Display orientation center while 
reorienting. 

yes, no yes 

step_export_format Changed Data Exchange Specifies output format when exporting to 
STEP. AP203_IS - Formats output to ISO 
10303 AP203IS format. AP214_CD - 
Formats output with geometry that meets 
the specification for the long-term schema 
for AP214cc1. 

public ap203_is, internal ap203_dis, 
public ap214_cd, public ap202_is, 
public 203_is_ext, public ap214_dis, 
public ap209_dis, public ap214_is 

ap203_is 

style_default_conne
ctions 

New Without Category Yes - Add connections to a newly created 
Style surface. 

yes, no yes 

system_hidden_colo
r 

Changed Colors Defines default color of hidden, wireframe 
entities. The three decimal values specify 
(in order) percentage of red, green and blue 
in the resulting color. For example, 0 0 49 
specifies a medium blue. Change in session 
using View>Display Settings>System 
Colors. 

- 0 

tbl_driven_tol_val_e
dit 

New Dimensions & 
Tolerances 

Tbl_driven_tol_val_edit Y/N* - "Yes" 
allows users to directly edit the tolerance 
value of dimensions whose tolerance values 
are driven by tolerance tables. Editing the 
tolerance value of a dimension will make 
the dimension non-table-driven. "No" 
disallows direct editing of the tolerance 
values of table driven tolerances. 

yes, no no 

template_designasm Changed File Storage & 
Retrieval 

Specifies the designated template assembly. 
Use full path to avoid problems. 

- inlbs_asm_desi
gn.asm 
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template_mfgcast Changed File Storage & 

Retrieval 
Specify the model used as the default 
manufacturing cast template. 

- inlbs_mfg_cast.
mfg 

template_mfgcmm New File Storage & 
Retrieval 

Specify the model used as the default 
manufacturing cmm template. 

- inlbs_mfg_cm
m.mfg 

template_mfgemo New File Storage & 
Retrieval 

Specify the model used as the default 
manufacturing expert machinist template. 

- inlbs_mfg_emo
.mfg 

template_mfgmold Changed File Storage & 
Retrieval 

Specify the model used as the default 
manufacturing mold template. 

- inlbs_mfg_mol
d.mfg 

template_mfgnc New File Storage & 
Retrieval 

Specify the model used as the default 
manufacturing assembly template. 

- inlbs_mfg_nc.
mfg 

template_mold_layo
ut 

Changed File Storage & 
Retrieval 

Specify the mold layout assembly used as a 
default template. 

- inlbs_mold_lay
.asm 

tracesketch New Without Category Display tracesketches outside of Style 
feature 

no, yes yes 

triangulate_filled_ar
eas 

New Drawing Subdivide filled areas into triangles (may 
affect memory usage and plot files). 

yes, no no 

ui_theme New Without Category Setup Pro/E Theme. Standard will result in 
the Wildfire Theme on UNIX and 
"following the Windows theme on 
Windows XP & Win2K. Wildfire - Will 
always use the Wildfire Theme regardless 
of the OS settings. 

wildfire, standard standard 

unattached_geometr
y_log_path 

New Without Category Sets a path to log files with checked objects 
listing and ghost features details. 

- - 

units_system_dic_fil
e 

New Piping Specifies the file containing the mapping 
for MCAT filename and units. 

- $PTCSRC/text/
piping_data/ma
ster_catalog/pip
ing_units_syste
m_dic_file.ptd

update_rep_refs Changed Assembly "Yes" updates top assembly simplified reps 
for replacements during regeneration and 
upon replacement. 

yes, no yes 
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use_export_2d_dial
og 

New Data Exchange Yes - Opens export options dialog when 
exporting Pro/E drawing. No - exports file 
without the options dialog. 

yes, no yes 

use_pre_wildfire_te
xt_font 

New Model Display Yes - Use the old stroke-based PTC font as 
the default font. No - Use a True Type font 
as the default font. 

no, yes no 

user_defined_grid_i
nterval 

New Features Modify grid space in user defined length 
units for handle movement. 

- 0.5 

verify_on_save_by_
default 

New File Storage & 
Retrieval 

Yes - "Verify Now" action will be selected 
in the conflict dialog by default when an 
unverified family table instance is to be 
saved in PDM workspace. No - "Verify 
Now" action will not be selected by default. 
The user may explicitly specify the "Verify 
Now" action in the conflict dialog. 

yes, no no 

visible_message_lin
es 

Changed User Interface Sets the default number of visible message 
lines in the Pro/ENGINEER message area. 

- 6 

vrml_export_versio
n 

New Data Exchange   2.0, 1.0 2 

web_browser_histor
y_days 

New System Enter number of days to store history 
records. 

- 20 

web_browser_home
page 

New System Enter location of Pro/E browser home page. - $PTCSRC/html
/usascii/proe/he
lpsystop/resour
ce_center_inde

x.htm 
web_disable_js_co
mmand 

New Application 
Programming 
Interfaces 

Enter a specific javascript command to be 
disabled 

- - 

web_enable_javascr
ipt 

New Without Category Enables or disables Pro/Web.Link in the 
embedded browser. 

on, off off 
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web_enable_subscri
ption 

New Application 
Programming 
Interfaces 

Enable the subscription mechanism for 
Connections 

no, yes yes 

web_max_mail_size New Without Category Set the maximum email attachment size in 
kilobytes. 

- 5000 

weld_color Changed Weld Defines default weld color. The three 
decimal values specify (in order) 
percentage of red, green and blue in the 
resulting color. For example, 0 0 49 
specifies a medium blue. Change in session 
using Tools>Colors>System. 

- 0 

weld_notch_corner_
radius 

New Weld Specifies an initial default value for the 
radius at weld notch corner. 

- 0.1 

weld_notch_height New Weld Specifies an initial default value for the 
weld notch height. 

- 0.4 

weld_notch_radius New Weld Specifies an initial default value for the 
weld notch radius. 

- 0.5 

weld_notch_width New Weld Specifies an initial default value for the 
weld notch width. 

- 0.5 

windows_scale Changed User Interface Scales Pro/ENGINEER windows with a 
given coefficient. A value of 0.85 is usually 
adequate to allow dynamic menus to 
display to the right of the Pro/ENGINEER 
window. 

- 1 
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Name Status Category Description Values Default Value

add_lower_level_comps
_to_layer 

New Layers Setting this option to yes will check off 
the Favor Current Layer option, which 
allows lower level components to be 
added to top level layers. 

yes, no no 

adobe_distiller New Printing & Plotting Sets the Adobe Distiller command path. 
Required for PDF and COLOR PDF 
creation. 

- - 

advanced_intersection New Assembly Control the appearance of the 
intersection tool and scope of available 
functionalities. 

yes, no no 

af_copy_references_flag New User Interface Toggle display of Copy References 
column in Annotation Feature definition 
dialog 

no, yes no 

allow_multiple_tool_tips Changed Manufacturing Allows to use for machining cutting tool 
with multiple tips. 

yes, no no 

allow_shrink_dim_befor
e 

New Casting & Mold 
Design 

Allow calculation before relations. yes, no no 

ask_designate_owners New Without Category Show the both required and optional 
owners to be designated. 

yes, no yes 

atb_prod_asm_upd_by_c
omp_ids 

New Data Exchange Allows to update a Pro/DESKTOP 
assembly based on assembly component 
ids, if set to YES. Otherwise, the update 
will be based on component names. 

yes, no yes 

atb_search_path Changed Without Category Extends search path for ATB Update and 
ATB Check Status commands. 

- - 

auto_ae_param_file New User Interface Define path and file name of external file 
used to define parameters that are 
automatically created in all Annotation 
Elements. 

- - 
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auto_constr_always_use
_offset 

Changed Assembly Control whether auto constraint should 
create offsets. Yes - Auto constraint alw 
ays creates offsets. No - Auto constraint 
snaps align or mate if surfaces are wi thin 
tolerance. Never - Auto constraint never 
create offsets. 

yes, no, never no 

auto_regen_views Changed Drawing Yes - Automatically repaints the drawing 
display when changing from one window 
to another. No - Update to drawing views 
will only occur when manual updates are 
made via Repaint or View> Update. 

yes, no yes 

auto_traceback New System When set to yes, traceback.log file will 
be generated when fatal error occurs. 

yes, no yes 

autobuildz_enabled New Drawing Loads AutobuildZ application. yes, no no 
auxapp_popup_menu_in
fo 

New User Interface Enable display of popup menu info in the 
trail file. 

yes, no no 

bmx_param_restrictions New Without Category   yes, no yes 
bump_revnum_on_retr_r
egen 

Changed Assembly Determines whether or not revision 
number is increased for generic models 
that regenerate and change during 
assembly retrieval. Only applies if 
new_asm_regen_revnums is yes 
(otherwise, there will be no revision 
number bumping). 

yes, no yes 

color_windows Changed Colors All_windows - Wireframe colors display 
in the main window and all auxiliary 
windows. One_window - Colors display 
only in the main window. Auxiliary 
windows display wireframe in the default 
color. 

all_windows, one_window all_windows 

conf_mouse_anim Changed Miscellaneous Display the presenter's mouse motions 
when observing a shared 
Pro/ENGINEER session. 

no, yes yes 
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def_layer Changed Layers Specifies default layer names for 

different types of items. The first value 
string is the layer type. The second value 
string is the layer name. 

layer_assem_member, 
layer_assy_cut_feat, layer_axis, 
layer_chamfer_feat, 
layer_comp_design_model, 
layer_comp_fixture, 
layer_comp_workpiece, 
layer_copy_geom_feat, 
layer_corn_chamf_feat, 
layer_cosm_round_feat, 
layer_cosm_sketch, layer_csys, 
layer_curve, layer_curve_ent, 
layer_cut_feat, layer_datum, 
layer_datum_plane, 
layer_datum_point, 
layer_detail_item, 
layer_dgm_conn_comp, 
layer_dgm_highway, 
layer_dgm_rail, layer_dgm_wire, 
layer_dim, layer_draft_constr, 
layer_draft_dim, layer_draft_dtm, 
layer_draft_entity, 
layer_draft_feat, 
layer_draft_geom, 
layer_draft_grp, 
layer_draft_hidden, 
layer_draft_others, 
layer_draft_refdim, 
layer_driven_dim, 
layer_dwg_table, 
layer_ext_copy_geom_feat, 
layer_feature, layer_geom_feat, 
layer_gtol, layer_hole_feat, 
layer_intchg_funct, 
layer_intchg_simp, 
layer_nogeom_feat, 
layer_nongraph_annot_elem, 
layer_note, layer_parameter_dim, 

- 
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layer_part_refdim, layer_point, 
layer_protrusion_feat, layer_quilt, 
layer_refdim, layer_ribbon_feat, 
layer_rib_feat, layer_round_feat, 
layer_sfin, layer_shell_feat, 
layer_skeleton_model, 
layer_slot_feat, layer_snap_line, 
layer_solid_geom, layer_surface, 
layer_symbol, layer_thread_feat, 
layer_trim_line_feat, 
layer_weld_feat 

default_layer_model New Layers Name of the model which is used to 
drive rule-based layer placement of new 
items in all models of the same type in 
session. 

- - 

default_shrink_formula New Casting & Mold 
Design 

Default option of shrinkage formula: 
1/(1-S) - ASME standard or 1+S 
(simple). 

asme, simple simple 

dim_offscreen_limit Changed Dimensions & 
Tolerances 

If more than zero, sets the margin beyond 
which dimensions are automatically 
snapped back onto the screen. For 
example, a value of .2 lets a dimension 
be 20% of the window size outside the 
window. If set to zero, disables snapping 
of offscreen dimensions. 

- 0.2 

dm_http_compression_le
vel 

Changed Data Management Set the data compression factor (0-9, 0= 
no compression) for data exchange with 
a Windchill server. 

- 0 

dm_overwrite_contents_
on_update 

New Data Management Yes: Windchill Workspace Update will 
overwrite locally/modified out of date 
objects with the ones in the server. No 
(Default): Windchill Workspace Update 
will update metadata only. 

yes, no no 
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draw_models_read_only Changed Drawing Yes - Drawing model files are read-only. 

Driven dimensions, gtols, and similar 
items cannot be added to the model. 
Cosmetic_only - Driven dimensions, 
gtols, cross sections, and explode states 
can be added to the model, design 
changes are not allowed. 

yes, no, cosmetic_only no 

dwg_export_format Changed Data Exchange Provides the ability to choose DWG file 
version when exporting from Pro/E 
drawing. 

12, 13, 14, 2000 2000 

dxf_export_format Changed Data Exchange Provides the ability to choose DXF file 
version when exporting from Pro/E 
drawing. 

12, 13, 14, 2000 2000 

dxf_out_comments Changed Data Exchange YES - comments (999 group codes) will 
be created in DXF file exported from 
Pro/ENGINEER. NO - DXF file will be 
created without comment lines. 

yes, no yes 

ecad_other_outl_csys_de
f_name 

Changed Data Exchange Specifies the default coordinate system 
name for the .OTHER_OUTLINE 
section of an IDF 2.0 ECAD component 
being imported. If you do not set this 
variable, the system uses ECAD 
DEFAULT as coordinate system name. 

- - 

ecad_pin_hole_import New Data Exchange Setup the default for the import of ECAD 
Holes from type PIN (IDF 3.0 ONLY) 

yes, no no 

ecad_via_hole_import New Data Exchange Setup the default for the import of ECAD 
Holes from type VIA (IDF 3.0 ONLY) 

yes, no yes 

enable_face_preselection New Without Category   yes, no yes 
enable_implied_joints Changed Assembly Allow underconstrained components as 

mechanism connections. 
yes, no yes 

enable_k01_msr_anls New Without Category Enable or disable new UI for Measure 
Analysis. 

yes, no no 

enable_offset_fan_curve New Without Category Enables fan curve option for offset tool. yes, no no 
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enable_protk_xml_sche
ma 

New Application 
Programming 
Interfaces 

Enables XML-Schema validation for 
Pro/TK feature XMLs 

yes, no no 

expand_all_with_nested
_layers 

New Without Category Yes - expand all including nested sub 
layers. 

yes, no yes 

fan_significant_locations
_only 

New Electromechanical Setup whether only significant locations 
should be flattened on flattening a 
harness. 

no, yes yes 

fast_highlight New Model Display Yes - Use simplified highlighting which 
redisplays more quickly at the expense of 
certain details. This option may increase 
memory usage slightly. 

no, yes no 

file_open_default_folder Changed File Storage & 
Retrieval 

Sets default dir for File>Open. 
Working_directory - Search working 
directory. In_session - Search objects in 
session. Pro_library - Use only if 
Pro/LIBRARY is installed. Workspace - 
Use only with Pro/INTRALINK. 
Commonspace - Use only with 
Pro/INTRALINK. 

default, working_directory, 
in_session, pro_library, 
my_documents 

- 

folder_display_file_limit New File Storage & 
Retrieval 

Sets the default number of files that will 
be displayed when viewing the contents 
of a folder using the Folder Navigator. 

- -1 

force_upd_assem_mp_in
_simp_rep 

Changed Assembly Update mass properties parameters even 
when some of the components of the 
assembly are not in master rep. 

yes, no no 

general_undo_stack_limi
t 

New System Setup the default number of entries in the 
top level Undo/Redo (default = 50). 

- 50 
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iges_out_assembly_defa
ult_mode 

Changed Data Exchange Set default for assembly export via 
IGES. Flat - Single level model. 
One_level - Assy structure with pointers 
to components. All_levels - Assy 
structure with all comps to IGES files. 
All_parts - Assy to IGES files with geom 
info of comps and assy feats. 

public flat, internal one level, 
internal all levels, public 
one_level, public all_levels, 
internal all parts, public all_parts 

flat 

instance_search_exhausti
ve 

Changed File Storage & 
Retrieval 

Specifies extent of instance search. Yes - 
Include file type when entering instance 
name in File>Open: type in input panel 
(e.g. inst_name.prt) or select in drop-
down list. If no .idx files are found, only 
working dir is searched; each generic is 
not. 

no, yes no 

intf_in_dwg_view Changed Data Exchange Controls if associativity in an imported 
IGES view is preserved. 3D_VIEWS - 
tries to create 3D views if 3D model 
exists in the file. 2D_VIEWS - Imported 
IGES views work as 2D. No - Imported 
IGES views are exploded and become 
unrelated. 

no, 2d_views, 3d_views 2d_views 

intf_in_granite_direct_en
able 

Changed Data Exchange Allows the user to switch back to the old 
'Import Feature' method of reading 
Desktop .des files and Granite .g files 
into Pro/E. By default, Pro/E directly 
opens these models. 

yes, no yes 

intf_use_variable_size Changed Data Exchange Yes - IGES,DXF,STEP files with 
variable sized sheet information are 
imported andput on the appropriate 
variable-size format. Without a sheet 
size, the system tries to apply the correct 
variable-size format. No - The 
IGES,DXF,STEP drawing isplaced on a 
standard sized format. 

no, yes yes 
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intf2d_in_acad_ignore_3
d 

New Data Exchange YES - Ignore the 3DSOLID entities, if 
they exist, in the DXF/DWG file being 
imported in Drawing mode. Only, the 2D 
entities are processed. NO - Create an 
assembly by processing the 3DSOLID 
entities in the DWG/DXF file being 
imported in Drawing mode. This is the 
default value for this option. 

yes, no no 

intf2d_in_create_multili
ne_note 

New Data Exchange Create a single multi-line note on 
importing multi-line text when is set to 
YES. 

yes, no yes 

intf2d_out_acad_mtext New Data Exchange Create a single MTEXT entity for multi-
line text notes when is set to YES. 

yes, no yes 

intf3d_ideas_import_filt
er 

New Data Exchange Enables UI to selectively import I-DEAS 
part and assembly models from the I-
DEAS .mf1 and .pkg container files. 

yes, no no 

intf3d_ideas_install_dir New Data Exchange Specifies the path for I-DEAS 
installation. Use the full pathname to 
avoid problems. 

- - 

intf3d_ideas_run_comm
and 

New Data Exchange Specifies the I-DEAS run command. 
Default command is "ideas". 

- ideas.cmd 

intf3d_parasolid_export_
schema 

New Without Category   - sch_10004 

intf3d_ug_install_dir New Without Category Specifies the path for Unigraphics 
installation. Use the full pathname to 
avoid problems. 

- - 

isogen_nominal_size_ma
p_file 

Changed Piping Specify name of file mapping Pro/Piping 
Size with Nominal Sizes in MM and 
Inches 

- $PTCSRC/text/
piping_data/iso
data/isogen_no
minal_size_ma

p.ptd 
jlink_java_command New Without Category Specifies a command to start JRE for J-

Link. May contain arguments and 
environment variables. Overrides the 
default, see also jlink_java2. 

- - 
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jlink_java2 Changed Application 

Programming 
Interfaces 

Option to force use of Java-2 JRE 
command line ("java" instead of "jre") 

off, on on 

log_dwg_spr1150166_de
tection 

New Without Category Create a log file and include if a 
particular drawing needs correction for 
SPR #1150166. 

no, yes no 

mdo_cl_executable New Mechanism Path for Custom Load executable. - - 
mdo_enable_joint_frictio
n 

New Mechanism Enable joint axis friction. yes, no no 

mdo_use_mm_body_ord
er 

New Mechanism Use Mechanica Motion body order. 
(Make the ground to be the first body in 
connection). 

yes, no no 

mfg_auto_retract_clear_
dist 

New Without Category   - -0.001 

mfg_process_print_dir New Without Category Specifies the directory where Mfg 
Process html page get stored. Use the full 
pat hname to avoid problems. 

- - 

mfg_process_table_setup
_dir 

New Without Category Specifies the directory where Mfg 
Process Table settings get stored. Use the 
full pathname to avoid problems. 

- - 

mfg_process_template_d
ir 

New Without Category Specifies the directory where Mfg 
Process Templates get stored. Use the 
full pathname to avoid problems. 

- - 

mfg_start_model_dir New File Storage & 
Retrieval 

Provides the complete path to the 
directory containing mfg start 
assemblies. 

- - 
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new_asm_regen_revnum
s 

Changed Assembly Yes - Regenerate command will not 
increase the model revision number of 
the top assembly unless features 
belonging to the top assembly actually 
get regenerated. Regenerate command 
will increase model revision numbers of 
subassemblies if features in the 
subassembly regenerate. No - Regenerate 
command will always increase the 
revision number of the top assembly and 
almost never increase the revision 
numbers of subassemblies, regardless of 
whether or not assembly features 
regenerate. 

yes, no yes 

number_user_colors Changed Colors Specifies the maximum number of 
different wireframe colors that can 
display in the graphics area(s) at any 
given moment. 

- -1 

orientation_style New Without Category Set spin orientation style to dynamic or 
anchored. 

anchored, dynamic dynamic 

overlays_enabled Changed System Yes - Enables Pro/ENGINEER screens 
and menus to be placed on different 
overlay layers of the hardware graphics 
card. This frees memory for 
Pro/ENGINEER use. 

yes, no yes 

pdf_plot_config New Printing & Plotting Set the pcf filename to be used when 
saving to PDF format. 

- - 

pen1_line_weight Changed Printing & Plotting Sets the weight of entities plotted with 
pens using an electrostatic plotter. The 
weight is a range from 1 (thinnest) to 16 
(thickest). 

- 4 
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pen2_line_weight Changed Printing & Plotting Sets the weight of entities plotted with 

pens using an electrostatic plotter. The 
weight is a range from 1 (thinnest) to 16 
(thickest). 

- 1 

pen3_line_weight Changed Printing & Plotting Sets the weight of entities plotted with 
pens using an electrostatic plotter. The 
weight is a range from 1 (thinnest) to 16 
(thickest). 

- 2 

pen4_line_weight Changed Printing & Plotting Sets the weight of entities plotted with 
pens using an electrostatic plotter. The 
weight is a range from 1 (thinnest) to 16 
(thickest). 

- 3 

pen5_line_weight Changed Printing & Plotting Sets the weight of entities plotted with 
pens using an electrostatic plotter. The 
weight is a range from 1 (thinnest) to 16 
(thickest). 

- 2 

pen6_line_weight Changed Printing & Plotting Sets the weight of entities plotted with 
pens using an electrostatic plotter. The 
weight is a range from 1 (thinnest) to 16 
(thickest). 

- 3 

pen7_line_weight Changed Printing & Plotting Sets the weight of entities plotted with 
pens using an electrostatic plotter. The 
weight is a range from 1 (thinnest) to 16 
(thickest). 

- 1 

pen8_line_weight Changed Printing & Plotting Sets the weight of entities plotted with 
pens using an electrostatic plotter. The 
weight is a range from 1 (thinnest) to 16 
(thickest). 

- 4 

pro_unit_sys Changed Environment Specifies the default system of units for 
new models. 

mks, cgs, mmns, fps, ips, 
proe_def, mmks 

- 



Parametric Technology Corporation 152   Configuration Option Changes Between  
  Pro/ENGINEER Wildfire and Pro/ENGINEER Wildfire 2.0 

Name Status Category Description Values Default Value
read_parameters_of_excl
uded 

New Data Management Allow Pro/ENGINEER designated 
parameters on excluded objects in 
Simplified Representation to be visible in 
Model Tree columns. 

yes, no no 

relations_num_const_uni
ts 

New Without Category Specifies whether diagnostic should be 
issued when an unitless numeric value 
causes relation expression evaluation 
trouble. 

yes, no no 

relations_units_sensitive New Without Category Set the default unit sensitivity (ignore or 
take into account parameter/dimensions 
units) in creation of new relation data 
(legacy relation data will not be unit 
sensitive until "converted" to one). 

yes, no yes 

remember_last_attach_ty
pe 

New Without Category Yes - Sets the default of the ATTACH 
TYPE menu of the last options picked. 

yes, no yes 

restricted_val_definition New Without Category Specify name and path of the file 
contained restricted values definition. 

- - 

reverse_spiral_finish_typ
e 

New Without Category If the option value is 1, the tool path is 
obtained from standard one by reversing 
it; if the option value is 2, the tool path 
starts from an inner circle. 

- 0 

save_hidden_items_w_st
atus 

New Without Category The items on the "Hidden Items" 
temporary layer are stored permanently 
when layer display status is saved with 
Save Status command. 

yes, no yes 

save_instance_accelerato
r 

Changed File Storage & 
Retrieval 

With family tables of solid parts, 
determines how instances are saved. 
None - Instance accelerator files not 
used. Explicit - Save instance accelerator 
files when instances explicitly saved. 
Always - Always save instance 
accelerator files. 

none, explicit, always none 
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save_model_display Changed File Storage & 

Retrieval 
Sets amount of graphical data stored. 
Wireframe - Wireframe data. 
Shading_high - Most detail (shaded). 
Shading_low - Least detail (shaded). 
Shading_lod - Detail determined by 
View Performance dialog (shaded). 

public wireframe, public 
shading_low, public 
shading_high, public shading_lod, 
internal no_display 

shading_lod 

show_all_mold_layout_b
uttons 

Changed Casting & Mold 
Design 

Sets all mold layout buttons visible. yes, no no 

sim_additive_mass New Simulation Treats Mass Idealizations as additive if 
they are applied to the same entity and 
suppresses Mass precedence rules. 

yes, no no 

sim_asm_modeling Changed Simulation Controls automatic creation of assembly 
links and free connections in Mechanica. 
The default is YES. 

yes, no yes 

sim_beamsection_path New FEM Specifies the path where the Beam 
Sections will be stored. 

- - 

sim_display_agem_contr
ols 

New Simulation Toggles display of AutoGEM Controls. yes, no yes 

sim_display_fasteners New Simulation Toggles display of Fastener icons. yes, no - 
sim_display_measures New Simulation Toggles display of Simulation Measure 

icons. 
yes, no yes 

sim_display_mesh_contr
ols 

New Simulation Toggles display of Mesh Controls. yes, no yes 

sim_display_mesh_quali
ty 

New Simulation Specifies the quality of mesh display in 
Mechanica. Values: FINE, MEDIUM, 
COARSE. 

fine, medium, coarse coarse 

sim_display_mesh_shell
s_thick 

New Simulation Toggles the display of shell thickness in 
Mechanica mesh. YES - Display shells 
with real thickness. NO - Display shells 
with zero thickness. 

no, yes no 

sim_display_mesh_shrin
k_elems 

Changed Simulation Controls display of Mesh through a 
specified percentage of shrinking of its 
elements. 

- -1 
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sim_html_report_prefs_f
ile 

New FEM Specifies the path to the Simulation post 
processor HTML report preferences file. 

- - 

sim_motion_analysis_ac
curacy 

Changed Simulation Specifies the default accuracy to which 
Mechanica determines values at each 
increment of the analysis. This number 
represents the acceptable fractional error 
in the computation of joint axis positions 
and rates at each time increment of the 
analysis. The default value is 0.0001. 

- 0.0001 

sim_motion_analysis_in
crement 

Changed Simulation Specifies the default increment between 
steps at which Mechanica reports the 
motion of the mechanism. The default 
value is 0.1 

- 0.1 

sim_motion_analysis_int
egrator 

Changed Simulation Controls the default integrator 
Mechanica uses when running the 
motion analysis. The value types are 
IMPLICIT (default) and EXPLICIT. 

implicit, explicit implicit 

sim_motion_analysis_m
ethod 

Changed Simulation Controls the default method Mechanica 
uses to analyze the motion of your 
model. The default is 
FASTEST_AVAILABLE. 

fastest_available, 
time_integration, kinetostatic 

fastest_availabl
e 

sim_pp_path_absolute New Simulation Choose Absolute (Yes) or Relative (No) 
path to "rwd" file. 

yes, no yes 

sim_pp_template_dir New Simulation Sets the default directory for results 
template files. 

- - 

sim_pp_vector_plot_arro
w_2d 

New Simulation "Yes" plots 2D arrows, "NO" plots 3D 
arrows in Vector Plot of Mechanica 
Postporcessor. 

yes, no no 

sim_run_out_dir Changed Simulation Specifies the directory for Mechanica run 
output storage. By default, the current 
directory is used. 

- - 

sim_run_tmp_dir Changed Simulation Specifies the directory for Mechanica run 
temporary storage. By default, the 
current directory is used. 

- - 
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sim_smooth_aspect_rati
o 

New Simulation Sets the element aspect ratio criterion for 
the mesh smoothing process. 

- 7 

sim_smooth_edge_angle New Simulation Sets the element edge angle criterion 
(Quad elements only), measured in 
degrees, for the mesh smoothing process. 

- 30 

sim_smooth_skew New Simulation Sets the element skew angle criterion 
(Quad elements only), measured in 
degrees, for the mesh smoothing process. 

- 45 

sim_smooth_taper New Simulation Sets the element taper criterion (Quad 
elements only) for the mesh smoothing 
process. 

- 0.5 

sim_smooth_warp_angle New Simulation Sets the element warp angle criterion 
(Quad elements only), measured in 
degrees, for the mesh smoothing process. 

- 10 

sim_use_layers Changed Simulation Allows layers to become groups for 
Mechanica Independent mode. 

no, yes no 

simulation_fem_mode Changed Simulation Yes - Activates FEM mode. No - Allows 
access to Mechanica only. Prompt 
(default) - Brings Mechanica Model 
Type Dialog. This option is used only if 
information about FEM mode is not yet 
stored with model. 

yes, no, prompt prompt 

simulation_process_auto
_advance 

New Simulation If set to yes the Process Guide will 
advance to the next set automatically 
upon completion of the current step. 

yes, no no 

simulation_process_pro
mpt 

New Simulation If set to yes, the Process Guide will be 
launched automatically upon entry into 
Mechanica, if template files are present. 

yes, no no 

simulation_process_tem
plate_dir 

New Simulation Specifies the default location of the 
Process Guide template files. 

- - 
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simulation_product New Simulation Set Mechanica product being selected 

(Structure/Thermal/Motion). Prompt 
(default) - Brings Mechanica Model 
Type Dialog. This option is used only if 
information about Mechanica product is 
not yet stored with model. 

public structure, public thermal, 
internal mold, internal motion, 
public prompt 

prompt 

sketcher_import_exact_g
eom 

Changed Sketcher During import in sketcher use exact 
geometry. 

yes, no yes 

skip_small_surfaces Changed Model Display Gives the user the option not to display 
small shaded surfaces. Disabling this 
option will improve display quality at the 
expense of speed. It is most useful for 
creating screen snap shots. 

no, yes yes 

smt_mp_method Changed Sheetmetal MASS - Suppressed Flat Pattern and 
Flatten Forms will be temporary resumed 
before mass properties calculation of 
sheetmetal part. CG - Mass Properties 
calculation will be performed on current 
state of sheetmetal part. BOTH - Both 
methods will be used one after the other. 

mass, cg, both cg 

spherical_map_size New Drawing Size of Spherical map texture image used 
for environment mapping. Bigger size 
will have better image quality but will be 
slow to regenerate. 

256x256, 512x512, 1024x1024 256x256 

spin_rate_zoom_sensitiv
e 

Changed Model Display Allows slower spinning when zoomed in 
on a model. 

yes, no no 

spin_with_orientation_ce
nter 

New Without Category Display orientation center while 
reorienting. 

yes, no yes 

step_export_format Changed Data Exchange Specifies output format when exporting 
to STEP. AP203_IS - Formats output to 
ISO 10303 AP203IS format. AP214_CD 
- Formats output with geometry that 
meets the specification for the long-term 
schema for AP214cc1. 

public ap203_is, internal 
ap203_dis, public ap214_cd, 
public ap202_is, public 
203_is_ext, public ap214_dis, 
public ap209_dis, public ap214_is

ap203_is 
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system_hidden_color Changed Colors Defines default color of hidden, 

wireframe entities. The three decimal 
values specify (in order) percentage of 
red, green and blue in the resulting color. 
For example, 0 0 49 specifies a medium 
blue. Change in session using 
View>Display Settings>System Colors. 

- 0 

tbl_driven_tol_val_edit New Dimensions & 
Tolerances 

Tbl_driven_tol_val_edit Y/N* - "Yes" 
allows users to directly edit the tolerance 
value of dimensions whose tolerance 
values are driven by tolerance tables. 
Editing the tolerance value of a 
dimension will make the dimension non-
table-driven. "No" disallows direct 
editing of the tolerance values of table 
driven tolerances. 

yes, no no 

template_designasm Changed File Storage & 
Retrieval 

Specifies the designated template 
assembly. Use full path to avoid 
problems. 

- inlbs_asm_desi
gn.asm 

template_mfgcast Changed File Storage & 
Retrieval 

Specify the model used as the default 
manufacturing cast template. 

- inlbs_mfg_cast.
mfg 

template_mfgcmm New File Storage & 
Retrieval 

Specify the model used as the default 
manufacturing cmm template. 

- inlbs_mfg_cm
m.mfg 

template_mfgemo New File Storage & 
Retrieval 

Specify the model used as the default 
manufacturing expert machinist template. 

- inlbs_mfg_emo
.mfg 

template_mfgmold Changed File Storage & 
Retrieval 

Specify the model used as the default 
manufacturing mold template. 

- inlbs_mfg_mol
d.mfg 

template_mfgnc New File Storage & 
Retrieval 

Specify the model used as the default 
manufacturing assembly template. 

- inlbs_mfg_nc.
mfg 

template_mold_layout Changed File Storage & 
Retrieval 

Specify the mold layout assembly used 
as a default template. 

- inlbs_mold_lay
.asm 

triangulate_filled_areas New Drawing Subdivide filled areas into triangles (may 
affect memory usage and plot files). 

yes, no no 
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ui_theme New Without Category Setup Pro/E Theme. Standard will result 

in the Wildfire Theme on UNIX and 
"following the Windows theme on 
Windows XP & Win2K. Wildfire - Will 
always use the Wildfire Theme 
regardless of the OS settings. 

wildfire, standard standard 

verify_on_save_by_defa
ult 

Changed File Storage & 
Retrieval 

Yes - "Verify Now" action will be 
selected in the conflict dialog by default 
when an unverified family table instance 
is to be saved in PDM workspace. No - 
"Verify Now" action will not be selected 
by default. The user may explicitly 
specify the "Verify Now" action in the 
conflict dialog. 

yes, no no 

visible_message_lines Changed User Interface Sets the default number of visible 
message lines in the Pro/ENGINEER 
message area. 

- 6 

web_browser_homepage Changed System Enter location of Pro/E browser home 
page. 

- $PTCSRC/html
/usascii/proe/he
lpsystop/resour
ce_center_inde

x.htm 
weld_color Changed Weld Defines default weld color. The three 

decimal values specify (in order) 
percentage of red, green and blue in the 
resulting color. For example, 0 0 49 
specifies a medium blue. Change in 
session using Tools>Colors>System. 

- 0 

 


